Copyright Information

Hewlett-Packard Company shall not be liable for technical or editorial errors or omissions contained herein or for incidental or consequential damages in connection with the furnishing, performance, or use of this material. The information in this document is provided “as is” without warranty of any kind, including, but not limited to, the implied warranties of merchantability and fitness for a particular purpose, and is subject to change without notice. The warranties for HP products are set forth in the express limited warranty statements accompanying such products.

Nothing herein should be construed as constituting and additional warranty.

This document contains proprietary information that is protected by copyright. No part of this document may be photocopied, reproduced, or translated to another language without the prior written consent of Hewlett-Packard Company.

Trademark Credits

Microsoft, Windows, and XP are U.S. registered trademarks of Microsoft Corporation in the U.S. and other countries.

Intel is a trademark of Intel Corporation in the U.S. and other countries and are used under license.

ENERGY STAR is a U.S. registered mark of the United States Environmental Protection Agency.

504630-007

Seventh Edition, November 2010
# About this guide

This guide provides service and maintenance information for the HP Z400 Workstation. It includes these topics:

<table>
<thead>
<tr>
<th>Guide topics</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Product overview on page 1</td>
<td></td>
</tr>
<tr>
<td>Setting up the operating system on page 18</td>
<td></td>
</tr>
<tr>
<td>Restoring the operating system on page 24</td>
<td></td>
</tr>
<tr>
<td>System management on page 30</td>
<td></td>
</tr>
<tr>
<td>Replacing components on page 64</td>
<td></td>
</tr>
<tr>
<td>Diagnostics and troubleshooting on page 164</td>
<td></td>
</tr>
<tr>
<td>Configuring RAID devices on page 207</td>
<td></td>
</tr>
<tr>
<td>Configuring password security and resetting CMOS on page 216</td>
<td></td>
</tr>
<tr>
<td>Connector pins on page 221</td>
<td></td>
</tr>
<tr>
<td>System board designators on page 231</td>
<td></td>
</tr>
<tr>
<td>Routine Care on page 233</td>
<td></td>
</tr>
<tr>
<td>Locating HP resources on page 235</td>
<td></td>
</tr>
</tbody>
</table>
# Table of contents

## 1 Product overview

- Product features ........................................................................................................................................ 1
  - System board architecture .................................................................................................................. 2
    - Processor technology .......................................................................................................................... 3
    - Memory technology ............................................................................................................................. 3
    - Graphics ............................................................................................................................................... 4
    - Expansion card slots ............................................................................................................................. 4
    - Additional features .............................................................................................................................. 4

- Workstation components ......................................................................................................................... 5
  - Chassis components .............................................................................................................................. 5
  - Front panel components ......................................................................................................................... 6
  - Rear panel components .......................................................................................................................... 7

- Workstation specifications ...................................................................................................................... 8
  - Physical characteristics ......................................................................................................................... 8
  - Power supply description ....................................................................................................................... 8
    - Power supply voltages .......................................................................................................................... 8
    - Power supply currents .......................................................................................................................... 9
    - Power supply specifications ............................................................................................................... 10
    - Power consumption and heat dissipation ............................................................................................... 11
  - System fans .......................................................................................................................................... 11
  - Resetting the power supply ................................................................................................................... 11

- Environmental specifications .................................................................................................................. 12
  - ENERGY STAR Qualification ............................................................................................................... 12
  - ERP compliance mode ........................................................................................................................... 14
    - Enabling ERP compliance mode ........................................................................................................ 14
    - Disabling ERP compliance mode ....................................................................................................... 14

- Accessibility .......................................................................................................................................... 14
  - Hyper-threading ..................................................................................................................................... 15
  - SATA Power Management .................................................................................................................... 15
  - Intel Turbo Boost Technology ................................................................................................................ 15
  - HP Cool Tools ....................................................................................................................................... 15
  - Ensuring proper ventilation ................................................................................................................... 16

## 2 Setting up the operating system

- Setting up the Microsoft operating system ............................................................................................ 19
  - Installing or upgrading device drivers ............................................................................................... 19
  - Transferring files and settings to your Windows workstation ............................................................. 19

- Setting up Red Hat Enterprise Linux .................................................................................................... 20
  - Installing with the HP driver CD ......................................................................................................... 20
Installing and customizing Red Hat-enabled workstations ............................................. 21
Verifying hardware compatibility ...................................................................................... 21
Setting up Novell SLED ........................................................................................................ ... 21
Updating the workstation ...................................................................................................... .. 21
Updating the workstation after first boot ..................................................................... 21
Upgrading the BIOS ................................................................................................ 21
Determining current BIOS ......................................................................................... 22
Upgrading BIOS .............................................................................................. 23
Upgrading device drivers ......................................................................................... 23

3 Restoring the operating system ....................................................................................... 24
Restore methods ..................................................................................................................... 24
Ordering backup software ................................................................................................. 25
Restoring Windows 7 or Windows Vista ........................................................................... 25
Ordering the RestorePlus! media ..................................................................................... 25
Restoring the operating system ....................................................................................... 25
Restoring Windows XP Professional ............................................................................... 26
Creating RestorePlus! media .......................................................................................... 26
Creating HP Backup and Recovery (HPBR) media ....................................................... 27
Restoring the operating system ....................................................................................... 28
Using RestorePlus! ......................................................................................................... 28
Using HPBR ................................................................................................................... 28
Using the recovery partition ......................................................................................... 28
Restoring Novell SLED ......................................................................................................... ... 28
Creating restore media ............................................................................................ 29

4 System management ...................................................................................................... 30
BIOS ROM ............................................................................................................................ 31
The Computer Setup (F10) Utility .................................................................................... 31
Computer Setup (F10) functionality ................................................................................ 31
Accessing the Computer Setup (F10) Utility .................................................................. 33
The Computer Setup (F10) Utility menu ....................................................................... 34
Workstation management ................................................................................................... 43
Initial workstation configuration and deployment ........................................................... 44
Installing a remote system ............................................................................................... 44
Replicating the setup ........................................................................................................ 45
Copying a setup configuration to a single workstation .................................................. 45
Copying a setup configuration to multiple workstations ................................................ 46
Updating and managing software .................................................................................. 47
HP Client Manager Software ....................................................................................... 47
Altiris Client Management Solutions ........................................................................... 47
HP SoftPaq Download Manager ................................................................................... 48
System Software Manager .............................................................................................. 49
Diagnostic codes and errors ................................................................. 195
Diagnostic LED and audible (beep) codes .................................................. 195
LED color definitions ............................................................................. 199
POST error messages ............................................................................ 201

7 Configuring RAID devices ...................................................................... 207
  Maximum hard drive configurations ...................................................... 207
  Configuring SATA RAID devices ......................................................... 208
    Attaching SATA HDDs .................................................................. 208
    Configuring system BIOS ............................................................... 209
    Creating RAID volumes ................................................................. 210
  Configuring SAS RAID devices ........................................................... 211
    Supported configurations ................................................................. 211
    SAS RAID 0 configuration ............................................................... 212
    SAS RAID 1 configuration ............................................................... 213
    SAS RAID 1E configuration ............................................................. 214
    Deleting RAID volumes ................................................................. 215

8 Configuring password security and resetting CMOS .............................. 216
  Preparing to configure passwords ....................................................... 217
  Resetting the password jumper .......................................................... 218
  Clearing and Resetting the CMOS ....................................................... 219
    Using the CMOS Button ................................................................. 219
    Using the Computer Setup (F10) Utility to Reset CMOS ................. 220

Appendix A Connector pins ..................................................................... 221

Appendix B System board designators ...................................................... 231

Appendix C Routine Care ........................................................................ 233
  General cleaning safety precautions .................................................... 233
  Cleaning the workstation case ............................................................ 233
  Cleaning the keyboard ....................................................................... 233
  Cleaning the monitor ......................................................................... 234
  Cleaning the mouse .......................................................................... 234

Appendix D Locating HP resources .......................................................... 235
  Product information .......................................................................... 236
  Product support ................................................................................. 237
  Product documentation ...................................................................... 238
  Product diagnostics .......................................................................... 239
  Product updates ................................................................................. 240
1 Product overview

This chapter presents an overview of the hardware components of the workstation. It includes these topics:

<table>
<thead>
<tr>
<th>Topics</th>
</tr>
</thead>
<tbody>
<tr>
<td>Product features on page 1</td>
</tr>
<tr>
<td>Workstation specifications on page 8</td>
</tr>
</tbody>
</table>

Product features

The following sections describe the workstation system board architecture and components, and includes these topics:

<table>
<thead>
<tr>
<th>Topics</th>
</tr>
</thead>
<tbody>
<tr>
<td>System board architecture on page 2</td>
</tr>
<tr>
<td>Workstation components on page 5</td>
</tr>
</tbody>
</table>
System board architecture

This section describes the workstation system architecture.

The following figures show the typical system board block diagram for 4-DIMM and 6-DIMM Z400 workstations.

**Figure 1-1** 4-DIMM system board block diagram

---

**NOTE:** The x1, x4, x8, and x16 designators describe the mechanical length of the slot. The number in parentheses lists the number of electrical PCIe lanes routed to the expansion slot. For example, x16(8) means that the expansion slot is mechanically a x16 length connector, with eight PCIe lanes connected.
**Processor technology**

This workstation uses the Intel® X58 Express chipset to support the latest Quad Core Intel® Xeon™ processor W3500 Series, including processors up to 130W. These processors incorporate an integrated 3-channel memory controller, microarchitecture improvements and large L3 cache to provide superior performance. In addition, the workstation uses Intel QuickPath Interconnect (QPI) to connect the processor and I/O controller with speeds up to 6.4 GT/s.

**Memory technology**

The workstation dual in-line memory modules (DIMMs) are based on DDR3 1333MHz technology, and are error checking and correcting (ECC)-protected. Three direct attach memory channels permit low latency accesses and fast data transfer for improved performance. The workstation supports system memory sizes of up to 16GB (in the 4-DIMM Z400s, using 4-GB DIMMs) and 24 GB (in the 6-DIMM Z400s, using 4-GB DIMMs).

**NOTE:** DIMMs should be distributed across all three memory channels for optimal performance.
Graphics

The workstation supports PCIe Gen2 (PCle2) bus speeds and can support dual PCIe Gen2 graphics cards in PCle2 x16 slots.

When using the 475W power supply, the workstation supports:

- A graphics card up to 150W in the primary graphics slot
- A second graphics card in the second PCle2 x16 slot (slot 4), provided the combined power consumption of both cards does not exceed 150W

When using the optional 600W power supply, the workstation supports:

- A graphics card up to 250W in the primary graphics slot
- A second graphics card in the second PCle2 x16 slot (slot 4), provided the combined power consumption of both cards does not exceed 250W

Expansion card slots

The workstation implements one Intel X58 I/O chip to provide a total of six high-performance graphics and I/O slots. In addition to the two full x16 PCle Gen2 slots, two additional PCle x8 (4) slots (x8 mechanically, x4 electrically) provide extra I/O bandwidth for high speed I/O cards. Open ended PCle x8 connectors let the user install x16 physical size cards in the x8 (4) slots.

Additional features

Redundant array of independent disks (RAID) configurations for SATA support modes 0, 1, 5 and 10. eSATA (3.0 Gbps) is supported using an optional adapter. The workstation provides 8 external and 4 internal USB 2.0 ports. The 475W power supply is 85% efficient and enables Energy Star Version 5.0 system configurations. HP WattSaver technology enables support of the European Union ERP Lot 6 power limit of 1W in off mode. HP Quiet Fan Technology enables quiet system operation. A plug-in card supports Serial Attached SCSI (SAS) drives.
Workstation components

This section describes workstation components, including front and rear panel components.

For complete and current information on supported accessories and components for the workstation, see http://partsurfer.hp.com.

Chassis components

The following image shows the components of a typical workstation configuration. Drive configurations can vary.

Figure 1-3  Workstation components

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Power supply</td>
<td>9</td>
<td>Memory module (DIMM)</td>
</tr>
<tr>
<td>2</td>
<td>Side access panel</td>
<td>10</td>
<td>System board</td>
</tr>
<tr>
<td>3</td>
<td>Rear system fan</td>
<td>11</td>
<td>PCIe card</td>
</tr>
<tr>
<td>4</td>
<td>SFF Hard drive</td>
<td>12</td>
<td>PCI card</td>
</tr>
<tr>
<td>5</td>
<td>Hard disk drive</td>
<td>13</td>
<td>Airflow guide (for 6-DIMM Z400 product)</td>
</tr>
<tr>
<td>6</td>
<td>Optical drive</td>
<td>14</td>
<td>Speaker</td>
</tr>
<tr>
<td>7</td>
<td>Processor (CPU) heatsink</td>
<td>15</td>
<td>Front bezel</td>
</tr>
<tr>
<td>8</td>
<td>Processor</td>
<td>16</td>
<td>Chassis</td>
</tr>
</tbody>
</table>
### Front panel components

The following figure shows the front panel of a typical workstation configuration.

**Figure 1-4** Front panel

#### Table 1-2 Front panel connectors

<table>
<thead>
<tr>
<th>Item</th>
<th>Symbol</th>
<th>Description</th>
<th>Item</th>
<th>Symbol</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td></td>
<td>Optical drive manual eject</td>
<td>6</td>
<td><img src="headphone.png" alt="Headphone" /></td>
<td>Headphone connector</td>
</tr>
<tr>
<td>2</td>
<td></td>
<td>Optical drive eject button</td>
<td>7</td>
<td><img src="microphone.png" alt="Microphone" /></td>
<td>Microphone connector</td>
</tr>
<tr>
<td>3</td>
<td><img src="power.png" alt="Power" /></td>
<td>Power button</td>
<td>8</td>
<td><img src="1394a.png" alt="1394a Connector" /></td>
<td>1394a connector (optional and plugged unless configured)</td>
</tr>
<tr>
<td>4</td>
<td><img src="hard_drive.png" alt="Hard Drive" /></td>
<td>Hard drive activity light</td>
<td>9</td>
<td><img src="optical_drive.png" alt="Optical Drive" /></td>
<td>Optical drive activity light</td>
</tr>
<tr>
<td>5</td>
<td><img src="usb.png" alt="USB" /></td>
<td>USB 2.0 ports (2)</td>
<td>10</td>
<td><img src="optical_drive.png" alt="Optical Drive" /></td>
<td>Optical drive</td>
</tr>
</tbody>
</table>
Rear panel components

The following figure shows the rear panel of a typical workstation configuration.

**Figure 1-5  Rear panel**

![Rear panel components image]

**NOTE:** The rear panel connectors are labeled with industry-standard icons and colors to assist in connecting peripheral devices.

With the optional 600W power supply, rear appearance and BIST LED location differ.

**Table 1-3  Rear panel connectors**

<table>
<thead>
<tr>
<th>Item</th>
<th>Symbol</th>
<th>Description</th>
<th>Item</th>
<th>Symbol</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td></td>
<td>Power supply Built-In Self Test (BIST) LED</td>
<td>8</td>
<td></td>
<td>Padlock loop</td>
</tr>
<tr>
<td>2</td>
<td></td>
<td>Universal chassis clamp opening</td>
<td>9</td>
<td></td>
<td>Graphics card connector</td>
</tr>
<tr>
<td>3</td>
<td>![mouse_icon]</td>
<td>PS/2 mouse connector (green)</td>
<td>10</td>
<td>![audio_output_icon]</td>
<td>Audio line-out connector (green)</td>
</tr>
<tr>
<td>4</td>
<td>![usb_icon]</td>
<td>USB 2.0 ports (4)</td>
<td>11</td>
<td>![microphone_icon]</td>
<td>Microphone connector (pink)</td>
</tr>
<tr>
<td>5</td>
<td>![network_icon]</td>
<td>RJ-45 network connector</td>
<td>12</td>
<td>![usb_icon]</td>
<td>USB 2.0 ports (2)</td>
</tr>
<tr>
<td>6</td>
<td>![audio_input_icon]</td>
<td>Audio line-in connector (blue)</td>
<td>13</td>
<td>![keyboard_icon]</td>
<td>PS/2 keyboard connector (purple)</td>
</tr>
<tr>
<td>7</td>
<td></td>
<td>Cable lock slot</td>
<td>14</td>
<td></td>
<td>Power cord connector</td>
</tr>
</tbody>
</table>
Workstation specifications

This section provides workstation chassis, power supply, and environmental specifications.

Physical characteristics

The following table lists the workstation physical characteristics.

<table>
<thead>
<tr>
<th>Weight (Typical configuration)</th>
<th>13.5-20.3 kg (29.8-44.7 lb.)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chassis Dimensions</td>
<td></td>
</tr>
<tr>
<td>Height</td>
<td>45.0 cm (17.7 in.)</td>
</tr>
<tr>
<td>Width</td>
<td>17.0 cm (6.7 in.)</td>
</tr>
<tr>
<td>Depth</td>
<td>44.5 cm (17.5 in.)</td>
</tr>
</tbody>
</table>

Power supply description

The workstation includes either a:

- 475W 85% efficient power supply (ENERGY STAR v5.0 compliant)
- 600W 80% efficient power supply (optional) to enable higher power graphics options (not ENERGY STAR v5.0 compliant)

Power supply voltages

Table 1-4 Power supply source voltages

<table>
<thead>
<tr>
<th>Source voltage</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>+3.3V</td>
<td>PCI, PCIe, audio, clocks, chipset, super I/O, BIOS ROM, and onboard logic</td>
</tr>
<tr>
<td>+5.1V</td>
<td>Storage (hard disk drive, optical disk drive, diskette drive), PCI, PCIe,</td>
</tr>
<tr>
<td></td>
<td>chipset, audio, keyboard/mouse, and USB</td>
</tr>
<tr>
<td>+12 V-CPU</td>
<td>Input to onboard regulator that supplies power to CPU and CPU fan</td>
</tr>
<tr>
<td>+12 V-B</td>
<td>PCI, PCIe, and system fans</td>
</tr>
<tr>
<td>+12 V-D</td>
<td>Storage (hard disk drive, optical disk drive, diskette drive), graphics card</td>
</tr>
<tr>
<td></td>
<td>cable (475W power supply only), and input to onboard regulator that</td>
</tr>
<tr>
<td></td>
<td>supplies power to memory</td>
</tr>
<tr>
<td>V12N</td>
<td>PCI and serial ports</td>
</tr>
<tr>
<td>+5 V-SB</td>
<td>Sleep circuitry</td>
</tr>
<tr>
<td>+12 V-CPU1</td>
<td>Source for graphics card cable (600W power supply only)</td>
</tr>
<tr>
<td>V12-M</td>
<td>Source for graphics card cable (600W power supply only)</td>
</tr>
</tbody>
</table>
### Power supply currents

#### Table 1-5  Maximum current per rail

<table>
<thead>
<tr>
<th>Voltage rail</th>
<th>475W maximum continuous current</th>
<th>600W maximum continuous current</th>
</tr>
</thead>
<tbody>
<tr>
<td>+12 V-CPU</td>
<td>17.5A</td>
<td>18.0A</td>
</tr>
<tr>
<td>+12 V-B</td>
<td>17.5A</td>
<td>18.0A</td>
</tr>
<tr>
<td>+12 V-D</td>
<td>18.0A</td>
<td>18.0A</td>
</tr>
<tr>
<td>V12N</td>
<td>0.30A</td>
<td>0.15A</td>
</tr>
<tr>
<td>+5 VSB</td>
<td>2.25A</td>
<td>3.0A</td>
</tr>
<tr>
<td>3.3V</td>
<td>15.0A</td>
<td>18.0A</td>
</tr>
<tr>
<td>5.1V</td>
<td>21.0A</td>
<td>21.0A</td>
</tr>
<tr>
<td>12 V-CPU1</td>
<td></td>
<td>18.0A</td>
</tr>
<tr>
<td>V12-M</td>
<td></td>
<td>18.0A</td>
</tr>
</tbody>
</table>

⚠️ **CAUTION: 475W power supply**

- Do not exceed 475 watts of total continuous output power.
- Maximum combined power on 3.3V and 5.1V is 110 watts.
- Maximum combined current on +12V (CPU,B,D) is 38 amps.

⚠️ **CAUTION: 600W power supply**

- Do not exceed 600 watts of total continuous output power.
- Maximum combined power on 3.3V and 5.1V is 115 watts.
- Maximum combined current on +12V (CPU0,CPU1,M,B,D) is 50 amps.
## Table 1-6 Power supply specifications

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
</table>
| Power supply                  | ● 475W Wide Ranging, Active PFC and 85% efficient or  
                                  ● 600W Wide Ranging, Active PFC and 80% efficient (optional) |
| Operating voltage range       | 90 – 269 VAC                                      |
| Rated voltage range           | ![100-240 VAC](100-240_VAC) ![118 VAC](118_VAC) |
| Rated line frequency          | 50–60 Hz                                         |
| Operating line frequency range| 47–66 Hz                                         |
| Rated input current           | ![10A @ 100-127 VAC](10A_100-127_VAC)  ![6A @ 200–240 VAC](6A_200-240_VAC) @ 118 VAC |
| Heat dissipation              | ![475W power supply](Heat_dissipation)           |
|                               | ● Typical: 954 Btu/hr = (240.3 kg-cal/hr)         |
|                               | ● Max: 1977 Btu/hr = (498.2 kg-cal/hr)            |
|                               | 600W power supply:                               |
|                               | ● Typical: 1536 Btu/hr = (387 kg-cal/hr)          |
|                               | ● Max: 2560 Btu/hr = (645 kg-cal/hr)              |
| Power supply fan              | One fan, 92mm x 25mm, variable speed             |
| FEMP Standby Power compliant @115V (<2W in S5 – Power Off) | Yes |
| ERP Lot 6 Compliant @230V (<1w in S5 – Power Off) | Yes |
| Built-in Self Test LED        | Yes                                              |
| Surge tolerant full ranging power supply (withstands power surges up to 2000V) | Yes |
| Power Consumption in sleep mode (as defined by ENERGY STAR) - Suspend to RAM (S3) (Instantly Available PC) | <6 watts |


**Power consumption and heat dissipation**


To reach zero power consumption, unplug the workstation from the power outlet or use a power strip with an on/off switch. For additional information about power-saving features, see the operating system installation instructions.

This product is in compliance with U.S. Executive Order 13221.

**System fans**

This workstation includes:

- One rear system fan
- One CPU heatsink fan
- One power supply fan

Additional fans may include:

- Optional front system fan for special environments.
- CPU voltage regulator fan for Z400s equipped with liquid cooling solution.
- Onboard fans on some graphics cards.

**Resetting the power supply**

If an overload triggers the power supply overload protection, power is immediately disconnected.

To reset the power supply:

1. Disconnect the power cord from the workstation.
2. Determine what caused the overload and fix the problem. For troubleshooting information, see *Diagnostics and troubleshooting on page 164*.
3. Reconnect the power cord and restart the workstation.

When you power off the workstation through the operating system, power consumption falls below what is considered low power consumption but does not reach zero. This low power consumption feature extends the life of the power supply.
Environmental specifications

The following table lists the environmental specifications of HP Workstations.

**Table 1-7 HP Workstation environmental specifications**

<table>
<thead>
<tr>
<th>Specification</th>
<th>Operating</th>
<th>Non-operating</th>
</tr>
</thead>
<tbody>
<tr>
<td>Temperature</td>
<td>5 to 35°C (40 to 95°F)</td>
<td>40 to 60°C (-40 to 140°F)</td>
</tr>
<tr>
<td><strong>NOTE:</strong></td>
<td>Derate by one degree C (1.8 degrees F) for every 305m (1,000 ft.) altitude over 1,524m (5,000 ft.).</td>
<td></td>
</tr>
<tr>
<td>Humidity</td>
<td>8 to 85% Relative Humidity (RH), non-condensing</td>
<td>8 to 90% Relative Humidity, non-condensing</td>
</tr>
<tr>
<td>Altitude</td>
<td>0 to 3,048m (10,000 ft.)</td>
<td>0 to 9,144m (30,000 ft.)</td>
</tr>
<tr>
<td>Shock</td>
<td>½-sine: 40g, 2.3ms</td>
<td>● ½-sine: 160 cm/s, 2.3ms (~100g)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>● square: 422 cm/s, 20g</td>
</tr>
<tr>
<td><strong>NOTE:</strong></td>
<td>Values represent individual shock events and do not indicate repetitive shock events.</td>
<td></td>
</tr>
<tr>
<td>Vibration</td>
<td>Operating Random: 0.5g (rms), 5-300 Hz</td>
<td>Non-Operating: random: 2.0g (rms), 10-500 Hz</td>
</tr>
<tr>
<td></td>
<td><strong>NOTE:</strong> Values do not indicate continuous vibration.</td>
<td></td>
</tr>
</tbody>
</table>

**ENERGY STAR Qualification**

HP computers marked with the ENERGY STAR logo are compliant with the applicable U.S. Environmental Protection Agency (EPA) ENERGY STAR specifications for computers. The EPA ENERGY STAR logo does not imply endorsement by the EPA. As an ENERGY STAR Partner, Hewlett-Packard Company has determined the products marked with the ENERGY STAR logo are ENERGY STAR qualified per the applicable ENERGY STAR guidelines for energy efficiency. The following logo appears on all ENERGY STAR qualified computers.

The ENERGY STAR Computers Program was created by the EPA to promote energy efficiency and reduce air pollution through more energy-efficient equipment in homes, offices, and factories. One way products achieve this energy efficiency is by reducing power consumption when not being used through the Microsoft Windows Power Management feature.
The Power Management feature enables the workstation to enter a low-power (or “sleep”) mode after a period of inactivity. When used with an external monitor that is ENERGY STAR qualified, this feature also supports the similar power management features of the external monitor.

To take advantage of this energy savings:

- The Power Management feature has been preset to suspend the workstation to a sleep state after 30 minutes of inactivity.
- The Power Management feature has been preset to suspend the monitor to a sleep state after 15 minutes of inactivity.

Both the computer and monitor can be woken from sleep mode through user interaction with any of the computer input devices (mouse, keyboard, and so on). When configured with Wake On LAN (WOL) enabled, the workstation can also be woken by a network signal.


See the EPA ENERGY STAR Web site for more information about the ENERGY STAR program and its environmental benefits: [http://www.energystar.gov](http://www.energystar.gov).

⚠️ CAUTION: Using the Energy Save Monitor feature with monitors that are not ENERGY STAR qualified can cause video distortion when an Energy Save timeout occurs.

❗️ NOTE: ENERGY STAR is not supported on Linux workstations.

If it is necessary to restore the operating system, you must also reset the ENERGY STAR settings (if applicable) after the restore.

To verify the factory default power settings for your workstation, select **Start>Control Panel**, and then double-click **Power Options**.

❗️ NOTE: ENERGY STAR is not supported with the optional 600W power supply.
**ERP compliance mode**

This computer provides a European Union ERP Lot 6 (Energy-Related Products Directive) compliance mode.

When enabled, this feature lets the workstation shut down to the lowest possible power state by removing all power to the system board.

When disabled, the workstation powers down conventionally.

When the workstation is shut down in ERP compliance mode, you must use the workstation power button to restore power.

**Enabling ERP compliance mode**

To enable ERP Lot 6 compliance mode:

1. Press F10 during start up.
2. Using the arrow keys, select the **Power>Hardware Power Management>ERP Compliance Mode**, and then select **Enable**.
3. Press F10 to accept the change.
4. Select **File>Save Change and Exit**, and then press F10 to accept the change.

**Disabling ERP compliance mode**

To disable the ERP compliance mode:

1. Press F10 during start up.
2. Select **Power>Hardware Power Management>ERP Compliance Mode**, and then select **Disable**.
3. Press F10 to accept the change.
4. Select **File>Save Change and Exit**, and then press F10 to accept the change.

**Accessibility**

HP is committed to developing products, services, and information that is easier to access for all customers, including customers with disabilities and age-related limitations. HP products with Windows Vista® Business and Microsoft® Windows® XP Professional preinstalled are designed for accessibility, and these products are tested with industry-leading Assistive Technology products. For more information see [http://www.hp.com/accessibility](http://www.hp.com/accessibility).
Hyper-threading

This HP workstation supports Hyper-threading.

Hyper-Threading Technology (HTT), is an Intel-proprietary technology used to provide process parallelization. The operating system treats a processor with Hyper-Threading enabled as two processors instead of one. This improves performance under certain workloads by getting useful work from parts of the processor that would otherwise remain idle. Hyper-threading relies on support from the operating system as well as the CPU.

To implement hyper-threading, see The Computer Setup (F10) Utility on page 31.

SATA Power Management

SATA Power Management enables or disables SATA bus and/or device power management.

Intel Turbo Boost Technology

The HP Z Workstation series supports Intel® Turbo Boost Technology.

When the workload does not require all CPU cores, this feature diverts power from inactive cores to active cores, increasing their performance. This lets the CPU run at a higher than normal rate.

Use the workstation BIOS to enable, enhance, or disable Turbo Boost. For instructions on setting BIOS features, see The Computer Setup (F10) Utility on page 31.

HP Cool Tools

An HP workstation with Windows 7 or Windows Vista includes additional software not installed when you first start the workstation. To access or learn more about these additional preinstalled tools on the workstation that can enhance the workstation experience:

1. Open the HP Cool Tools folder by selecting Start> All Programs> HP Cool Tools.
2. Select the HP Cool Tools icon on the desktop.
3. To learn more about these applications, select HP Cool Tools—Learn More.
4. To install or launch the applications, select the appropriate application.

**NOTE:** A preinstalled Windows Vista Business operating system does not contain a Cool Tools icon, shortcut or folder, but several of the tool programs are included, such as Performance Tuning Framework.
Ensuring proper ventilation

Proper ventilation for the system is important for workstation operation. Follow these guidelines to ensure adequate ventilation:

- Operate the workstation on a sturdy, level surface.
- Place the workstation in an area with adequate ventilation. Provide at least 15.24 CM (6 inches) of clearance at the front and back of the workstation as shown in the following figure.

Your workstation might look different than the one shown.

Figure 1-6 Proper workstation ventilation

- Ensure that the ambient air temperature surrounding the workstation falls within the published limit.

**NOTE:** The ambient upper limit of 35 C is only good up to 1524 M (5000 FT) elevation. There is a 1 C per 304.8 M (1000 FT) derating above 1524 M (5000 FT). So, at 3,048 M (10,000 FT), the upper ambient air temperature limit is 30 C.

- For cabinet installation, ensure adequate cabinet ventilation and ensure that the ambient temperature within the cabinet does not exceed published limits.
Never restrict the incoming or outgoing airflow of the workstation by blocking any vents or air intakes as shown in the following figure.

**Figure 1-7** Proper workstation placement
## 2 Setting up the operating system

This chapter provides setup and update information for the workstation operating system. It includes these topics:

<table>
<thead>
<tr>
<th>Topics</th>
</tr>
</thead>
<tbody>
<tr>
<td>Setting up the Microsoft operating system on page 19</td>
</tr>
<tr>
<td>Setting up Red Hat Enterprise Linux on page 20</td>
</tr>
<tr>
<td>Setting up Novell SLED on page 21</td>
</tr>
<tr>
<td>Updating the workstation on page 21</td>
</tr>
</tbody>
</table>

This chapter also includes information on how to determine that you have the latest BIOS, drivers, and software updates installed on the workstation.

⚠️ **CAUTION:** Do not add optional hardware or third-party devices to the HP workstation until the operating system is successfully installed. Adding hardware might cause errors and prevent the operating system from installing correctly.
Setting up the Microsoft operating system

**NOTE:** If you ordered a downgrade from Windows 7 or Windows Vista to Windows XP Professional operating system, your system will be preinstalled with Windows XP Professional operating system. With this configuration, you will receive recovery media for the Windows 7 or Windows Vista operating system only. In case you need to restore or recover the Windows XP Professional operating system in the future, it is important that you create recovery media disks for Windows XP Professional operating system after first boot.

When you first apply power to the workstation, the operating system is installed. This process takes approximately 5 to 10 minutes. Carefully follow the instructions on the screen to complete the installation.

**CAUTION:** After installation has started, do not turn off the workstation until the process is complete. Turning off the workstation during installation can damage the installation and operation of the software.

For complete operating system installation and configuration instructions, see the operating system documentation that was provided with the workstation. Additional information is available in the online help tool after you successfully install the operating system.

### Installing or upgrading device drivers

To install hardware devices after the operating system is installed, you must install the appropriate device drivers before you install the devices. Follow the installation instructions that came with the device. In addition, for optimum performance, your operating system must have the most recent updates, patches, and software fixes. For additional driver and software update information, refer to Upgrading device drivers on page 23.

### Transferring files and settings to your Windows workstation

The Microsoft Windows operating system offers data migration tools that helps you choose and transfer files and data from a Windows computer to your Windows 7, Windows Vista, or Windows XP Professional operating system workstation.

For instructions on how to use these tools, see the documents at [http://www.microsoft.com](http://www.microsoft.com).
Setting up Red Hat Enterprise Linux

HP offers an HP Installer Kit for Linux (HPIKL) to supplement Red Hat box sets and help HP Linux customers customize their system image. The HPIKL contains the HP driver CD and device drivers to successfully setup up the Red Hat Enterprise Linux (RHEL) operating system. The HP Installer Kit for Linux CDs are currently available for download at http://www.hp.com/support/workstation_swdrivers.

Installing with the HP driver CD

To install the HP driver CD, see “Installing with the HP Installer Kit for Linux” in the HP Workstations for Linux manual at http://www.hp.com/support/workstation_manuals.
Installing and customizing Red Hat-enabled workstations

Linux-enabled workstations require the HP Installer Kit and the purchase of a Red Hat Enterprise Linux box set. The Installer kit includes the HP CDs necessary to complete the installation of all versions of the Red Hat Enterprise Linux box set that have been qualified to work on an HP workstation.

To use the drivers in the HP Installer kit for Linux other than RHEL, you must manually extract the drivers from the HP Driver CD and install them. HP does not test the installation of these drivers on other Linux distributions nor does HP support this operation.

Verifying hardware compatibility

To see which Linux versions have been qualified to work on HP Workstations visit http://www.hp.com/support/linux_hardware_matrix.

Setting up Novell SLED

To set up the SUSE Linux Enterprise Desktop (SLED) on systems preloaded with the operating system:

1. Boot the workstation.
2. Start the Installation Settings and enter the password, network, graphics, time, keyboard settings, and Novell Customer Center Configuration for the workstation.

   **NOTE:** During Installation Settings after the first time after booting the system the Novell subscription can be activated from the Novell Customer Center Configuration screen. Visit the full Novell Customer Center documentation at http://www.novell.com/documentation/ncc/.

Updating the workstation

HP is constantly working on improving your total workstation experience. To ensure that the workstation leverages the latest enhancements, HP recommends that you install the latest BIOS, driver, and software updates on a regular basis.

Updating the workstation after first boot

After successfully booting the workstation for the first time, you should follow these guidelines to ensure that the workstation is up-to-date:

- Ensure that you have the latest system BIOS loaded. See Upgrading the BIOS on page 21 for instructions.
- Ensure that you have the latest drivers for your system. See Upgrading device drivers on page 23 for instructions.
- Become familiar with your available HP resources.
- Consider a subscription to Driver Alerts at http://www.hp.com/go/subscriberschoice.

Upgrading the BIOS

For optimum performance, determine the BIOS revision on the workstation, and upgrade it if necessary.
Determining current BIOS

To determine the current BIOS of the workstation during system power up:

1. Wait for F10=setup to appear on the lower right corner of the screen.
2. Press F10 to enter the F10 Setup utility.
   
   The F10 Setup utility displays the workstation BIOS version under **File > System Information**.

3. Note the workstation BIOS version so that you can compare it with the BIOS versions that appear on the HP website.
Upgrading BIOS

To find and download the latest available BIOS, which includes the latest enhancements:

2. Select Download Drivers and Software from the left menu column under Tasks.
3. Follow the instructions to locate the latest BIOS available for the workstation.
4. If the BIOS on the Web site is the same as the version on your system, no further action is required.
5. If the BIOS on the Web site is a version later than the one on your system, download the appropriate version for the workstation. Follow the instructions in the release notes to complete the installation.

Upgrading device drivers

If you install a peripheral device (such as a printer, display adapter, or network adapter), confirm you have the latest device drivers loaded. If you purchased your device through HP, visit the HP Web site to download the latest drivers for your device. These drivers have been tested to ensure the best compatibility between your device and your HP workstation.

If you did not purchase your device from HP, HP recommends visiting the HP Web site first to see if your device and its drivers have been tested for HP workstation compatibility. If no driver is available, visit the device manufacturer’s Web site to download the latest drivers.

To upgrade device drivers:

2. Select Download Drivers and Software from the left menu column under Tasks.
3. Follow the instructions to find the latest drivers available for the workstation.

If a needed driver is not found, see the Web site of the manufacturer of the peripheral device.
3 Restoring the operating system

This chapter describes how to restore the Windows or Linux operating system. It includes these topics:

<table>
<thead>
<tr>
<th>Topics</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Restore methods</td>
<td>24</td>
</tr>
<tr>
<td>Ordering backup software</td>
<td>25</td>
</tr>
<tr>
<td>Restoring Windows 7 or Windows Vista</td>
<td>25</td>
</tr>
<tr>
<td>Restoring Windows XP Professional</td>
<td>26</td>
</tr>
<tr>
<td>Restoring Novell SLED</td>
<td>28</td>
</tr>
</tbody>
</table>

**Restore methods**

The Windows 7 or Windows Business Vista operating system can be reinstalled using the HP RestorePlus! process. The Windows XP Professional operating system can be reinstalled using the RestorePlus! process or the HP Backup and Recovery Manager.

- RestorePlus!
  
  The RestorePlus! process reinstalls the Windows operating system and device drivers (for devices included with the system) to a near-factory state. The process does not back up or recover data on the hard drive. Some application software might not be restored using this process and must be installed from the appropriate application CD.

- HP Backup and Recovery Manager (HPBR) Recovery Point
  
  The HP Backup and Recovery Manager application can be used to capture and restore the contents of the system partition. It captures a snapshot of the system partition and stores it in a Recovery Point. Everything on the system partition at the time the recovery point was made is saved.

  **NOTE:** HP Backup and Restore is only supported on the HP xw6600 and xw8600 Workstations.

  The Recovery Point is saved to the hard drive and can be burned to media for safekeeping.

  **CAUTION:** These methods restore the operating system, but not data. Data must be backed up regularly to avoid loss.
Ordering backup software

If you cannot create system recovery CDs or DVDs, you can order a recovery disk set from the HP support center. To obtain the support center telephone number for your region see http://www.hp.com/support/contactHP.

Restoring Windows 7 or Windows Vista

This section describes how to restore Windows 7 or Windows Vista.

Ordering the RestorePlus! media

If you ordered restore media with your workstation, the media is included with your workstation components.

If you did not order restore media, call HP Support and request a RestorePlus! media kit. For worldwide technical support phone numbers, see http://www.hp.com/support.

Restoring the operating system

**NOTE:** Windows 7 and Windows Vista provide a backup and restore application as well. To learn more about this application, see the Microsoft Web site.

**CAUTION:** Before you restore the operating system, back up your data.

When you run RestorePlus! from media, the process deletes all information on the primary hard drive, including all partitions.

To restore Windows 7 or Windows Vista:


2. Follow the prompts to restore your operating system.

Some application software might not be restored using this process. If software is not restored, install it from the appropriate application DVD.
Restoring Windows XP Professional

This section describes how to restore the Windows XP Professional operating system.

**NOTE:** The workstation must have a CD or DVD writer installed to create the media set.

### Creating RestorePlus! media

The RestorePlus! kit can be created using the files contained on the hard drive. To create the restore media:

1. Boot the workstation.
2. During boot up, an HP Backup and Recovery Manager screen is displayed prompting you to create Recovery CDs or DVDs. Select **Now**.
3. An Initial Recovery Point (IRP) of the system is captured. This is a snapshot of the system hard drive. The capture can take more than 10 minutes.
4. After the IRP is created, you can create a set of backup CDs or DVDs.
   - To create a RestorePlus! media set including the Windows XP operating system CD, select **RestorePlus! > Microsoft Windows XP operating system > Supplemental media**.
   - **NOTE:** Depending on the options, there might be additional DVDs you can create.
5. Follow the prompts to create RestorePlus!, operating system, and HPBR media.

If you are unable to create CD/DVDs on your workstation, call HP Support and request a RestorePlus! media kit. For worldwide technical support phone numbers, see [http://www.hp.com/support](http://www.hp.com/support).
Creating HP Backup and Recovery (HPBR) media

**NOTE:** HPBR is only supported on Windows XP systems. For details, refer to the documentation on the Supplemental Software - HP Backup and Recovery CD included with the workstation. The documentation can be accessed during installation.

The Initial Recovery Point can be burned to optical media and used to recover a system. This section describes making the media.

**NOTE:** The workstation must have a CD or DVD writer to create the media.

To create HPBR recovery media:

1. The Initial Recovery Point was captured when the RestorePlus! media set was created previously.
   
   If the IRP was not created, start the HP Backup and Recovery Manager and create recovery points using the Expert mode. Follow the HPBR online documentation for instructions.

2. Burn the IRP to media from HPBR.
   
   Select **HPBR Start > All Programs > HP Backup & Recovery > HP Backup and Recovery Manager**.

3. Select **Next** at the first screen.
   
   Select **Create recovery CDs or DVDs to recover the system**, and then select **Next**.

4. Choose **Next** to display a list of available CD image and the recovery points.

5. Check the box next to Initial Recovery Point, and then select **Next**.

6. Follow the instructions to create the media.
Restoring the operating system

⚠️ CAUTION: Before you restore the operating system, back up your data.

When you run RestorePlus! from media, the process deletes all information on the primary hard drive, including all partitions. If you run RestorePlus! from the recovery partition, only the root (C:) partition is affected.

Using RestorePlus!

To restore with RestorePlus!:

1. Boot the workstation from the RestorePlus! DVD. You must start from the RestorePlus! DVD for device drivers and settings to be installed.

2. Follow the prompts to restore the operating system.

Some application software might not be restored using this process. If software is not restored, install it from the appropriate application DVD.

Using HPBR

To restore with the HPBR Initial Recovery Point media:

1. Boot the workstation from the Initial Recovery Point media.

2. Follow the prompts to restore the system to the state when the IRP was created.

Using the recovery partition

A system that shipped with Windows XP includes a recovery partition. You can boot the system from that recovery partition.

From the recovery partition you can perform a system restore using the HPBR Initial Recovery Point, if it was created. If it was not, you can use a RestorePlus! install.

To restore using the recovery partition:

1. Boot the workstation.

2. When prompted on the boot screen to enter the Recovery Manager, press F11.

⚠️ TIP: The opportunity to press F11 during the boot process is small. It comes about the time the F10 prompt appears.

_NOTE: To ensure that the recovery processes reinstall on the correct hard drive, do not disconnect the target drive during the recovery process.

3. Follow the prompts to restore the system to factory-like condition.

Restoring Novell SLED

The SLED restore media is required to restore the Linux operating system.
Creating restore media

THE SUSE Linux Enterprise Desktop preload includes a SUSE ISO icon on the desktop. You can click this icon to go to the /iso directory. The /iso directory contains all iso images used to preload your workstation. To recover or restore the original image, follow the instructions in the readme file in the /iso directory to copy the ISO image file onto CDs.

**NOTE:** Make copies of the ISO recovery images on CD as backup files in case your workstation experiences a hard drive failure.
This section describes the tools and utilities that provide system management for the workstation. It includes these topics:

<table>
<thead>
<tr>
<th>Topics</th>
</tr>
</thead>
<tbody>
<tr>
<td>BIOS ROM on page 31</td>
</tr>
<tr>
<td>The Computer Setup (F10) Utility on page 31</td>
</tr>
<tr>
<td>Workstation management on page 43</td>
</tr>
</tbody>
</table>
BIOS ROM

The BIOS ROM is a collection of machine language applications stored as firmware in ROM. It includes functions such as POST, PCI device initialization, Plug and Play support, power management, and the Computer Setup (F10) Utility. The BIOS ROM is a 1-MB Serial Peripheral Interface (SPI) port.

See [http://www.hp.com/go/quickspecs](http://www.hp.com/go/quickspecs) to review the latest BIOS ROM specifications.

The Computer Setup (F10) Utility

This section contains these topics:

- Computer Setup (F10) functionality
- Accessing the Computer Setup (F10) Utility
- The Computer Setup (F10) Utility menu

Computer Setup (F10) functionality

The Computer Setup (F10) Utility lets you:

- Change factory default settings and set or change the workstation configuration, which might be necessary when you add or remove hardware.
- Determine if all devices installed on the workstation are recognized by the system and functioning.
- Determine information about the operating environment of the workstation.
- Solve system configuration errors that are detected but not fixed during the Power-On Self-Test (POST).
- Establish and manage passwords and other security features.
- Establish and manage energy-saving time-outs (not supported on Linux platforms).
- Modify or restore factory default settings.
- Set the workstation date and time.
- Set, view, change, or verify the workstation configuration, including settings for CPU, graphics, memory, audio, storage, communications, and input devices.
- Modify the boot order of installed mass storage devices such as SATA, SAS, diskette drives, optical disk drives, network drives, LS-120 drives and USB boot devices.
- Configure the boot priority of SATA and SAS hard-drive controllers.
- Enable or disable Network Server Mode, which lets the workstation start the operating system when the power-on password is enabled with or without a keyboard or mouse attached. When attached to the workstation, the keyboard and mouse remain locked until the power-on password is entered.
- Enable or disable POST Messages to change the display status of POST messages. POST Messages disabled suppresses most POST messages, such as memory count, product name, and...
other nonerror text messages. If a POST error occurs, the error is displayed regardless of the mode selected. To manually switch to POST Messages Enabled during POST, press any key except F1 through F12.

- Specify an Ownership Tag, which appears when the workstation is powered on or restarted.
- Specify the Asset Tag or property identification number assigned by the company to this workstation.
- Enable power-on password prompts during system restarts (warm-starts) and power on.
- Hide or show the integrated I/O functionality, including serial, USB, or parallel ports, audio, or embedded NIC. Hidden devices are inaccessible, which increases system security.
- Enable or disable removable media boot ability.
- Enable or disable removable media write ability (if supported by hardware).
- Replicate the workstation setup by saving system configuration information on CD or diskette and restoring it on workstations.
- Execute self-tests on specified SATA and SAS hard disk drives (if supported by the drive).
**Accessing the Computer Setup (F10) Utility**

To access the Computer Setup (F10) Utility menu:

1. Power on or restart the workstation.

2. When the display is active and **F10=Setup** appears in the lower right corner of the screen, press **F10**.

   If you do not press **F10** at the appropriate time, try again. Turn the workstation off, then on, and press **F10** again to access the utility. You can also press the **Ctrl + Alt + Delete** keys before starting if you miss the opportunity to press **F10**.

3. Select the language from the list and press the **Enter** key.

   In the Computer Setup (F10) Utility menu, five headings are displayed: File, Storage, Security, Power, and Advanced.

4. Use the left and right arrow keys to select the appropriate heading, use the up and down arrow keys to select an option, and then press **Enter**.

5. Choose from the following:
   
   - To apply and save changes, select **File>Save Changes**, and then select **F10=YES**.
   - To remove changes you have made, select **Ignore Changes** and then select **F10=YES**.
   - To reset to factory settings, select **File>Default Setup>Restore Factory Settings as Default**. Press **F10** to accept the changes, and then select **Apply Defaults and Exit**. This restores the original factory system defaults.

△ **CAUTION:** Do not power off the workstation while the ROM is saving the Computer Setup (F10) Utility changes, because the Complementary Metal-Oxide Semiconductor (CMOS) could become corrupted. After you exit the F10 Setup screen, you can disconnect power from the workstation.
The Computer Setup (F10) Utility menu

The following table describes the functions available in the Computer Setup (F10) utility menu.

**NOTE:** With new BIOS releases, the following content is subject to change, so the menu might be different than shown.

<table>
<thead>
<tr>
<th>Heading</th>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>File</strong></td>
<td>System Information</td>
<td>Displays the following system characteristics:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Product Name</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• QPI Link Speed</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Memory Size</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Integrated MAC</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• System BIOS</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Boot Block Date</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Chassis serial number</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Asset Tracking Number</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Management Module</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Processor Type</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Processor Speed</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Processor Stepping</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Cache Size</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• DIMMs</td>
</tr>
<tr>
<td><strong>About</strong></td>
<td></td>
<td>Displays copyright information.</td>
</tr>
<tr>
<td><strong>System</strong></td>
<td>Temperatures</td>
<td>Displays system temperatures and fan speeds.</td>
</tr>
<tr>
<td><strong>Set Time and Date</strong></td>
<td></td>
<td>Lets you set system time and date.</td>
</tr>
<tr>
<td><strong>Flash System</strong></td>
<td>ROM</td>
<td>Lets you upgrade the BIOS from a ROM image on diskette, CD, or USB.</td>
</tr>
<tr>
<td><strong>Replicated Setup</strong></td>
<td></td>
<td>Provides these options:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Save to Removable Media—Saves the workstation configuration, including</td>
</tr>
<tr>
<td></td>
<td></td>
<td>CMOS, in the qsetup.txt file. This file can be saved to a formatted, blank</td>
</tr>
<tr>
<td></td>
<td></td>
<td>1.44-MB diskette, or to a USB device.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Restore from Removable Media—Restores the workstation configuration</td>
</tr>
<tr>
<td></td>
<td></td>
<td>from a diskette or a USB device.</td>
</tr>
<tr>
<td><strong>Default Setup</strong></td>
<td></td>
<td>Provides these options:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Save Current Settings as Default—Saves the current settings as default</td>
</tr>
<tr>
<td></td>
<td></td>
<td>settings for the next operation.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Restore Factory Settings as Default—Restores the factory settings as the</td>
</tr>
<tr>
<td></td>
<td></td>
<td>default settings for the next operation.</td>
</tr>
</tbody>
</table>
### Table 4-1 Computer Setup (F10) Utility menu descriptions (continued)

<table>
<thead>
<tr>
<th>Heading</th>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Apply Defaults and Exit</td>
<td>Restores the default settings defined in Default Setup.</td>
</tr>
<tr>
<td></td>
<td>Ignore Changes and Exit</td>
<td>Exits workstation setup without applying or saving changes.</td>
</tr>
<tr>
<td></td>
<td>Save Changes and Exit</td>
<td>Saves changes to system configuration and exits the workstation setup.</td>
</tr>
<tr>
<td>Storage</td>
<td>Device Configuration</td>
<td>Lists installed non-SCSI storage devices (except SATA devices) and provides options for obtaining specific information about each device:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Hard Disk—Provides information about the hard disk drives in the workstation. It is available in IDE Mode only.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- CD-ROM—Provides information about the optical disk drives in the workstation. (IDE mode only.)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Diskette Type (for legacy diskette drives only)—Identifies the highest capacity media type accepted by the diskette drive. Options are 3.5&quot; (1.44 MB), 5.25&quot; (1.2 MB), and Not Installed.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Default Values—Resets devices to their default configuration (SATA is the default).</td>
</tr>
<tr>
<td></td>
<td>Multisector Transfers</td>
<td>- Defines the transfer of data per interrupt. Options are 8, 16, and Disable (16 is the default).</td>
</tr>
<tr>
<td></td>
<td>Transfer Mode</td>
<td>- Specifies the active data transfer mode. Options (subject to device capabilities) are Max UDMA, PIO 0, Max PIO, Enhanced DMA, and Ultra DMA0. (Max UDMA is the default).</td>
</tr>
<tr>
<td></td>
<td>Translation Mode</td>
<td>- Lets the BIOS determine the translation mode used to configure a formatted SATA or USB mass storage device. This prevents you from needing to know how the mass storage device was formatted. Options are Automatic, Bit Shift, LBA Assisted, Use (Cylinders, Heads, Sectors), and Off. Automatic is the default.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Ordinarily, you should not change the translation mode selected by the BIOS. If the selected translation mode is not compatible with the translation mode that was active when the drive was partitioned and formatted, the data on the disk is inaccessible.</td>
</tr>
<tr>
<td>Heading</td>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>----------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Storage Options</td>
<td>Provides these options:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>● Removable Media Boot—Enables and disables the ability to start the workstation from removable media.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>● Legacy Diskette Write—Enables and disables the ability to write data to removable media.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>● SATA Emulation—Sets the SATA emulation mode with the following options:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>◦ RAID + AHCI—both the RAID and AHCI OPROMs execute. This emulation mode is the default and offers the best performance and most functionality.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>◦ IDE—offers standard SATA supports (four ports only).</td>
<td></td>
</tr>
<tr>
<td></td>
<td>● SATA PORT 0-n—enables and disables the SATA ports. Offers these configurations:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>◦ GEN 2/3.0 Gbps (Internal Only/eSATA Only)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>◦ GEN 1/1.5 Gbps (eSATA Only)</td>
<td></td>
</tr>
<tr>
<td>DPS Self-test</td>
<td>Select a drive—Lets you select a drive to test. (Available in SATA IDE emulation mode only.)</td>
<td>The DPS self-test function directs an IDE hard disk to run an internal self-test and report the results. If the SATA controller is not in IDE emulation mode, the DPS self-test option is not displayed in the setup menu. This selection appears only when at least one drive capable of performing the IDE DPS self-test is attached to the workstation. By default, the SATA controller is in RAID+AHCI mode, so this option is not displayed.</td>
</tr>
<tr>
<td>Heading</td>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>-----------</td>
<td>--------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
|           | Boot Order         | Lets you configure the boot order of diskette drive and hard disk drive by physically reordering the menu entries. The menu presents the following default boot order:  
  - Optical Drive  
  - Diskette Drive  
  - USB Device  
  - Hard Drive  
  - Embedded Ethernet controller  
  - Embedded Ethernet controller (ASF) Second embedded LAN. (Not available in some configurations.)  
  Press **Enter** to drag a device to a preferred place.  
  Press **F5** to remove the device from consideration as a bootable device.  
  MS-DOS drive lettering assignments might not apply after an operating system other than MS-DOS has started.  
  Boot devices can be disabled in the boot order process. These order changes are stored in the physical ROM when the F10 Setup changes are confirmed with File>Save Changes and Exit.  
  You can temporarily override the boot order. To start one time from a device other than the default device specified in Boot Order, restart the workstation and press **F9** when the F9=Boot Menu message appears on the screen. After POST completes, a list of bootable devices is displayed. Use the arrow keys to select the preferred bootable device and press **Enter**. The workstation then starts from the selected nondefault device for this one time. |
|           | Security Setup     | Enables you to set and enable a setup password for the administrator.  
  If you create a setup password, you must use it to change workstation setup options, to flash the ROM, and to make changes to certain Plug and Play settings under Windows. |
|           | Power-On Password  | Enables you to set and enable the power-on password.                                                                                       |
|           | Password Options   | This option becomes available when you create a setup and/or power-on password. It provides these options:  
  - Lock Legacy Resources—Prevents the operating system from changing resources to serial, parallel, or diskette controller.  
  - Network Server Mode—Enables network server mode.  
  - Password Prompt on Warm Boot—Enables a password prompt on a warm boot.  
  - Setup Browse Mode—Enables read-only functionality for password info. |
<p>|           | Smart Cover        | Lets you enable and disable the cover removal sensor, or notify you if the sensor is activated.                                             |</p>
<table>
<thead>
<tr>
<th>Heading</th>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Device Security</td>
<td></td>
<td>Makes the following devices available or hidden to the workstation:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Serial Port</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Front USB Ports</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Rear USB Ports</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Internal USB Ports</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- System Audio</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- IEEE 1394 Controller (Not available on some models.)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Ethernet Controller</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Ethernet Controller (ASF) (Not available on some models.)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- SAS Controller (Not available on some models)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Legacy Diskette</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Embedded Security Device</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- SATA 0-n</td>
</tr>
<tr>
<td></td>
<td></td>
<td>For each device, Device Available is the default setting, which lets the operating system access the device. Device Hidden makes the device unavailable; it is disabled by the BIOS and cannot be enabled by the operating system.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>NOTE:</strong> An entry for enabling DriveLock appears in the setup menu if the workstation has a DriveLock-compatible hard disk drive.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Embedded Security Device</th>
<th>This option becomes available if Embedded Device is set to Available.</th>
<th>Embedded Security Device (Hidden or Available) turns the Trusted Platform Mechanism (TPM) on and off. Device Hidden is the default. If this option is made available, the following options become available:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>- Power-On Authentication Support—Enables and disables an authentication feature that requires you to enter a TPM user key password to start the workstation. This feature uses the TPM to generate and store the authentication password.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Reset Authentication Credential—Resets the authentication functionality and clears authentication credentials.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>To enable the Embedded Security Device and to access any security features associated with the device, you must enter a setup password.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Setting a device to Available enables the operating system to access the device. Hidden makes the device unavailable. It is disabled by the BIOS and cannot be enabled by the operating system.</td>
</tr>
</tbody>
</table>

<p>| Network Service Boot     | Enables or disables the ability to boot to the network using the F12 key or the boot order. |</p>
<table>
<thead>
<tr>
<th>Heading</th>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| System IDs    | Provides these options:     | ● Asset Tag—A 16-byte string identifying the workstation.  
● Ownership Tag—An 80-byte string identifying ownership of the workstation. This tag appears on the screen during POST.  
● Universal Unique Identifier (UUID)—Can only be updated if the current chassis serial number is invalid. (These ID numbers are normally set in the factory and are used to uniquely identify the workstation.)  
● Keyboard—Lets you set the keyboard locale for System ID entry. |
| System Security| Provides these options:     | ● Data Execution Prevention—Enables or disables Data Execution Prevention mode in the CPUs. This mode prohibits code from running in pages that were set up as data pages, and prevents attacks such as buffer overflows. Operating system support is required for this feature.  
● Virtualization Technology (VTx)—Enables or disables Intel Virtualization Technology to increase workstation performance.  
● Virtualization Technology for Directed I/O (VT-d2)—Enables a virtual machine to gain exclusive control of a hardware device, such as a graphics card.  
● Embedded Security Device—This option becomes available if Embedded Device is set to Available.  

Embedded Security Device (Hidden or Available) turns the Trusted Platform Mechanism (TPM) on and off. Device Hidden is the default. If this option is made available, the following options become available:  
◦ Power-On Authentication Support—Enables and disables an authentication feature that requires you to enter a TPM user key password to start the workstation. This feature uses the TPM to generate and store the authentication password.  
◦ Reset Authentication Credential—Resets the authentication functionality and clears authentication credentials.  

To enable the Embedded Security Device and to access any security features associated with the device, you must enter a setup password.  

Setting a device to Available lets the operating system access the device. Hidden makes the device unavailable. It is disabled by the BIOS and cannot be enabled by the operating system.  
● Intel IO Virtualization—Enables or disables Virtualization Technology to increase workstation I/O performance.  
● Embedded Security Device Support—Lets the workstation leverage the trusted platform mechanism device.  
● OS Management of Embedded Security Device—Enables or disables operating system control of the TPM device, including turning it on and off, initializing it, and resetting it.  
● Reset of Embedded Security Device through OS—Enables or disables operating system ability to reset the TPM. |
<table>
<thead>
<tr>
<th>Heading</th>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Setup Security Level</td>
<td></td>
<td>Lets the administrator set the security level of each setup feature.</td>
</tr>
<tr>
<td>Power</td>
<td>OS Power Management</td>
<td>Enables or disables:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>● Runtime Power Management</td>
</tr>
<tr>
<td></td>
<td></td>
<td>● MWAITE-AWARE OS</td>
</tr>
<tr>
<td></td>
<td></td>
<td>● Idle Power Savings</td>
</tr>
<tr>
<td></td>
<td></td>
<td>● ACPI S3 Hard Disk Reset</td>
</tr>
<tr>
<td></td>
<td></td>
<td>● ACPI S3 PS/2 Mouse Wakeup</td>
</tr>
<tr>
<td></td>
<td></td>
<td>● USB Wake on Device Insertion</td>
</tr>
<tr>
<td></td>
<td></td>
<td>● Unique Sleep State Blink Rates</td>
</tr>
<tr>
<td>Hardware Power</td>
<td></td>
<td>Enables or disables:</td>
</tr>
<tr>
<td>Management</td>
<td></td>
<td>● SATA Power Management</td>
</tr>
<tr>
<td></td>
<td></td>
<td>● Intel Turbo Boost Technology</td>
</tr>
<tr>
<td></td>
<td></td>
<td>● Enhanced Intel Turbo Boost Technology</td>
</tr>
<tr>
<td></td>
<td></td>
<td>● ERP Compliance Mode</td>
</tr>
<tr>
<td>Thermal</td>
<td></td>
<td>Lets you set the rate of the system fan when the CPU is in idle.</td>
</tr>
<tr>
<td>Heading</td>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>-----------------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Advanced2</td>
<td>Power-On Options</td>
<td>Lets you set the following:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>● POST Messages—Enables or disables the splash screen during POST.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>● F9 Prompt (Displayed or Hidden)—Selecting <strong>Displayed</strong> displays the <strong>F9=Boot Menu</strong> during POST. Selecting <strong>Hidden</strong> prevents the text from being displayed. However, pressing F9 still accesses the boot menu.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>● F10 Prompt (Displayed or Hidden)—Selecting <strong>Displayed</strong> displays <strong>F10=Setup</strong> during POST. Selecting <strong>Hidden</strong> prevents the text from being displayed, but pressing F10 still accesses the Setup screen.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>● F12 Prompt (Displayed or Hidden)—Selecting <strong>Displayed</strong> displays <strong>F12=Network Service Boot</strong> during POST. Selecting <strong>Hidden</strong> prevents the text from being displayed but pressing F12 still forces the workstation to attempt booting from the network.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>● Option ROM1 prompt (Enable or Disable)—Enabling this feature causes the workstation to display a message before loading options ROMs.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>● Remote Wakeup Boot Source—Enables you to set the remote wakeup boot source as:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>◦ Local Hard Drive</td>
</tr>
<tr>
<td></td>
<td></td>
<td>◦ Remote Server</td>
</tr>
<tr>
<td></td>
<td></td>
<td>● After Power Loss (On, Off, Previous State)—Enabling this option directs the previous state to be the default.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>● POST Delay (in seconds) (5, 10, 15, 20, None)—Adds a specified delay to the POST process. This delay is sometimes needed for hard disk drives on some expansion cards that spin up slowly (so slowly that they are not ready to start by the time POST is finished). The POST delay also gives you time to select F10 to enter the Computer Setup (F10) Utility.</td>
</tr>
<tr>
<td>BIOS Power-On</td>
<td></td>
<td>Lets you disable or specify a weekday and time for BIOS power-on.</td>
</tr>
<tr>
<td>Processors</td>
<td>Enables/disables these options:</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>● Hyper-Threading—Provides processor parallelization such that the operating system treats one processor as two.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>● Active Cores (1, 2, or All Cores)—Selects a single core, or multiple cores per socket. (Not available on some configurations.)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>● Limit CPUID Maximum Value to 3 (Enable or Disable)—Sets the number of allowable CPU IDs.</td>
</tr>
<tr>
<td>Onboard Devices</td>
<td></td>
<td>Lets you set resources (IRQ, DMA, I/O Rate) or disable onboard system devices such as serial port and diskette controller. Operating system parameters generally override Onboard Devices settings.</td>
</tr>
<tr>
<td>PCI VGA</td>
<td></td>
<td>Configures which expansion slots are used for graphics cards. In multi-graphics card configurations, this option designates one graphics card as primary and the other card as secondary.</td>
</tr>
</tbody>
</table>
### Table 4-1  Computer Setup (F10) Utility menu descriptions (continued)

<table>
<thead>
<tr>
<th>Heading</th>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chipset/ Memory</td>
<td>Enable/disable these options:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>● PCI SERR# Generation (Enable or Disable)—Controls PCI SERR# generation for ill-behaved PCI add-in cards (that can generate SERR# spuriously).</td>
<td></td>
</tr>
<tr>
<td></td>
<td>● PCI VGA Palette Snooping (Enable or Disable)—Controls PCI VGA Palette Snooping for compatibility purposes.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>● Memory Mode Interleave—Sets interleave mode for dual socket workstations.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Device Options Lets you set the following device options:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>● Num Lock State at Power-On (On or Off)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>● S5 Wake-on-LAN (Enable or Disable)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>● Multiprocessor (Activates a single core.)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>● Unique Sleep State Blink Rates (Enable or Disable)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>● Internal speaker</td>
<td></td>
</tr>
<tr>
<td></td>
<td>● Monitor Tracking (Enable or Disable)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>● NIC PXE Option ROM(^1) Download (Enable or Disable)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>● SAS Option ROM(^1) Download (Enable or Disable) (Not available on some workstations.)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>● SATA RAID Option ROM(^1) Download (Enable or Disable)</td>
<td></td>
</tr>
</tbody>
</table>

\(^1\) Available on selected models
\(^2\) These options should be used by advanced users only
Workstation management

This section summarizes capabilities, features, and key components of workstation management, including:

<table>
<thead>
<tr>
<th>Topics</th>
</tr>
</thead>
<tbody>
<tr>
<td>Initial workstation configuration and deployment on page 44</td>
</tr>
<tr>
<td>Installing a remote system on page 44</td>
</tr>
<tr>
<td>Replicating the setup on page 45</td>
</tr>
<tr>
<td>Updating and managing software on page 47</td>
</tr>
<tr>
<td>HP Client Manager Software on page 47</td>
</tr>
<tr>
<td>Altiris Client Management Solutions on page 47</td>
</tr>
<tr>
<td>System Software Manager on page 49</td>
</tr>
<tr>
<td>Proactive Change Notification on page 49</td>
</tr>
<tr>
<td>Subscriber’s Choice on page 49</td>
</tr>
<tr>
<td>ROM Flash on page 50</td>
</tr>
<tr>
<td>FailSafe Boot Block ROM on page 51</td>
</tr>
<tr>
<td>Workstation security on page 52</td>
</tr>
<tr>
<td>Fault notification and recovery on page 62</td>
</tr>
<tr>
<td>Dual-state power button on page 63</td>
</tr>
</tbody>
</table>

**NOTE:** Support for specific features described in this guide can vary by model and software version.
Initial workstation configuration and deployment

The workstation includes a preinstalled system software image. After a brief software unbundling process, the workstation is ready to use.

If you prefer to replace the preinstalled software image with a customized set of system and application software, several methods are available for deploying a customized software image, including:

- Installing additional software applications after unbundling the preinstalled software image
- Using a disk cloning process to copy the contents from one hard disk drive to another

The Restore Plus! CD, ROM-based setup, and ACPI hardware provide further assistance with recovery of system software, configuration management and troubleshooting, and power management.

Support for specific features described in this guide can vary by model and software version.

The best deployment method depends on the information technology environment and processes.

Installing a remote system

Remote system installation enables starting and setting up the workstation using software and configuration information on a network server. This feature provides a useful system setup and configuration tool for the following tasks:

- Deploying a software image on new PCs
- Formatting a hard disk drive
- Installing application software or drivers
- Updating the operating system, application software, or drivers

To initiate a remote system installation, press F12 when F12=Network Service Boot appears in the lower right corner of the HP logo screen. Follow the onscreen instructions to continue the installation process. The default boot order is a BIOS configuration setting that can be changed to always attempt a PXE boot.
Replicating the setup

This section provides information about replicating the workstation setup.

Copying a setup configuration to a single workstation

⚠️ CAUTION: A setup configuration is model-specific. File system corruption can result if source and target workstations are not the same model.

To copy a setup configuration:

1. Select a setup configuration to copy, and then restart the workstation.

2. As soon as the workstation powers on, press and hold F10 until you enter the Computer Setup (F10) Utility. If necessary, press Enter to bypass the title screen.

💡 NOTE: If you do not press F10 at the appropriate time, you must restart the workstation, and then press and hold F10 again to access the utility.

If you are using a PS/2 keyboard, you might see a keyboard error message. Disregard it.

3. Select File>Replicated Setup>Save to Removable Media. Follow the instructions on the screen to create the configuration diskette or USB media device.

4. Power off the workstation you are configuring and insert the configuration diskette into the diskette drive or USB media device.

5. Power on the workstation you are configuring.

6. Press and hold the F10 key until you enter the Computer Setup (F10) Utility. If necessary, press Enter to bypass the title screen.

7. Select File>Replicated Setup>Restore from Removable Media, and then follow the instructions on the screen.

8. Restart the workstation when the configuration is complete.
Copying a setup configuration to multiple workstations

⚠ **CAUTION:** A setup configuration is model-specific. If source and target workstations are not the same model, file system corruption can result. For example, do not copy the setup configuration from an HP xw8600 Workstation to an HP Z400 Workstation.

This method takes longer to prepare the configuration diskette, but copying the configuration to target workstations is fast.

A bootable diskette is required for this procedure. If Windows XP is not available to create a bootable diskette, use the method for copying to a single workstation instead (see Copying a setup configuration to a single workstation on page 45).

1. Create a bootable diskette or USB media device.
2. Select a setup configuration to copy.
3. If you are using a diskette or USB storage device, insert it now.
4. Restart the workstation.
5. As soon as the workstation powers on, press and hold F10 until you enter the Computer Setup (F10) Utility. If necessary, press Enter to bypass the title screen.

**NOTE:** If you do not press the F10 key at the appropriate time, you must restart the workstation, and then press and hold the F10 key again to access the utility.

If you are using a PS/2 keyboard, you might see a keyboard error message. Disregard it.

6. Select **File>Replicated Setup>Save to Removable Media**, and follow the instructions on the screen to create the configuration diskette or USB media device.
7. Download a BIOS utility for replicating setup (repset.exe), and copy it to the configuration diskette or USB media device. To obtain this utility, see [http://www.hp.com/support/files](http://www.hp.com/support/files).
8. Enter the model number of the workstation.
9. On the configuration diskette, create an autoexec.bat file containing repset.exe and cpqsetup.txt.
10. Power off the workstation you are configuring, insert the configuration diskette or USB device, and then power on the workstation. The configuration utility runs automatically.
11. When the configuration is complete, restart the workstation.
Updating and managing software

HP provides several tools for managing and updating software on desktops and workstations:

- HP Client Manager Software
- System Software Manager
- Altiris Client Management Solutions
- Proactive Change Notification
- Subscriber’s Choice

**HP Client Manager Software**

The HP Client Manager Software offers these services:

- Detailed views of hardware inventory for asset management
- PC health-check monitoring and diagnostics
- Proactive notification of changes in the hardware environment
- Web-accessible reporting of business-critical details such as thermal warnings and memory alerts
- Remote updating of system software such as device drivers and ROM BIOS
- Remote changing of boot order
- Configuration of system BIOS settings


For more information about the HP Client Manager, see [http://www.hp.com/go/ssm](http://www.hp.com/go/ssm).

**Altiris Client Management Solutions**

Altiris and HP have partnered to provide comprehensive, tightly integrated systems management solutions to reduce the cost of owning HP client PCs.

The HP CMS is the foundation for additional Altiris Client Management Solutions that address the following topics.

- Inventory and asset management
- Deployment and migration
- Help desk and problem resolution
- Software and operations management

For more information about the following topics, go to [http://www.hp.com/go/ssm](http://www.hp.com/go/ssm).

- How HP CMS works
- Which solutions are compatible with the operating system
- How to download a fully functional, 30-day evaluation version of Altiris solutions
**HP SoftPaq Download Manager**

HP SoftPaq Download Manager is a free, easy-to-use interface for locating and downloading software updates for the HP client PC models in your environment. By specifying your models, operating system, and language, you can quickly locate, sort, and select the softpaqs you need. To download HP SoftPaq Download Manager, visit [http://h20331.www2.hp.com/Hpsub/cache/509658-0-0-225-121.html](http://h20331.www2.hp.com/Hpsub/cache/509658-0-0-225-121.html).
**System Software Manager**

System Software Manager (SSM) is a utility available on Windows workstations that lets you update system-level software on multiple systems simultaneously. When executed on a PC client system, SSM detects hardware and software versions and then updates the software from a central repository, known as a *file store*. Driver versions supported by SSM are noted with a special icon on the software, the driver download Web site, and on the Support Software CD.

To download the utility or to obtain more information about SSM, see [http://www.hp.com/go/ssm](http://www.hp.com/go/ssm).

**Proactive Change Notification**

The Proactive Change Notification application uses the Subscriber’s Choice Web site to:

- Send Proactive Change Notification (PCN) e-mail informing you up to 60 days in advance of hardware and software changes to most commercial workstations and servers
- Send you e-mail containing customer bulletins, customer advisories, customer notes, and driver alerts for most commercial workstations and servers

You can create a profile to ensure you receive only the information relevant to the specific IT environment.

To learn more about the PCN application and to create a custom profile, see **Subscriber’s Choice on page 49**.

**Subscriber’s Choice**

Subscriber’s Choice is a client-based service from HP that supplies you with personalized product tips, feature articles, and driver and support alerts and notifications based on the profile.

Subscriber’s Choice Driver and Support Alerts and Notifications delivers e-mail notifying you that the information you subscribed to in the profile is available for review and retrieval.

To learn more about Subscriber’s Choice and create a custom profile, see:

**ROM Flash**

HP workstations include a programmable flash ROM. By establishing a setup password in the Computer Setup (F10) Utility, you can protect the ROM from being inadvertently updated or overwritten. This function is important to ensure the operating integrity of the workstation.

To upgrade the ROM, download the latest SoftPaq images from [http://www.hp.com/support/workstation_swdrivers](http://www.hp.com/support/workstation_swdrivers).

For maximum ROM protection, establish a setup password. The setup password prevents unauthorized ROM upgrades. SSM lets you create the setup password on several workstations simultaneously.

**Remote ROM Flash**

Remote ROM Flash lets system administrators safely upgrade the ROM on remote HP workstations from a centralized network management console. This permits consistent deployment and greater control of HP PC ROM images over the network.

To use Remote ROM Flash, the workstation must be powered on, or turned on using Remote Wakeup.

For more information about Remote ROM Flash and HPQFlash, see the HP Client Manager Software or System Software Manager sections at [http://www.hp.com/go/ssm](http://www.hp.com/go/ssm).

**HPQFlash**

The HPQFlash utility locally updates or restores the system ROM on PCs using a Windows operating system. For more information about HPQFlash, see [http://www.hp.com/go/ssm](http://www.hp.com/go/ssm), and enter the name of the workstation.
**FailSafe Boot Block ROM**

The FailSafe Boot Block ROM enables system recovery in the unlikely event of a ROM flash failure. For example, if a power failure occurs during a ROM upgrade, the Boot Block uses a flash-protected section of the ROM to verify a valid system ROM flash when power is restored to the workstation.

If the system ROM is valid, the workstation starts normally.

If the system ROM fails the validation check, the FailSafe Boot Block ROM provides enough support to start the workstation from a BIOS image CD created from a SoftPaq. The BIOS image CD programs the system ROM with a valid image.

When Boot Block detects an invalid system ROM, the workstation power LED blinks red eight times and the workstation beeps eight times; then the workstation pauses for two seconds. On some models, a Boot Block recovery mode message appears.

In preparation for system recovery, use the BIOS CD media file in the SoftPaq to create a BIOS image CD.

**Recovering the workstation from Boot Block Recovery mode**

To recover the workstation after it enters Boot Block recovery mode:

1. If there is media in the diskette or optical disk drives, remove it.
2. Insert a BIOS image CD into the CD drive.
   
   You can also use USB media such as an HP DriveKey.
3. Power off, then power on the workstation.
   
   If no BIOS image CD or USB media is found, you are prompted to insert one and restart the workstation.
   
   If a setup password has been established, the Caps Lock light illuminates and you are prompted for the password.
4. Enter the setup password.
   
   If the workstation starts from the CD or USB media and successfully reprograms the ROM, three keyboard lights illuminate. A rising-tone series of beeps also signals successful recovery.
5. Remove the CD or USB media and power off the workstation.
6. Restart the workstation.
Workstation security

This section provides information about providing system security through asset tracking, password security, hard disk drive locking, and chassis locks.

Asset tracking

Asset tracking features incorporated into the workstation provide asset tracking data that can be managed using HP Systems Insight Manager (HP SIM), HP CMS, or other systems-management applications.

Seamless, automatic integration between asset tracking features and these products lets you choose the management tool best suited to the environment and to leverage investments in existing tools.

HP also offers several solutions for controlling access to valuable components and information:

- **HP ProtectTools Embedded Security** prevents unauthorized access to data, checks system integrity, and authenticates third-party users attempting system access.

- Security features such as ProtectTools and the Side access panel sensor (Smart Cover Sensor) help prevent unauthorized access to the data and to the internal components of the workstation.

- By disabling parallel, serial, or USB ports, or by disabling removable-media boot capability, you can protect valuable data assets.

- Memory Change and Side access panel sensor (Smart Cover Sensor) alerts can be forwarded to system management applications to deliver proactive notification of tampering with a workstation’s internal components.

ProtectTools, the Side access panel sensor (Smart Cover Sensor), and the Side access panel solenoid lock (Hood Lock) are available as options on select systems.

Use the following utilities to manage security settings on the HP workstation:

- (Local) Use the Computer Setup (F10) Utility.

- (Remote) Use HP CMS or System SSM, which let you use a simple command-line utility to control security settings and permit the secure and consistent deployment.

For more information about the Computer Setup (F10) Utility, see *The Computer Setup (F10) Utility menu on page 34.*

The following table and sections refer to the management of workstation security through the Computer Setup (F10) Utility

**Table 4-2   Security features overview**

<table>
<thead>
<tr>
<th>Feature</th>
<th>Purpose</th>
<th>How it is established</th>
</tr>
</thead>
<tbody>
<tr>
<td>Removable Media Boot Control</td>
<td>Prevents booting from removable media drives</td>
<td>From the Computer Setup (F10)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Utility menu</td>
</tr>
<tr>
<td>Serial, Parallel, USB, or Infrared Interface Control</td>
<td>Prevents transfer of data through the integrated serial, parallel, USB, or infrared interface</td>
<td>From the Computer Setup (F10) Utility menu</td>
</tr>
<tr>
<td>Power-On Password</td>
<td>Prevents use of the workstation until the password is entered (applies to initial system startup and restarts)</td>
<td>From the Computer Setup (F10) Utility menu</td>
</tr>
</tbody>
</table>

52 Chapter 4   System management
Table 4-2  Security features overview (continued)

<table>
<thead>
<tr>
<th>Feature</th>
<th>Purpose</th>
<th>How it is established</th>
</tr>
</thead>
<tbody>
<tr>
<td>Setup Password</td>
<td>Prevents reconfiguration of the workstation (use of the Setup utility)</td>
<td>From the Computer Setup (F10)</td>
</tr>
<tr>
<td></td>
<td>until the password is entered</td>
<td>Utility menu</td>
</tr>
<tr>
<td>Network Server Mode</td>
<td>Provides unique security features for workstations used as servers</td>
<td>From the Computer Setup (F10)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Utility menu</td>
</tr>
</tbody>
</table>

**SATA hard disk drive security**

HP workstations include the HP DriveLock facility for SATA hard disk drives to prevent unauthorized access to data.

⚠️ **WARNING!** Enabling DriveLock can render a SATA hard disk drive permanently inaccessible if the master password is lost or forgotten. No method exists to recover the password or access the data.

DriveLock has been implemented as an extension to Computer Setup (F10) functions. It is only available when hard disk drives that support the ATA security command set are detected. On HP workstations, it is not available when the SATA emulation mode is RAID+AHCI or RAID.

DriveLock is for HP customers for whom data security is a paramount concern. For such customers, the cost of a hard disk drive and the loss of the data stored on it is inconsequential when compared to the damage that could result from unauthorized access to its contents.

To balance this level of security with the need to address the issue of a forgotten password, the HP implementation of DriveLock employs a two-password security scheme. One password is intended to be set and used by a system administrator, while the other is typically set and used by the user.

No “back door” can be used to unlock the drive if both passwords are lost. Therefore, DriveLock is most safely used when the data contained on the hard disk drive is replicated on a corporate information system or is regularly backed up.

If both DriveLock passwords are lost, the hard disk drive is rendered unusable. For users who do not fit the previously defined customer profile, this might not be acceptable. For users who fit this profile, it might be a tolerable risk, given the nature of the data stored on the hard disk drive.
**DriveLock applications**

The most practical use of DriveLock is in a corporate environment. The system administrator would be responsible for configuring the hard disk drive, which involves setting the DriveLock master password and a temporary user password. If you forget the user password or if the equipment is passed on to another employee, the master password can be used to reset the user password and regain access to the hard disk drive.

HP recommends that corporate system administrators who enable DriveLock also establish a corporate policy for setting and maintaining master passwords. This prevents situations in which an employee sets both DriveLock passwords before leaving the company. This scenario leaves the hard disk drive unusable and forces its replacement. Likewise, system administrators who do not set a master password might find themselves locked out of a hard disk drive and unable to perform routine checks for unauthorized software, other asset control functions, and support.

For users with less stringent security requirements, HP does not recommend enabling DriveLock. Users in this category include personal users, or users who do not maintain sensitive data on their hard disk drives as a common practice. For these users, the potential loss of a hard disk drive resulting from forgetting both passwords is much greater than the value of the data DriveLock protects.

Create an administrator-only setup password to restrict access to Computer Setup (F10) and DriveLock. This keeps users from enabling DriveLock.

**Using DriveLock**

When DriveLock detects hard disk drives that support the ATA security command, a DriveLock menu item appears under the Security menu in the Computer Setup (F10) menu. This presents you with options to set the master password and to enable DriveLock. You must provide a user password to enable DriveLock. Because a system administrator typically performs the initial configuration of DriveLock, set a master password first.

HP recommends that system administrators set a master password whether they plan to enable DriveLock or not. This lets administrators modify DriveLock settings if the drive is locked in the future. After the master password is set, the system administrator can enable DriveLock or leave it disabled.

If a locked hard disk drive is present, POST requires a password to unlock the device. If a power-on password is set and it matches the device’s user password, POST does not prompt the user to re-enter the password. Otherwise, the user is prompted to enter a DriveLock password.

For a cold start, use the master or user password. For a warm start, enter the same password used to unlock the drive during the preceding cold start.

Users have two attempts to enter a correct password. During cold start, if neither attempt succeeds, POST continues but the drive remains inaccessible. During a warm-start or restart from Windows, if neither attempt succeeds, POST halts and the user is instructed to cycle power.
Enabling DriveLock

To enable and set the DriveLock user password:

1. Power on or restart the workstation.

2. As soon as the workstation is powered on, press and hold F10 until you enter the Computer Setup (F10) Utility. Press Enter to bypass the title screen, if necessary.

   If you do not press F10 at the appropriate time, you must restart the workstation, and then press and hold F10 again to access the utility.

   If you are using a PS2 keyboard, you might see a keyboard error message. Disregard it.


4. For each DriveLock-capable drive, select a drive by pressing F10 to accept.

5. Under Enable/Disable DriveLock options, select Enable, and then press F10 to enable DriveLock for a specific drive.

   △ CAUTION: Forgetting the DriveLock password renders the drive unusable.

6. Enter a new user password, and then press F10 to accept. This password may be 1 to 32 characters long.

7. Enter the password again in the Enter New Password Again field. If you forget this password, the drive is rendered permanently disabled.

8. Select File>Save Changes and Exit, and then press F10. After you press F10, the workstation performs a cold start before invoking the DriveLock function.

   You can also use this process to set the DriveLock master password by selecting Master in Step 5.

When the workstation starts, you are prompted to enter the DriveLock password for each DriveLock-capable drive for which you have set a password. You have two attempts to enter the password correctly. If the password is not entered correctly, the workstation attempts to start anyway. However, the boot process most likely fails because data from a locked drive cannot be accessed.

In a single drive workstation, if the drive has DriveLock enabled, the workstation might not be able to boot to the operating system, and might try to boot from the network or from another storage device (depending on the boot ordering options). Regardless of the outcome of the start attempts, the drive-locked drive remains inaccessible without the DriveLock password.

In a two-drive workstation that has a boot drive and a data drive, you can apply the DriveLock feature to the data drive only. In this case, the workstation can always start, but the data drive is accessible only when the DriveLock password is entered.

Cold starts require that you enter DriveLock passwords. However, DriveLock passwords are also required for warm starts. For example, if you boot to DOS and press Ctrl+Alt+Del, you must enter the DriveLock password before the workstation completes the next start cycle. This warm-start behavior is consistent with the DriveLock feature.
**Password security**

The power-on password prevents unauthorized use of the workstation by requiring entry of a password to access applications or data when the workstation is powered on or restarted. The setup password specifically prevents unauthorized access to the Computer Setup (F10) Utility and can also override the power-on password. When prompted for the power-on password, entering the setup password instead enables access to the workstation.

You can establish a network-wide setup password, which lets the system administrator log in to all network systems to perform maintenance without having to know the power-on password.

**Establishing a setup password using Computer Setup (F10) Utility**

Establishing a setup password through the Computer Setup (F10) Utility prevents reconfiguration of the workstation (through the use of the Computer Setup (F10) Utility) until the password is entered.

To establish a setup password using the Computer Setup (F10) menu:

1. Power on or restart the workstation.
2. As soon as the workstation is powered on, press and hold F10 until you enter the Computer Setup (F10) Utility. Press Enter to bypass the title screen, if necessary.
   
   If you do not press F10 at the appropriate time, you must restart the workstation, and then press and hold F10 again to access the utility.
   
   If you are using a PS/2 keyboard, you might see a keyboard error message. Disregard it.
3. Select **Security>Setup Password** and then follow the onscreen instructions.
4. Before exiting, select **File>Save Changes and Exit**.
Establishing a power-on password using workstation setup

Establishing a power-on password through the Computer Setup (F10) Utility prevents access to the workstation when power is connected, unless you specify the password. When a power-on password is set, the Computer Setup (F10) Utility presents Password Options in the Security menu. The password options include Network Server Mode and Password Prompt on Warm Boot.

When Network Server Mode is disabled, you must enter the password when the workstation is powered on, when the key icon appears on the monitor. When Password Prompt on Warm Boot is enabled, you must enter the password. The password must also be entered each time the workstation is restarted. When Network Server Mode is enabled, the password prompt is not presented during POST, but an attached PS/2 keyboard remains locked until you enter the power-on password.

To enable Network Server Mode, you must set a power-on password under Advanced > Password Options. This option lets the workstation start without requiring the power-on password, although the keyboard and mouse remain locked until you enter the password. The keyboard LEDs flash in a rotating pattern when the workstation is in locked mode.

To establish a power-on password through the Computer (F10) menu:

1. Power on or restart the workstation.
2. As soon as the workstation is powered on, press and hold F10 until you enter the Computer Setup (F10) Utility. Press Enter to bypass the title screen, if necessary.
   If you do not press F10 at the appropriate time, you must restart the workstation and then press and hold F10 again to access the utility.
   If you are using a PS/2 keyboard, you might see a keyboard error message. Disregard it.
3. Select Security > Power-On Password and then follow the onscreen instructions.
4. Before exiting, select File > Save Changes and Exit.

Entering a power-on password

To enter a power-on password:

1. Restart the workstation.
2. When the key icon appears on the monitor, enter the current password, and then press Enter.

Type carefully. For security reasons, the characters you enter do not appear on the screen.

If you enter the password incorrectly, a broken key icon appears. Try again. After three unsuccessful tries, you will enter the F10 setup screen with read-only permission. (See the Setup Browse Mode option under the Power-On options.)
**Entering a setup password**

If a setup password has been established on the workstation, you will be prompted to enter it each time you run the Computer Setup (F10) Utility.

To enter a setup password:

1. Restart the workstation.
2. As soon as the workstation is powered on, press and hold F10 until you enter the Computer Setup (F10) Utility. Press Enter to bypass the title screen, if necessary.
   - If you do not press F10 at the appropriate time, you must restart the workstation and press and hold F10 again to access the utility.
   - If you are using a PS/2 keyboard, you might see a keyboard error message. Disregard it.
3. When the key icon appears on the monitor, enter the setup password, and press Enter.

   Type carefully. For security reasons, the characters you enter do not appear on the screen.

   If you enter the password incorrectly, a broken key icon appears. Try again. After three unsuccessful tries, you must restart the workstation before you can continue.

**Changing a power-on or setup password**

To change a power-on or setup password:

1. Restart the workstation.
2. To change the power-on password, go to step 4.
3. To change the setup password, as soon as the workstation is powered on, press and hold F10 until you enter the Computer Setup (F10) Utility. Press Enter to bypass the title screen, if necessary.
   - If you do not press F10 at the appropriate time, you must restart the workstation, and then press and hold the F10 key again to access the utility.
   - If you are using a PS/2 keyboard, you might see a keyboard error message. Disregard it.
4. When the key icon appears, enter the current password, a slash (/) or alternative delimiter character, the new password, another slash (/) or alternative delimiter character, and the new password again as shown:
   
   `current password/new password/new password`
   
   For information about the alternative delimiter characters, see *National keyboard delimiter characters on page 59*.
   
   Type carefully. For security reasons, the characters you enter do not appear on the screen.
5. Press Enter.
   
   The new password takes effect the next time you power on the workstation.

The power-on and setup passwords can also be changed using the Security options in the Computer Setup (F10) Utility.
Deleting a power-on or setup password

To delete a power-on or setup password:

1. Power on or restart the workstation.

2. Choose from the following:
   - To delete the power-on password, go to step 4.
   - To delete the setup password, as soon as the workstation is powered on, press and hold F10 until you enter the Computer Setup (F10) Utility. Press Enter to bypass the title screen, if necessary.

   If you do not press F10 at the appropriate time, you must restart the workstation and then press and hold F10 again to access the utility.

   Use the appropriate operating system shutdown process.

3. When the key icon appears, enter the current password followed by a slash (/) or alternative delimiter character: current password/.

   For information about the alternative delimiter characters see National keyboard delimiter characters on page 59.

4. Press Enter.

National keyboard delimiter characters

Each keyboard meets country-specific requirements. The syntax and keys you use for changing or deleting passwords depend on the keyboard included with the workstation.

Table 4-3 National keyboard delimiter characters

<table>
<thead>
<tr>
<th>Language</th>
<th>Delimiter</th>
<th>Language</th>
<th>Delimiter</th>
<th>Language</th>
<th>Delimiter</th>
</tr>
</thead>
<tbody>
<tr>
<td>Arabic</td>
<td>/</td>
<td>Greek</td>
<td>-</td>
<td>Russian</td>
<td>/</td>
</tr>
<tr>
<td>Belgian</td>
<td>=</td>
<td>Hebrew</td>
<td>-</td>
<td>Slovakian</td>
<td>-</td>
</tr>
<tr>
<td>BHCSY*</td>
<td>-</td>
<td>Hungarian</td>
<td>-</td>
<td>Spanish</td>
<td>-</td>
</tr>
<tr>
<td>Brazilian</td>
<td>/</td>
<td>Italian</td>
<td>-</td>
<td>Swedish/Finnish</td>
<td>/</td>
</tr>
<tr>
<td>Chinese</td>
<td>/</td>
<td>Japanese</td>
<td>/</td>
<td>Swiss</td>
<td>-</td>
</tr>
<tr>
<td>Czech</td>
<td>-</td>
<td>Korean</td>
<td>/</td>
<td>Taiwanese</td>
<td>/</td>
</tr>
<tr>
<td>Danish</td>
<td>-</td>
<td>Latin American</td>
<td>-</td>
<td>Thai</td>
<td>/</td>
</tr>
<tr>
<td>French</td>
<td>!</td>
<td>Norwegian</td>
<td>-</td>
<td>Turkish</td>
<td>-</td>
</tr>
<tr>
<td>French Canadian</td>
<td>é</td>
<td>Polish</td>
<td>-</td>
<td>U.K. English</td>
<td>/</td>
</tr>
<tr>
<td>German</td>
<td>-</td>
<td>Portuguese</td>
<td>-</td>
<td>U.S. English</td>
<td>/</td>
</tr>
</tbody>
</table>

* Bosnia-Herzegovina, Croatia, Slovenia, and Yugoslavia
Clearing passwords

If you forget the password, you cannot access the workstation.

For instructions about clearing passwords, see Configuring password security and resetting CMOS on page 216.

Chassis security

Side access panel sensor (Smart Cover Sensor) (optional)

The optional Side access panel sensor is a combination of hardware and software technology that can alert you when the workstation side access panel has been removed (if the sensor has been configured in the Computer Setup (F10) Utility).

The three levels of Side access panel sensor protection are shown in the following table:

<table>
<thead>
<tr>
<th>Level</th>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Level 0</td>
<td>Disabled</td>
<td>Side access panel sensor * is disabled (default).</td>
</tr>
<tr>
<td>Level 1</td>
<td>Notify User</td>
<td>When the workstation restarts, a message appears indicating that the workstation side access panel has been removed.</td>
</tr>
<tr>
<td>Level 2</td>
<td>Setup Password</td>
<td>When the workstation is restarted, a message appears indicating that the workstation side access panel has been removed. You must enter the setup password to continue.</td>
</tr>
</tbody>
</table>

* Side access panel sensor settings can be changed using the Computer Setup (F10) Utility.

Setting the side access panel sensor protection level

To set the side access panel sensor protection level:

1. Power on or restart the workstation.
2. As soon as the workstation is powered on, press and hold the F10 key until you enter the Computer Setup (F10) Utility. Press Enter to bypass the title screen, if necessary.

**NOTE:** If you do not press the F10 key at the appropriate time, you must restart the workstation, and then press and hold the F10 key again to access the Computer Setup (F10) Utility.

If you are using a PS/2 keyboard, you might see a keyboard error message. Disregard it.

3. Select Security>Smart Cover>Cover Removal Sensor, and follow the onscreen instructions.
4. Before exiting, select File>Save Changes and Exit.
Side access panel solenoid lock (optional)

The side access panel solenoid locks the side access panel to the chassis. The solenoid is controlled by a local or remote signal.

To lock the solenoid, set a password for the solenoid lock in the Computer Setup (F10) Utility. To unlock the solenoid, remove the solenoid lock password in the Computer Setup (F10) Utility.

The solenoid lock FailSafe Key—available from HP—is a device for manually disabling the solenoid lock. You will need the FailSafe Key in case of forgotten password, power loss, or workstation malfunction.
**Cable lock (optional)**

To prevent theft, the rear chassis panel of the workstation accommodates a keyed cable lock. This cable lock attaches to the chassis and secures it to the work area.

**Fault notification and recovery**

Fault notification and recovery features combine innovative hardware and software technology to prevent the loss of critical data and minimize unplanned downtime.

If the workstation is connected to a network that is managed by HP CMS, the workstation sends a fault notice to the network management application. With HP CMS, you can also remotely schedule diagnostics to run on managed PCs and create a summary report of failed tests.

**Drive Protection System**

The Drive Protection System (DPS) is a diagnostic tool built into hard disk drives and is installed in select HP workstations. The DPS helps diagnose problems that might result in unwarranted hard disk drive replacement.

When HP workstations are built, each installed hard disk drive is tested using the DPS, and a permanent record of key information is written onto each drive. Every time the DPS is run, test results are written to the hard disk drive. The service provider can use this information to help diagnose conditions that required you to run the DPS software.

**ECC fault prediction**

When the workstation encounters an excessive number of error checking and correcting (ECC) memory errors, it displays a local alert message. This message contains information about the errant DIMM, enabling you to take action before you experience noncorrectable memory errors. ECC DIMMs are standard on this workstation.

**Thermal sensors**

Several thermal sensors in the HP Workstation regulate workstation fans to maintain an acceptable, efficient chassis temperature.
Dual-state power button

With ACPI enabled, the power button can function as an on/off switch or as a button. This feature does not completely turn off power, but instead causes the workstation to enter a low-power standby state. This lets you go to standby without closing applications or return to the same operational state without any data loss.

Changing the power button configuration

To change the power button configuration:

1. Select Start, and then select Control Panel>Power Options.
2. In Power Options Properties, select the Advanced tab.
3. In the Power Button section, select Hibernate.

NOTE: Hibernate must be enabled in the Hibernate tab.

After configuring the power button to function as a button, you can press the power button to put the workstation in a very low power state. Press the button again to bring the workstation out of this low power state to full power state. To completely turn off power to the workstation, press and hold the power button for four seconds.

CAUTION: Do not use the power button to power off the workstation unless the system is not responding; turning off the power without operating system interaction can cause data loss.
This chapter presents removal and installation procedures for most internal workstation components. It includes these topics:

<table>
<thead>
<tr>
<th>Topics</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Warnings and cautions</td>
<td>65</td>
</tr>
<tr>
<td>Service considerations</td>
<td>66</td>
</tr>
<tr>
<td>Customer self-repair</td>
<td>71</td>
</tr>
<tr>
<td>Removing and installing components</td>
<td>72</td>
</tr>
<tr>
<td>Product recycling</td>
<td>163</td>
</tr>
</tbody>
</table>
Warnings and cautions

⚠️ **WARNING!**  ⚠️ Any surface or area of the equipment marked with this symbol indicates the presence of a hot surface or hot component. If this surface is contacted, the potential for injury exists. To reduce the risk of injury from a hot component, let the surface cool before touching.

⚠️ **WARNING!**  ⚠️ Any surface or area of the equipment marked with this symbol indicates the presence of an electrical shock hazard. To reduce the risk of injury from electrical shock, do not open any enclosed area marked with this symbol.

⚠️ **WARNING!**  ⚠️ To reduce the risk of electric shock or damage to your equipment:

— Do not disable the power cord grounding plug. The grounding plug is an important safety feature.
— Plug the power cord in a grounded (earthed) outlet that is easily accessible at all times.
— Disconnect power from the equipment by unplugging the power cord from the electrical outlet.

⚠️ **WARNING!**  ⚠️ To reduce the risk of serious injury, read the **Safety & Comfort Guide**. It describes proper workstation setup, posture, health, and work habits for computer users, and provides important electrical and mechanical safety information. This guide is located at [http://www.hp.com/ergo](http://www.hp.com/ergo).

⚠️ **WARNING!**  ⚠️ If a product is shipped in packaging marked with this symbol, the product must always be lifted by two persons to avoid personal injury due to product weight.

⚠️ **CAUTION:**  ⚠️ Static electricity can damage the electronic components of the workstation. Before beginning these procedures, be sure you discharge static electricity by briefly touching a grounded metal object.

⚠️ **CAUTION:**  ⚠️ Observe the following cautions when removing or replacing a processor:

— Installing a processor incorrectly can damage the system board. Contact an HP authorized reseller or service provider to install the processor. If you plan to install the processor yourself, read all of the instructions carefully before you begin.
— Failure to follow the workstation preparation instructions can result in an improperly installed processor, causing extensive workstation damage.
— Processor socket pins are delicate and bend easily. Use extreme care when placing the processor in the socket.

⚠️ **CAUTION:**  ⚠️ To prevent damage to the workstation, observe the following Electrostatic Discharge (ESD) precautions while performing the system parts removal and replacement procedures:

— Work on a static-free mat.
— Wear a static strap to ensure that any accumulated electrostatic charge is discharged from your body to the ground.
— Create a common ground for the equipment you are working on by connecting the static-free mat, static strap, and peripheral units to that piece of equipment.
NOTE: HP accessories are for use in HP Workstation products. They have been extensively tested for reliability and are manufactured to high quality standards.

Service considerations

Review the following sections, which describe service considerations, before removing and replacing system components.

⚠️ WARNING! Do not use the front bezel as a handle or lifting point when lifting or moving the workstation. Lifting the workstation from the front bezel, or lifting it incorrectly, could cause the workstation to fall, causing possible injury to you and damage to the workstation. To properly and safely lift the workstation, use the handles. If the workstation is not equipped with handles, lift from the bottom of the workstation.

Cautions, warnings and safety precautions

For safety, review the cautions, warnings, and safety precautions before accessing the workstation components. Also, review the Safety and Regulatory Guide that came with the workstation for more information.

ESD information

Generating static

The following table shows that different activities generate different amounts of static electricity. Static electricity increases as humidity decreases.

<table>
<thead>
<tr>
<th>Event</th>
<th>Relative humidity</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>55%</td>
</tr>
<tr>
<td>Walking across carpet</td>
<td>7,500V</td>
</tr>
<tr>
<td>Walking across vinyl floor</td>
<td>3,000V</td>
</tr>
<tr>
<td>Motions of bench worker</td>
<td>400V</td>
</tr>
<tr>
<td>Removing bubble pack from PCB</td>
<td>7,000V</td>
</tr>
<tr>
<td>Packing PCBs in foam-lined box</td>
<td>5,000V</td>
</tr>
</tbody>
</table>

CAUTION: Static electricity in the amount of 700 volts might degrade a product.
Preventing ESD equipment damage

Many electronic components are sensitive to ESD. Circuitry design and structure determine the degree of sensitivity. The following packaging and grounding precautions are necessary to prevent damage to electric components and accessories:

- Transport products in static-safe containers such as tubes, bags, or boxes, to avoid hand contact.
- Protect electrostatic parts and assemblies with nonconductive or approved containers or packaging.
- Keep electrostatic-sensitive parts in their containers until they arrive at static-free stations.
- Place items on a grounded surface before removing them from containers.
- When handling or touching a sensitive component or assembly, ground yourself by touching the chassis.
- Avoid contact with pins, leads, or circuitry.
- Place reusable electrostatic-sensitive parts from assemblies in protective packaging or nonconductive foam.

Personal grounding methods and equipment

Use the following items to help prevent ESD damage:

- **Wrist straps**—These are flexible straps with a maximum of one megohm ± 10% resistance in the ground cords. To provide a proper ground, wear the strap against bare skin. The ground cord must be connected and fit snugly into the banana plug connector on the grounding mat or workstation.

- **Heel straps, toe straps, and boot straps**—These can be used at standing workstations and are compatible with most types of shoes or boots. On conductive floors or dissipative floor mats, use them on both feet with a maximum of one megohm ± 10% resistance between the operator and ground.

The following table shows protection levels available from static shielding materials.

<table>
<thead>
<tr>
<th>Method</th>
<th>Voltage</th>
</tr>
</thead>
<tbody>
<tr>
<td>Antistatic plastic</td>
<td>1,500V</td>
</tr>
<tr>
<td>Carbon-loaded plastic</td>
<td>7,500V</td>
</tr>
<tr>
<td>Metallized laminate</td>
<td>15,000V</td>
</tr>
</tbody>
</table>

This section provides guidelines to prevent ESD damage to equipment.
Grounding the work area

To prevent static damage in the work area:

- Cover the work surface with approved static-dissipative material. Use a wrist strap connected to the work surface, and properly grounded tools and equipment.
- Use static-dissipative mats, foot straps, or air ionizers to give added protection.
- Handle electrostatic-sensitive components, parts, and assemblies by the case or PCB laminate. Handle them only in static-free work areas.
- Disconnect power and input signals before inserting and removing connectors or test equipment.
- Use fixtures made of static-safe materials when fixtures must directly contact dissipative surfaces.
- Keep work area free of nonconductive materials, such as plastic assembly aids and Styrofoam.
- Use field service tools (such as cutters, screwdrivers, and vacuums) that are conductive.

Recommended ESD prevention materials and equipment

The recommended materials and equipment are:

- Antistatic tape
- Antistatic smocks, aprons, and sleeve protectors
- Conductive bins and other assembly or soldering aids
- Conductive foam
- Conductive tabletop workstations with a ground cord of one megohm ± 10% resistance
- Static-dissipative table or floor mats with a hard-tie to ground
- Field service kits
- Static awareness labels
- Wrist straps and footwear straps providing one megohm ± 10% resistance
- Material-handling packages
- Conductive plastic bags
- Conductive plastic tubes
- Conductive tote boxes
- Opaque shielding bags
- Transparent metallized shielding bags
- Transparent shielding tubes
Tools and software requirements

The tools necessary for workstation component removal and installation are:

- Torx T-15 driver
- Flat blade and cross-tip screwdrivers
- Diagnostics software

Special handling of components

The components included in this section require special handling when servicing the workstation.

⚠️ WARNING! Do not use the front bezel as a handle or lifting point when lifting or moving the workstation. Lifting the workstation from the front bezel, or lifting it incorrectly, could cause the workstation to fall, causing possible injury to you and damage to the workstation. To properly and safely lift the workstation, lift from the bottom of the workstation.

Cables and connectors

Handle cables with care to avoid damage. Apply only the tension required to seat or unseat cables during insertion or removal from the connector. When possible, handle cables by the connector or pull-strap. In all cases, avoid bending or twisting the cables, and be sure that the cables are routed in such a way that they cannot be caught or snagged by parts being removed or replaced.

When servicing the workstation, be sure that cables are placed in their proper location during the reassembly process. Improper cable placement can damage the workstation.
**Hard disk drives**

Hard disk drives are fragile, precision components. Avoid subjecting them to physical shock and vibration. The following guidelines apply to all drives, including failed drives, replacement drives, and spares.

- Do not remove hard disk drives from the shipping package for storage. Keep hard disk drives in their protective packaging until they are mounted in the workstation.
- Avoid dropping hard disk drives from any height.
- If you are inserting or removing a hard disk drive, power off the workstation. Do not remove a hard disk drive while the workstation is powered on or in standby mode.
- Before handling a drive, be sure that you discharge static electricity. While handling a drive, avoid touching the connector. For more information about preventing electrostatic damage, see ESD information on page 66.

To prevent possible ESD damage when the drive is installed, connect the drive power cable before connecting the data cable. This discharges accumulated static electricity through the drive power cable to the workstation chassis.

- When inserting a drive, do not use excessive force.
- Avoid exposing a hard disk drive to liquids, temperature extremes, or products with magnetic fields such as monitors or speakers.

**Lithium coin cell battery**

The battery included with the workstation provides power to the real-time clock and has a lifetime of about three years.

For instructions on battery removal and replacement, see Battery on page 128.

⚠️ **WARNING!** This workstation contains a lithium battery. There is a risk of fire and chemical burn if the battery is handled improperly. Do not disassemble, crush, puncture, short the external contacts, dispose of in water or fire, or expose the battery to temperatures higher than 60° Centigrade (140° Fahrenheit).

접기 **NOTE:** Do not dispose of batteries, battery packs, and accumulators with general household waste.
Customer self-repair

Under the Customer Self-Repair program, you can order a replacement part and install the part without onsite HP technical assistance. See http://www.hp.com/go/selfrepair/ for information on the program as customer self-repair may be required for some components.

**NOTE:** Some components, like the liquid cooling system, are not eligible for Customer Self-Repair and must be returned to HP for service. Call HP Support for further instructions before attempting to remove or repair this system.
Removing and installing components

This section includes these topics:

<table>
<thead>
<tr>
<th>Topics</th>
<th>Component locations on page 73</th>
<th>Power button assembly on page 87</th>
<th>Expansion card slot identification on page 121</th>
</tr>
</thead>
<tbody>
<tr>
<td>Predisassembly procedures</td>
<td>Optical disk drive (mini-tower configuration) on page 89</td>
<td></td>
<td>Expansion card on page 124</td>
</tr>
<tr>
<td>on page 75</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Disassembly order on page 76</td>
<td>Optical disk drive (desktop configuration) on page 93</td>
<td></td>
<td>Battery on page 128</td>
</tr>
<tr>
<td>Cable lock (optional) on page 77</td>
<td>Workstation speaker on page 97</td>
<td></td>
<td>Hard disk drive on page 129</td>
</tr>
<tr>
<td>Side access panel on page 78</td>
<td>Power supply on page 98</td>
<td></td>
<td>Liquid cooling solution on page 134</td>
</tr>
<tr>
<td>Side access panel sensor (optional) on page 79</td>
<td>Power connections on page 99</td>
<td></td>
<td>CPU heatsink on page 154</td>
</tr>
<tr>
<td>Side access panel solenoid lock on page 82</td>
<td>Fan assemblies on page 100</td>
<td></td>
<td>CPU on page 157</td>
</tr>
<tr>
<td>Bezel on page 83</td>
<td>Airflow guide on page 110</td>
<td></td>
<td>System board on page 159</td>
</tr>
<tr>
<td>Front panel I/O device assembly on page 83</td>
<td>Memory on page 116</td>
<td></td>
<td>Converting to desktop configuration on page 161</td>
</tr>
</tbody>
</table>
Component locations

The following illustration and table identify workstation system board components.

**Figure 5-1** 4-DIMM configuration system board components

<table>
<thead>
<tr>
<th>Item</th>
<th>Component</th>
<th>Item</th>
<th>Component</th>
<th>Item</th>
<th>Component</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>CPU fan</td>
<td>12</td>
<td>Clear CMOS button</td>
<td>23</td>
<td>PCI 32/33</td>
</tr>
<tr>
<td>2</td>
<td>Rear chassis fan</td>
<td>13</td>
<td>Front power button/LED</td>
<td>24</td>
<td>PCIe2 x16</td>
</tr>
<tr>
<td>3</td>
<td>CPU power</td>
<td>14</td>
<td>Crisis recovery jumper</td>
<td>25</td>
<td>PCIe x8(4)</td>
</tr>
<tr>
<td>4</td>
<td>Solenoid hood lock</td>
<td>15</td>
<td>Front chassis fan</td>
<td>26</td>
<td>PCIe2 x16</td>
</tr>
<tr>
<td>5</td>
<td>CPU socket</td>
<td>16</td>
<td>HDD LED</td>
<td>27</td>
<td>PCIe2 x8(4)</td>
</tr>
<tr>
<td>6</td>
<td>Memory sockets</td>
<td>17</td>
<td>Internal USB 1/DASH</td>
<td>28</td>
<td>Audio</td>
</tr>
<tr>
<td>7</td>
<td>Main power</td>
<td>18</td>
<td>SATA ports</td>
<td>29</td>
<td>Network/USB</td>
</tr>
<tr>
<td>8</td>
<td>Battery</td>
<td>19</td>
<td>Internal USB 2</td>
<td>30</td>
<td>USB</td>
</tr>
<tr>
<td>9</td>
<td>Floppy disk drive</td>
<td>20</td>
<td>Front USB</td>
<td>31</td>
<td>Keyboard/mouse</td>
</tr>
</tbody>
</table>
### Table 5-2 4-DIMM system board components ID (continued)

<table>
<thead>
<tr>
<th>Item</th>
<th>Component</th>
<th>Item</th>
<th>Component</th>
<th>Item</th>
<th>Component</th>
</tr>
</thead>
<tbody>
<tr>
<td>10</td>
<td>Password jumper</td>
<td>21</td>
<td>Speaker</td>
<td>32</td>
<td>Serial</td>
</tr>
<tr>
<td>11</td>
<td>Chassis intrusion switch</td>
<td>22</td>
<td>Front audio</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Figure 5-2 6-DIMM configuration system board components

![6-DIMM configuration system board components](image)

### Table 5-3 6-DIMM system board components ID

<table>
<thead>
<tr>
<th>Item</th>
<th>Component</th>
<th>Item</th>
<th>Component</th>
<th>Item</th>
<th>Component</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>CPU fan</td>
<td>12</td>
<td>Clear CMOS button</td>
<td>23</td>
<td>Front audio</td>
</tr>
<tr>
<td>2</td>
<td>Rear chassis fan</td>
<td>13</td>
<td>Front power button/LED</td>
<td>24</td>
<td>PCI 32/33</td>
</tr>
<tr>
<td>3</td>
<td>CPU power</td>
<td>14</td>
<td>Crisis recovery jumper</td>
<td>25</td>
<td>PCIe2 x16</td>
</tr>
<tr>
<td>4</td>
<td>Solenoid hood lock</td>
<td>15</td>
<td>Front chassis fan</td>
<td>26</td>
<td>PCIe x8(4)</td>
</tr>
<tr>
<td>5</td>
<td>CPU socket</td>
<td>16</td>
<td>HDD LED</td>
<td>27</td>
<td>PCIe2 x16</td>
</tr>
<tr>
<td>6</td>
<td>Memory sockets</td>
<td>17</td>
<td>Internal USB 1/DASH</td>
<td>28</td>
<td>PCIe x8(4)</td>
</tr>
<tr>
<td>Item</td>
<td>Component</td>
<td>Item</td>
<td>Component</td>
<td>Item</td>
<td>Component</td>
</tr>
<tr>
<td>------</td>
<td>----------------</td>
<td>------</td>
<td>----------------</td>
<td>------</td>
<td>--------------</td>
</tr>
<tr>
<td>7</td>
<td>Main power</td>
<td>18</td>
<td>SATA ports</td>
<td>29</td>
<td>Audio</td>
</tr>
<tr>
<td>8</td>
<td>Battery</td>
<td>19</td>
<td>Internal USB 2</td>
<td>30</td>
<td>Network/USB</td>
</tr>
<tr>
<td>9</td>
<td>Floppy disk drive</td>
<td>20</td>
<td>Front USB</td>
<td>31</td>
<td>USB</td>
</tr>
<tr>
<td>10</td>
<td>Password jumper</td>
<td>21</td>
<td>Speaker</td>
<td>32</td>
<td>Keyboard/mouse</td>
</tr>
<tr>
<td>11</td>
<td>Chassis intrusion switch</td>
<td>22</td>
<td>Front 1394a</td>
<td>33</td>
<td>Serial</td>
</tr>
</tbody>
</table>

For related system architecture information, see System board architecture on page 2.

**Predisassembly procedures**

**NOTE:** Read Warnings and cautions on page 65 before servicing this component.

Perform the following steps before servicing a workstation:

1. Review the safety information and precautions in Warnings and cautions on page 65 and the Safety and Regulatory Information for the workstation.
2. Locate and clear a suitable work area.
3. Close all open software applications.
4. Remove all diskettes, CDs, and DVDs from the workstation.
5. Shut down the operating system.
6. Power off the workstation and all peripheral devices connected to it.
7. Remove or disengage security devices that prevent you from opening the workstation.
8. Disconnect the power cord from the electrical outlet and then from the workstation.
9. Disconnect peripheral device cables from the workstation.
10. Gather the tools.
11. Service the workstation.
12. Return your workstation to use by reversing the appropriate steps in this procedure when servicing is done.
Disassembly order

For convenience, disassembly procedures should be followed in a particular order. Use the following table to determine the sequence in which to access major workstation components.

**Table 5-4  Workstation component installation**

<table>
<thead>
<tr>
<th>To install/replace...</th>
<th>Remove...</th>
<th>Then remove...</th>
<th>Then remove...</th>
<th>Then remove...</th>
<th>Then remove...</th>
<th>Then remove...</th>
<th>Then remove...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hard drive, battery, front bezel, rear system fan, side access panel sensor, or solenoid lock</td>
<td>Chassis lock</td>
<td>Side access panel</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Memory, liquid cooling system, heatsink, or power supply</td>
<td>Chassis lock</td>
<td>Side access panel</td>
<td>Airflow guide</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Processor</td>
<td>Chassis lock</td>
<td>Side access panel</td>
<td>Airflow guide</td>
<td>Heatsink</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Front fan</td>
<td>Chassis lock</td>
<td>Side access panel</td>
<td>Full-length expansion cards</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Expansion card (PCI/PCIe)</td>
<td>Chassis lock</td>
<td>Side access panel</td>
<td>Expansion card hold down clamp or support</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Front panel I/O assembly, power button assembly, side access panel sensor, or system speaker</td>
<td>Chassis lock</td>
<td>Side access panel</td>
<td>Front bezel</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Optical bay filler or optical drive</td>
<td>Chassis lock</td>
<td>Side access panel</td>
<td>Airflow guide</td>
<td>Front bezel</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>System board</td>
<td>Chassis lock</td>
<td>Side access panel</td>
<td>Airflow guide</td>
<td>Expansion card hold down clamp or support</td>
<td>Expansion cards or DIMMs</td>
<td>Liquid cooling system (if any)</td>
<td>Heatsink (optional)</td>
</tr>
</tbody>
</table>

**NOTE:** Z400s with 4 DIMM slots do not have an airflow guide.
**Cable lock (optional)**

If a cable lock is installed on the workstation, remove it before servicing the workstation. Unlock it and pull it out of the cable lock slot as shown in the following figure.

*Figure 5-3*  Removing the cable lock
**Side access panel**

Before accessing the internal components of the workstation, you must remove the side access panel. This section describes how to remove and install the side access panel.

**Removing the side access panel**

To remove the side access panel:

⚠️ **WARNING!** Before removing the workstation side access panel, be sure that the workstation is powered off and that the power cord is disconnected from the electrical outlet.

1. Power down the workstation (see *Predisassembly procedures on page 75*).
2. Disconnect power from the workstation (see *Predisassembly procedures on page 75*).
3. Remove locks that are present such as a cable lock.
4. Pull up on the handle (1), slide the cover 1/2-inch towards the rear of the system (2), then rotate the cover off the chassis (3) as shown in the following figure.

*Figure 5-4* Removing the side access panel

**Installing the side access panel**

To install the side access panel:

1. Align the bottom groove of the side panel with the bottom edge of the chassis.
2. Rotate the side panel toward the chassis, slide the panel forward to engage the fingers on the top cover as well as the latch, then press firmly until the latch engages.
Side access panel sensor (optional)

The side access panel sensor (also called the hood sensor or Smart Cover Sensor) is a switch that detects when the side access panel is opened. The side access panel sensor is mounted either on a metal bracket attached to the front chassis or on the front fan holder/card guide.

This section describes how to remove and install the sensor.

Removing the side access panel sensor

To remove the side access panel sensor (bracket mounting):

1. Power down the workstation (see Predisassembly procedures on page 75).
2. Disconnect power from the workstation (see Predisassembly procedures on page 75).
3. Remove the side access panel (see Removing the side access panel on page 78).
4. Disconnect the sensor cable from the HSENSE receptacle on the system board, as shown below (1).

   **Figure 5-5** Removing the side access panel sensor (bracket mounting)

5. Remove the sensor by sliding the sensor in the slot in the bracket toward the front of the chassis and then pushing the sensor down (2).
6. If removing the metal mounting bracket for the sensor:
   a. Remove the front bezel (see Removing the front bezel on page 83).
   b. Remove the two screws that hold the metal bracket to the front of the chassis (3).
To remove the side access panel sensor (front fan holder mounting):

1. Power down the workstation (see Predisassembly procedures on page 75).
2. Disconnect power from the workstation (see Predisassembly procedures on page 75).
3. Remove the side access panel (see Removing the side access panel on page 78).
4. Disconnect the sensor cable from the HSENSE receptacle on the system board, as shown below (1).

   **NOTE:** To locate system board components, see the service label on the side access panel.

5. Remove the sensor by sliding the sensor in its slot in the fan holder/card guide toward the front of the chassis (2).

   **Figure 5-6** Removing the side access panel sensor (fan holder mounting)

   To remove the fan holder/card guide, see Removing the front fan assembly on page 101.

### Installing the side access panel sensor

The metal mounting bracket for the sensor is part of the sensor kit and must be installed before installing a sensor for the first time. Installing a front fan or some full-length expansion cards may require that you install a front fan holder/card guide instead of the mounting bracket.

To install a bracket-mounted side access panel sensor, reverse the removal steps (see Removing the side access panel sensor on page 79).

To install a side access panel sensor when a front fan holder/card guide is present:
NOTE: The metal bracket where the sensor resides is part of the sensor kit and must be installed before installing a sensor for the first time. Installing a front fan or some full-length expansion cards may require that you install a front fan holder/card guide instead of the mounting bracket. See Installing the front fan assembly on page 104 for details on installing the side access panel sensor with the fan assembly.

1. Power down the workstation (see Predisassembly procedures on page 75).
2. Disconnect power from the workstation (see Predisassembly procedures on page 75).
3. Remove the side access panel (see Removing the side access panel on page 78).
4. Install the sensor by sliding the sensor into the slot provided for it in the fan holder/card guide (1), as shown in the following illustration.

   Figure 5-7 Installing the side access panel sensor (fan holder mounting)

5. Carefully route the sensor cable along the bottom of the drive bay so that it is not pinched by the fan holder/card guide and plug the sensor cable into the HSENSE connector on the system board (2).

   △ CAUTION: Clamping a cable between the card guide and the chassis might damage the cable.

   ☏ NOTE: To locate system board components, see the service label on the side access panel.

6. Make sure that the cable will not interfere with the expansion cards.
**Side access panel solenoid lock**

The side access panel solenoid lock provides a method to lock the side access panel by means of a local or remote signal-controlled solenoid.

This section describes how to remove and install the side access panel solenoid lock.

**Removing the side access panel solenoid lock**

To remove the side access panel solenoid lock:

1. Power down the workstation (see *Predisassembly procedures on page 75*).
2. Disconnect power from the workstation (see *Predisassembly procedures on page 75*).
3. Remove the side access panel (see *Removing the side access panel on page 78*).
4. Disconnect the side access panel solenoid lock cable from the system board (1).
5. Remove the two screws that fasten the solenoid lock to the chassis (2), as shown in the following figure.
6. Pull the solenoid lock assembly inward and then up (3) to remove the assembly from the chassis.

![Figure 5-8 Removing the side access panel solenoid lock](image)

**Installing the side access panel solenoid lock**

Reverse the above steps to install the side access panel solenoid lock. This involves connecting the solenoid lock cable to the system board and fastening the solenoid lock to the chassis.
Bezel

This section describes how to remove and install the front chassis bezel.

Removing the front bezel

To remove the front bezel:

1. Remove the side access panel (see Removing the side access panel on page 78).
2. Lift the release tabs (1), and then rotate the front bezel off the chassis (2).

Figure 5-9 Removing the front bezel

Installing the front bezel

To install the front bezel, align the tabs discussed in the previous section and rotate the bezel until it snaps in place.

Front panel I/O device assembly

This section describes how to remove and install a front panel I/O device assembly.

Removing the front panel I/O device assembly

To remove the front panel I/O device assembly:

1. Power down the workstation (see Predisassembly procedures on page 75).
2. Disconnect power from the workstation (see Predisassembly procedures on page 75).
3. Remove the side access panel (see Removing the side access panel on page 78).
4. Remove the front bezel (see Removing the front bezel on page 83).

5. Remove the top set of fastening screws from the I/O device assembly (1), as shown in the following figure.

**Figure 5-10** Removing the front panel I/O device assembly

6. Remove the bottom set of fastening screws from the I/O device assembly (2).

7. Pull the mounting bracket away from the chassis (3).

8. Grasp the I/O device assembly (4), and pull it away from the chassis (5).
9. Disconnect the front panel I/O device assembly cables from the system board as shown below.

**NOTE:** Z400s with 6 DIMM slots have an additional cable from the front panel to the 1394a connector on the system board that you must also disconnect.

**Figure 5-11** Disconnecting the front panel I/O cables

10. Carefully guide the front panel I/O device assembly from the chassis.
Installing the front panel I/O device assembly

To install the front panel I/O device assembly:

1. Guide the front panel I/O device assembly cables through the chassis openings from which they were removed.

2. Place the front panel I/O device assembly in the chassis.

3. Install the fastening screws in the reverse order from which they were removed.

4. Connect the front panel I/O cables directly to the system board. Connect the audio cable to the connector at (1) and the USB cable to the connector at (3), as shown in the following diagram.
   - For 6 DIMM Z400s, connect the front 1394a cable directly to the system board at location (2), as shown in the following diagram.
   - For 4 DIMM Z400s, connect the front 1394a cable directly to the optional 1394a expansion card. (If the 1394a cable is not used, use the plastic clip at the bottom of the chassis to secure the cable.)

Figure 5-12 Connecting the front panel I/O device cables
Power button assembly

This section describes how to remove and install the power button assembly.

Removing the power button assembly

To remove the power button assembly:

1. Power down the workstation (see Predisassembly procedures on page 75).
2. Disconnect power from the workstation (see Predisassembly procedures on page 75).
3. Remove the side access panel (see Removing the side access panel on page 78).
4. Remove the front bezel (see Removing the front bezel on page 83).
5. Disconnect the power button cable from the system board, as shown below.

Figure 5-13 Disconnecting the power button cable

6. From inside of the chassis, push the tabs (1) in from the chassis sides.
7. Pull the power button assembly (2) from the chassis.

**Figure 5-14** Removing the power button assembly

---

**Installing the power button assembly**

To replace the power button assembly, reverse the previous steps.
Optical disk drive (mini-tower configuration)

This section describes how to remove and install an optical disk drive in the workstation mini-tower configuration.

Removing an optical disk drive from the optical bay (mini-tower configuration)

1. Power down the workstation (see Predisassembly procedures on page 75).
2. Disconnect power from the workstation (see Predisassembly procedures on page 75).
3. Remove the side access panel (see Removing the side access panel on page 78).
4. Remove the airflow guide (see Removing the airflow guide on page 110).
5. Remove the front bezel (see Removing the front bezel on page 83).
6. Disconnect the data (1) and power (2) cables from the optical disk drive as shown in the following figure.

**Figure 5-15** Disconnecting optical disk drive cables
7. Lift the green drive-lock release lever (1) and gently slide the drive out of the chassis (2) as shown in the following figure.

**Figure 5-16** Removing the optical disk drive

8. After removing the drive, remove the four guide screws on the sides of the drive (two per side) if you plan to install another drive.
Installing an optical disk drive in the optical bay (mini-tower configuration)

To install an optical disk drive:

1. Power down the workstation (see *Predisassembly procedures on page 75*).
2. Disconnect power from the workstation (see *Predisassembly procedures on page 75*).
3. Remove the side access panel (see *Removing the side access panel on page 78*).
4. Remove the airflow guide (see *Removing the airflow guide on page 110*).
5. Remove the front bezel (see *Removing the front bezel on page 83*).
6. Remove the bezel blank where you want to add the drive.
7. Install the four black metric M3 guide screws into the sides of the drive.
8. Lift the green release lever (1), align the screws with the grooves in the drive bay, and gently slide the drive into the bay until it snaps into place (2).

⚠️ **CAUTION:** Ensure that the optical drive is secure in the workstation chassis by pulling on the drive to see if it can be disengaged. Failure to properly secure the drive can cause damage to the drive when moving the workstation.

*Figure 5-17* Installing the optical disk drive

9. Connect the power and data cables to the drive as shown in the following figure. (See the service label on the side access panel for component locations in your model of Z400.)
10. Connect the optical disk drive data cable to the appropriate SATA port on the system board as shown in the following figure.

**Figure 5-18  Connecting power and data cables**

11. Reverse steps 1–5 to replace the components you removed during installation.
Optical disk drive (desktop configuration)

This section describes how to remove and install an optical disk drive in the workstation desktop configuration.

Removing an optical drive (desktop configuration)

1. Power down the workstation (see Predisassembly procedures on page 75).
2. Disconnect power from the system (Predisassembly procedures on page 75),
3. Remove the side access panel (Removing the side access panel on page 78).
4. If your system has an airflow guide, remove it (see Removing the airflow guide on page 110).
5. Remove the front bezel (Removing the front bezel on page 83).
6. Disconnect the data (1) and power (2) cables from the optical disk drive as shown in the following figure. (The connector colors might be different than shown in the figure.)

   Figure 5-19  Disconnecting the optical drive cables
7. Press down on the yellow drive-lock release lever (1) and gently slide the drive out of the chassis (2).

**Figure 5-20** Removing the optical drive from chassis

8. After removing the drive (1), remove the four guide screws from the drive (2) if you plan to install another drive.

**Figure 5-21** Removing the optical drive screws
Installing an optical drive (desktop configuration)

1. Power down the workstation (see *Predisassembly procedures on page 75*).
2. Disconnect power from the system (*Predisassembly procedures on page 75*).
3. Remove the side access panel (*Removing the side access panel on page 78*).
4. If your system has an airflow guide, remove it (see *Removing the airflow guide on page 110*).
5. Remove the front bezel (see *Removing the front bezel on page 83*).
6. Remove the bezel blank from the bay in which you want to install the drive.
7. Install the four black metric M3 guide screws into the drive (1).

   **Figure 5-22** Installing the optical drive

8. Align the screws with the grooves in the drive bay and gently slide the drive into the bay until it snaps into place (2).

   △ **CAUTION:** Ensure that the optical drive is secure in the workstation chassis by pulling on the drive to see if it can be disengaged. Failure to properly secure the drive can cause damage to the drive when moving the workstation.
9. Connect the data (1) and power (2) cables from the system board to the optical disk drive as shown in the following figure. (See the service label on the side access panel for component locations in your model of Z400.)

**Figure 5-23** Connecting the optical drive cables

10. Reverse steps 1–5 to replace the components you removed during installation.
Workstation speaker

This section describes how to remove and install the workstation speaker.

Removing the workstation speaker

To remove the workstation speaker:

1. Power down the workstation (see Predisassembly procedures on page 75).
2. Disconnect power from the workstation (see Predisassembly procedures on page 75).
3. Remove the side access panel (see Removing the side access panel on page 78).
4. Remove the front bezel (see Removing the front bezel on page 83).
5. Disconnect the speaker cable from the system board (1), as shown in the figure below.
6. Remove the two speaker mounting screws (2).
7. Remove the speaker by sliding it away from the front panel into the chassis (3).

Figure 5-24 Removing the workstation speaker

Installing the workstation speaker

To install the speaker, reverse the previous steps.
Power supply

This section describes how to remove and install a power supply.

Removing the power supply

To remove the power supply:

1. Power down the workstation (see Predisassembly procedures on page 75).
2. Disconnect power from the workstation (see Predisassembly procedures on page 75).
3. Remove the side access panel (see Removing the side access panel on page 78).
4. Remove the airflow guide (see Removing the airflow guide on page 110).
5. Disconnect all of the power supply cables from the system board and all peripheral devices (hard drives, optical drives, and others as needed).
6. Remove the four screws from the rear of the chassis (1).
7. Slide the power supply inward then up to remove it from the chassis (2).

![Figure 5-25 Removing power supply](image)

Installing the power supply

To install the power supply, reverse the previous steps.
Power connections

For help with identifying power cables, see the following figure and table. Make sure that you route or tie all cables so they cannot interfere with the processor heatsink fan.

**Figure 5-26** Power connector identification for a typical configuration

**Table 5-5** Power connector description

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>Power supply</td>
<td>G</td>
<td>(P8) Optical drive</td>
</tr>
<tr>
<td>B</td>
<td>(P1) Main power</td>
<td>H</td>
<td>(P9) Floppy diskette drive</td>
</tr>
<tr>
<td>C</td>
<td>(P3) CPU power</td>
<td>I</td>
<td>(P10) Hard drive</td>
</tr>
<tr>
<td>D</td>
<td>(P12) PCIe auxiliary power</td>
<td>J</td>
<td>(P11) Hard drive</td>
</tr>
<tr>
<td>E</td>
<td>(P4/P5) Optical drive</td>
<td>K</td>
<td>(P13) Auxiliary/diskette drive</td>
</tr>
<tr>
<td>F</td>
<td>(P6/P7) Optical drive</td>
<td>L</td>
<td>(P14) PCIe auxiliary power (600W power supply only)</td>
</tr>
</tbody>
</table>
Fan assemblies

This section describes how to remove and install the front or rear system fan assemblies.

Removing the rear system fan assembly

To remove the rear system fan assembly:

1. Power down the workstation (see Predisassembly procedures on page 75).
2. Disconnect power from the workstation (see Predisassembly procedures on page 75).
3. Remove the side access panel (see Removing the side access panel on page 78).
4. Disconnect the rear system fan assembly cable (1) from the system board as shown in the following figure.

Figure 5-27 Disconnecting fan wires

5. Remove the four screws from the rear of the chassis (2), and then pull the fan assembly inward and then up (3) out of the chassis.

Installing the rear system fan assembly

To install the rear system fan assembly, reverse the removal steps.
Removing the front fan assembly

1. Power down the workstation (see Predisassembly procedures on page 75).
2. Disconnect power from the workstation (see Predisassembly procedures on page 75).
3. Remove the side access panel (see Removing the side access panel on page 78).
4. Remove the front bezel (see Removing the front bezel on page 83).
5. To have adequate clearance to remove the fan assembly, remove any full-length expansion cards (see Removing an expansion card on page 124).
6. If installed, remove the side access panel sensor (see Removing the side access panel sensor on page 79).
7. Unplug the front fan connector from the front chassis fan header on the system board.

   NOTE: To locate system board components, see the service label on the side access panel.

8. On the front of the chassis, press down and inward on the top two tabs that attach the fan holder/card guide to the metal grid.

   Figure 5-28 Releasing the top mounting tabs
9. When the top tabs release, rotate the top of the fan holder/card guide into the chassis (1) so that the bottom tabs release from the metal grid on the chassis, and then slide the guide away from the front panel (2).

Figure 5-29  Freeing the fan assembly from the chassis
10. Rotate the fan holder/card guide assembly slightly to one side (1), and then lift it up and out of the chassis (2).

**Figure 5-30** Removing the fan holder/card guide assembly
11. Remove the fan from the fan holder/card guide.

Figure 5-31 Removing the fan

Installing the front fan assembly

**NOTE:** Only computers having non-factory-integrated, high power PCI cards require the additional cooling provided by the optional front chassis fan included in this kit. This front fan is not recommended for use on computers that have hard drives mounted in the optical bays if your environmental temperature exceeds 27°C (80°F). This might reduce long term reliability of these hard drives.

1. Power down the workstation (see *Predisassembly procedures on page 75*).
2. Disconnect power from the workstation (see *Predisassembly procedures on page 75*).
3. Remove the side access panel (see *Removing the side access panel on page 78*).
4. To have adequate clearance for installing the fan, remove any full-length expansion cards (see *Removing an expansion card on page 124*).
5. Remove the front bezel (see *Removing the front bezel on page 83*).
6. If installed, remove the side access panel sensor (see *Removing the side access panel sensor on page 79*).
7. Insert the fan unit into the fan holder/card guide. Align the fan with the label facing inward. If an airflow indicator is present on the fan, make sure it points toward the holder and the rear of the chassis. Position the power cable so that it has the maximum length to reach the system board.

**Figure 5-32** Inserting the fan into the fan holder/card guide

8. If a side access panel sensor is present:
   - Some older fan holder/card guides are compatible with the metal mounting bracket for the side access panel sensor. If the fan holder/card guide has enough clearance for the side access panel sensor to remain on the metal mounting bracket, do nothing.
   - New fan holder/card guides are not compatible with the metal mounting bracket for the side access panel sensor. If this is the case, you must move the sensor from the bracket to the fan holder/card guide, as described below:

To move the side access panel sensor:

a. Remove the sensor and its metal mounting bracket (see Removing the side access panel sensor on page 79).
b. Insert the side access panel sensor into the slot provided on the fan holder/card guide.

Figure 5-33  Inserting the side access panel sensor into the fan holder/card guide
9. Route the front chassis cables so that they will clear the fan holder/card guide:
   - Route the front USB and power switch cables along the bottom of the drive bay (1).
   - Route the speaker cable along the side wall of the chassis (2).

Figure 5-34 Routing the cables
10. Insert the fan holder/card guide assembly. Make sure that the fan cable can reach the power receptacle on the system board.

**TIP:** Rotate the fan assembly slightly from side to side to fit it into the chassis.

**CAUTION:** Clamping a cable between the card guide and the chassis might damage the cable.

*Figure 5-35* Inserting the fan holder/card guide assembly

11. Finish installing the fan holder/card guide assembly, as shown in the following illustration:

- **a.** Slide the fan holder/card guide toward the front of the chassis (1).
- **b.** Rotate the fan holder/card guide so that the bottom tabs snap into the grid on the chassis first, followed by the top tabs (2).

  **CAUTION:** Clamping a cable between the card guide and the chassis might damage the cable.

- **c.** Plug the front fan connector into the front chassis fan header on the system board (3).

  **NOTE:** To locate system board components, see the service label on the side access panel.
d.  (If installing side access panel sensor) Carefully route the side access panel sensor cable along the drive bay and plug it into the HSENSE connector on the system board (4).

**NOTE:** To locate system board components, see the service label on the side access panel.

*Figure 5-36 Installing the fan holder/card guide assembly*

12. Make sure that none of the cables are pinched by the fan holder/card guide assembly.

13. Replace components removed during this procedure:

   a. Replace the front bezel (see Installing the front bezel on page 83).

   b. Replace any expansion cards that you removed (see Installing an expansion card on page 127), making sure that the cables will not interfere with the expansion cards. The slots in the fan holder/card guide will now help secure any full-length expansion cards.

   c. Replace the side access panel (see Installing the side access panel on page 78).
**Airflow guide**

This section describes how to remove and install the airflow guide used in the 6-DIMM versions of the workstation.

**Removing the airflow guide**

1. Power down the workstation (see *Predisassembly procedures on page 75*).
2. Disconnect power from the workstation (see *Predisassembly procedures on page 75*).
3. Remove the side access panel (see *Removing the side access panel on page 78*).
4. Press the airflow guide release latches as shown in the following figure, and guide the airflow guide out of the chassis.

   **Figure 5-37** Removing the airflow guide
Installing the airflow guide

1. Power down the workstation (see Predisassembly procedures on page 75).
2. Disconnect power from the workstation (see Predisassembly procedures on page 75).
3. Remove the side access panel (see Removing the side access panel on page 78).
4. Press the power cables, including P1, down toward the system board between the DIMM slots and the internal bay, as shown in the following figure.

Figure 5-38 Positioning the chassis cables
5. Set the airflow guide into the chassis.
   
a. Place the edge of the airflow guide (1) between DIMM socket #6 and the CPU heatsink.

   **Figure 5-39** Installing the airflow guide

b. Route the power and data cables through the opening next to the internal bay (2).
6. Route the CPU power cable (P3) through the opening next to the power supply as shown in the following figure.

**Figure 5-40** Routing the CPU power cable
7. Secure the airflow guide in the chassis.
   
   a. Insert the tab on the airflow guide into the slot next to the yellow ODD release lever (1), and then press down as shown in the following figure.

   Figure 5-41  Securing the airflow guide

   b. Ensure that the airflow guide secures even with the end of the FDD bay, and that the latch (2) engages with the slot in the internal bay cover.
c. Ensure that the latch on the top of the airflow guide snaps under the edge of the chassis frame as shown in the following figure.

**Figure 5-42** Securing the airflow guide latch

8. Replace all components that were removed in preparation for component installation.
Memory

This section presents memory module (DIMM) configuration information and removal/installation procedures.

**DIMM installation guidelines**

- Install only HP-approved unbuffered DDR3 DIMMs. See [http://www.hp.com/go/quickspecs](http://www.hp.com/go/quickspecs) to find which DIMMs are compatible with the workstation.

⚠️ **CAUTION:** HP ships only DIMMs that are electrically and thermally compatible with this workstation. Because third-party DIMMs might not be electrically or thermally compatible, they are not supported by HP.

**DIMM installation order**

Review the following figures to determine the correct installation order for DIMMs.

**Figure 5-43** 4-DIMM load order
**Supported DIMM configurations**

The workstation supports these DIMM arrangements, depending on which Z400 product you order:

- Up to six DIMM slots
- Memory range from 1 GB to 16GB for the 4-DIMM product
- Memory range from 1 GB to 24GB for the 6-DIMM product
- No support for mirroring
- No support for DIMM sparing

**BIOS errors and warnings**

The BIOS generates warnings/errors on invalid memory configurations:

- If the BIOS can find a valid memory configuration by disabling plugged-in memory, it does so and reports a warning during POST. the workstation can still be started. The warning will indicate the location of the failed DIMM on the system board.
- If there is no way for the BIOS to obtain a valid memory configuration by disabling plugged-in memory, the BIOS halts with a diagnostics 2006 code for memory error (five beeps and blinks).
Removing a DIMM

To remove a DIMM:

1. Power down the workstation (see Predisassembly procedures on page 75).
2. Disconnect power from the workstation (see Predisassembly procedures on page 75).

⚠️ **CAUTION:** To prevent electrical damage to the DIMMs during removal or installation, power off the workstation and unplug the power cord from the AC power outlet. Otherwise, the workstation may not recognize the memory changes.

3. Remove the side access panel (see Removing the side access panel on page 78).
4. If your system has an airflow guide, remove it (see Removing the airflow guide on page 110).
5. Push gently outward on the DIMM socket levers (1) as shown in the following figure.

   **Figure 5-45**  Removing a DIMM

6. Lift the DIMM straight up (2) and out of the socket, then store the DIMM in an antistatic bag.
Installing a DIMM

To install the DIMM:

1. Power down the workstation (see Predisassembly procedures on page 75).
2. Disconnect power from the workstation (see Predisassembly procedures on page 75).

⚠️ **CAUTION:** To prevent electrical damage to the DIMMs during removal or installation, power off the workstation and unplug the power cord from the AC power outlet. Otherwise, the workstation may not recognize the memory changes.

3. Remove the side access panel (see Removing the side access panel on page 78).
4. If your system has an airflow guide, remove it (see Removing the airflow guide on page 110).
5. Push gently outward on the DIMM socket levers as shown in the following figure.

**Figure 5-46** Opening DIMM socket levers
6. Align the DIMM connector key with the DIMM socket key, and then seat the DIMM firmly in the socket (1), as shown in the following figure.

⚠️ **CAUTION:** DIMMs and their sockets are keyed for proper installation. To prevent socket or DIMM damage, align these guides properly when installing DIMMs.

**Figure 5-47** Seating the DIMM

7. Secure the socket levers (2).

8. For a 6-DIMM workstation configuration, replace the airflow guide (see Installing the airflow guide on page 111).

9. Replace all components that you removed in preparation for component installation.
Expansion card slot identification

This section identifies and describes workstation expansion card slots, and presents card configuration information.

Slot identification and description

The following figure identifies workstation expansion card slots.

**Figure 5-48** Identifying expansion card slots

The following table describes the workstation PCIe card slots.

<table>
<thead>
<tr>
<th>Slot</th>
<th>Type</th>
<th>Slot power (Maximum)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>PCIe2 - x8(4)</td>
<td>25W</td>
</tr>
<tr>
<td>2</td>
<td>PCIe2 - x16</td>
<td>75W</td>
</tr>
<tr>
<td>3</td>
<td>PCIe - x8(4)</td>
<td>25W</td>
</tr>
<tr>
<td>4</td>
<td>PCIe2 - x16</td>
<td>75W</td>
</tr>
<tr>
<td>5</td>
<td>PCI 32/33</td>
<td>25W</td>
</tr>
<tr>
<td>6</td>
<td>PCI 32/33</td>
<td>25W</td>
</tr>
</tbody>
</table>

**NOTE:** The x1, x4, x8, and x16 designators describe the mechanical length of the slot. The number in parentheses shows how many electrical PCIe lanes are routed to the expansion slot. For example, x16(8) means that the expansion slot is mechanically a x16 length connector, with eight PCIe lanes connected. A x16 PCIe card runs at the bandwidth of the slot it is plugged into.
Slots one and three use open-ended PCIe connectors, so a PCIe x16 card can be inserted. Graphics cards greater than 75 watts require the use of an auxiliary power cable adapter.

**Card configuration restrictions for power supplies**

⚠️ **CAUTION:** To prevent damage, the overall power consumption of the workstation (including I/O cards, CPU, and memory) must not exceed the maximum rating of the workstation power supply. For power supply information, see [Power supply specifications on page 10](#).

The maximum graphics configurations are:

- **475W power supply**
  - A graphics card up to 150W in the primary graphics slot
  - A second graphics card in the second PCIe2 x16 slot (slot 4), provided the combined power consumption of both cards does not exceed 150W

- **600W power supply**
  - A graphics card up to 250W in the primary graphics slot
  - A second graphics card in the second PCIe2 x16 slot (slot 4), provided the combined power consumption of both cards does not exceed 250W

If you use a graphics card with greater than 75 watts of power, leave the adjacent slot empty. The maximum graphics power depends on CPU and memory selections. Follow any additional workstation configuration restrictions.
Choosing an expansion card slot

Whenever possible, use the following tips to help you select the proper slot for an expansion card:

- Insert the primary graphics card in a PCIe x16 slot intended for graphics.
- Insert a second graphics card in a second PCIe x16 slot intended for a secondary graphics card.
- Install full-length cards in slots that support full-length cards.
- For optimal cooling and acoustics do not insert a card next to a graphics card to avoid blocking the graphics card heatsink and fan. This is especially important for a card that requires an auxiliary power cable. For best results, choose a lower profile card to place next to the heatsink and fan.
- Install a card in a slot that most closely matches its interface technology:
  - Install a PCIe Gen2 x8 card in a PCIe Gen2 x8 slot.
  - Install a PCIe Gen1 x8 card in a PCIe Gen1 x8 slot.
  - Install a PCIe Gen1 x4 card in a PCIe Gen1 x4 slot.
  - Install a PCIe Gen1 x1 card in a PCIe Gen1 x1 slot.
  - Install a PCI card in a PCI slot.
  - Whenever possible, install a PCIe x1 card in a x1 slot.
- Leave as much space as possible between cards.
- For best operational efficiency, select a slot that:
  - Electrically matches the number of PCIe card lanes (e.g., x4 in a x4 slot).
  - Has more lanes electrically.
  - Has fewer lanes, but is closer to your needs. For example, place a x16 card in a x8 slot, and a x8 card in a a x4 slot.
- A x1 connector supports a x1 card only. Although, a x1 card can be inserted into any slot, this may waste the potential for future card placement.
- Install cards that require internal cable connections so that the cables are organized and have the least amount of strain on them. Some cables may be routed under, rather than over the other expansion cards.
- To prevent electromagnetic interference, avoid installing a card with external cable connections next to a graphics card.
Expansion card

PCIe I/O slots can support other PCIe cards with less bus bandwidth than what is physically defined for the slot.

Expansion card slot description

**NOTE:** The x1, x4, x8, and x16 designators describe the mechanical length of the slot. The number in parentheses shows how many electrical PCIe lanes are routed to the expansion slot. For example, x16(8) means that the expansion slot is mechanically a x16 length connector, with eight PCIe lanes connected. A x16 PCIe card runs at the bandwidth of the slot it is plugged into.

Use the following table to determine PCIe card compatibility.

<table>
<thead>
<tr>
<th>Slot</th>
<th>Mechanical compatibility</th>
<th>Electrical compatibility</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>x8 connector, open-ended*</td>
<td>PCIe2 (x1, x4)</td>
</tr>
<tr>
<td>2</td>
<td>x16 connector</td>
<td>PCIe2 (x1, x4, x8, x16)</td>
</tr>
<tr>
<td>3</td>
<td>x8 connector, open-ended*</td>
<td>PCIe (x1, x4)</td>
</tr>
<tr>
<td>4</td>
<td>x16 connector</td>
<td>PCIe2 (x1, x4, x8, x16)</td>
</tr>
</tbody>
</table>

* This slot is open-ended so a PCIe x16 card can be inserted.

- Slots one, two, and four are PCIe GEN2 slots.
- Graphics cards greater than 75 watts require the use of an auxiliary power cable adapter.

Removing an expansion card

To remove an expansion card:

1. Power down the workstation (see Predisassembly procedures on page 75).
2. Disconnect power from the workstation (see Predisassembly procedures on page 75).
3. Remove the side access panel (see Removing the side access panel on page 78).
4. Remove the expansion card support, if installed. Some workstation models use a bar support; remove the two screws (1) and lift up on the support (2).

**Figure 5-49** Removing expansion card support

Other workstation models use a hold down clamp; grasp the top of the clamp (1), squeeze the release handles until the bottom of the clamp releases from the clamp rail (2) (it should click when it releases), and swing the clamp out from the back panel (3).

**Figure 5-50** Removing expansion card clamp

5. Remove all cables connected to the expansion card.
6. Push down on the expansion card retention clamp levers on the inside of the chassis to open the retention clamp (1) as shown below.

**Figure 5-51** Removing the expansion card

Release the expansion card slot latch (2), and then carefully lift the card from the chassis (3).

7. Install an expansion slot cover and close the expansion card retention clamp.

If the expansion card retention clamp does not close, ensure that all cards are properly seated, and then try again.
Installing an expansion card

Visit http://www.hp.com/go/quickspecs to learn which graphics cards are supported in the workstation, how much memory each graphics card includes, and graphics card power requirements.

To install an expansion card:

1. Power down the workstation (see Predisassembly procedures on page 75).
2. Disconnect power from the workstation (see Predisassembly procedures on page 75).
3. Remove the side access panel (see Removing the side access panel on page 78).
4. Remove the expansion card support (if installed) by removing the two screws and lifting up on the support (see Removing an expansion card on page 124).
5. Push the expansion card retention clamp levers down on the outside of the chassis to release the retention clamp (1) as shown in the figure below.

   **Figure 5-52** Removing the slot cover

6. Remove the expansion card slot cover by pulling it up, out of the chassis (2).
   
   **TIP:** Grasp the slot cover between two fingers—one from the inside of the chassis, and one from the outside.

7. Angle the card into the expansion card guide.
8. Align the PCIe card keyway with the slot key. For full—length expansion cards, also align the card with the front fan holder/card guide (if installed).
9. Firmly seat the card in the slot (3).
10. Close the expansion card retention clamp by rotating it downward (4).
    
    If the PCI retention clamp does not close, ensure that all cards are properly seated, and then try again.
    
    If required by the card, connect the auxiliary power cable to the card (not illustrated).
Battery

This section describes how to remove and install the battery.

The battery that comes with the workstation provides power to the real-time clock and has a minimum lifetime of about three years.

⚠️ **WARNING!** This workstation includes a lithium battery. There is a risk of fire and chemical burn if the battery is handled improperly. Do not disassemble, crush, puncture, short external contacts, dispose in water or fire, or expose it to temperatures higher than 60°C (140°F).

⚠️ **CAUTION:** Before removing the battery, back up the CMOS settings in case they are lost when the battery is removed. To back up the CMOS settings, select the **Save to Diskette** option in the Computer Setup (F10) Utility.

ℹ️ **NOTE:** Do not dispose of batteries, battery packs, and accumulators with general household waste.

Removing the battery

To remove the battery:

1. Power down the workstation (see **Predisassembly procedures on page 75**).
2. Disconnect power from the workstation (see **Predisassembly procedures on page 75**).
3. Remove the side access panel (see **Removing the side access panel on page 78**).
4. On the system board, press the release tab of the battery holder.
5. Pull the tab (1) on the battery holder, and then lift it straight up (2), as shown in the following figure.

**Figure 5-53** Removing the battery

---

**Installing the battery**

To install the battery:

1. Confirm the polarity (positive or negative) of the battery to position it correctly in the battery holder.
2. Place the battery edge under the plastic housing tab and press gently until it snaps into place.

**Hard disk drive**

This section provides information to successfully remove and install a hard disk drive.

**Removing the hard disk drive**

To remove a hard disk drive:

1. Power down the workstation (see *Predisassembly procedures on page 75*).
2. Disconnect power from the workstation (see *Predisassembly procedures on page 75*).
3. Remove the side access panel (see *Removing the side access panel on page 78*).
4. Disconnect the power and data cables from the drive.
5. Lift the green hard disk drive release lever (1), then slide the hard disk drive (2) from the chassis as shown.

![Figure 5-54 Removing the drive from the chassis](image)

6. Replace the side access cover when finished.

**Installing the hard disk drive**

**Installation guidelines**

The workstation typically ships with an HDD, but additional drives can be added to expand data storage:

- Refer to the service label on the side access panel of your workstation to determine the location of the SAS and SATA ports.
- Additional HDDs must be added in a specific sequence, depending on the type of workstation.
- Once installed, the HDDs are assigned drive letters, with C:\ being the typical boot disk. Drive letters are assigned using the Computer Setup (F10) Utility.
- With additional HDDs installed, the workstation boot sequence can be modified so that the workstation boots from one of the additional drives. Boot sequence is specified using the Computer Setup (F10) Utility.
- With additional HDDs installed, you have hard disk space for additional programs, data files, and backup.

The HDD bays are not labeled on the chassis.
The cables plug into the system board connectors in the following manner:

- SATA HDD cables are plugged into SATA ports, starting at SATA port zero.
- SAS HDD cables do not plug into system board connectors, but into a separate SAS controller card.

**Installation**

To install an HDD:

1. Select a drive bay in which to install the hard disk drive.
2. Locate the four isolation grommet screws on the chassis.

   **Figure 5-55** Locating the grommet screws

3. Install the four isolation grommet screws as shown in the following figure.
   
   **Figure 5-56** Installing the grommet screws
4. If installing a SAS drive, attach a SAS-to-SATA cable adapter to the connector on the SAS hard drive as shown in the following figure.

**NOTE:** SAS Drives require a separate SAS Controller plug-in card.

*Figure 5-57* Attaching the cable adapter
5. Push the hard disk drive into the selected bay until it snaps into place (1), as shown in the following figure.

**Figure 5-58** Installing the HDD drive

6. Attach a power cable (2) to the drive, and attach a data cable (3) from the SATA port or SAS controller to the hard disk drive.

△ **CAUTION:** To avoid crushing or pinching the data cable when you replace the access panel, use a data cable with a right-angle connector when you install a HDD in bay 1 or bay 2.

♫ **NOTE:** For SATA and SAS HDDs, connect data cables to lower-numbered drive connectors first on the system board (for SATA HDDs) or SAS controller card (for SAS HDDs). To identify hard disk drive connectors, refer to the workstation service label on the side access panel.

7. Replace all components that were removed in preparation for component installation.
Liquid cooling solution

This section describes how to remove and install a processor liquid cooling solution (LCS).

**NOTE:** The LCS is not eligible for Customer Self-Repair. Call HP Support for further instructions before attempting to remove or repair this system.

Removing the liquid cooling solution

1. Disconnect power from the system ([Predisassembly procedures on page 75](#)).
2. Remove the side access panel (see [Removing the side access panel on page 78](#)).
3. If your system has an airflow guide, remove it (see [Removing the airflow guide on page 110](#)).
4. Remove the LCS VR fan.
   a. Disconnect the LCS VR fan cable from the system board as shown in the following figure.

   ![Figure 5-59 Disconnecting the LCS VR fan cable](#)
b. Remove the two LCS VR fan assembly bracket screws and remove the assembly from the chassis, as shown in the following figure.

**Figure 5-60** Removing the LCS VR fan assembly
5. Disconnect the rear system fan cable from the system board as shown in the following figure.

**Figure 5-61** Disconnecting the rear system fan cable
6. Remove the screws and the LCS radiator assembly from the chassis as shown in the following figure.

Figure 5-62 Removing the LCS radiator assembly
7. Disconnect the LCS pump cable from the system board as shown in the following figure.

**Figure 5-63** Disconnecting the LCS pump cable
8. Remove the cold plate assembly.
   a. Slowly and evenly loosen one pair of diagonally opposite screws (1) on the LCS cold plate assembly until the screw shanks disengage from the system board, and then loosen the remaining pair (2), as shown below.

   **Figure 5-64** Loosening the LCS cold plate screws in sequence

   b. Lift the cold plate assembly from the CPU, and then remove the entire LCS unit from the system.
c. With the LCS unit removed, gently twist the cold plate assembly (1), and remove it from the retention ring (2), as shown in the following figure.

**Figure 5-65** Removing the cold plate assembly from the retention ring

d. Use alcohol and a soft cloth to clean the thermal interface residue from the CPU and the cold plate assembly, allowing the alcohol to dry completely afterward.
9. Remove the rear system fan from the LCS radiator fan holder by lifting the fan holder tabs (1), and then rotating the fan out of the holder (2), as shown in the following figure. (Release the tabs when the fan is removed.)

**Figure 5-66** Removing the rear system fan from the radiator fan holder

10. Reinstall the rear system fan (see Installing the rear system fan assembly on page 100).

11. Reinstall the CPU heatsink (see Installing the CPU heatsink on page 155).

12. Reinstall all removed components and reconnect any cables that have been disconnected.
Installing a liquid cooling solution

1. Disconnect power from the system ([Predisassembly procedures on page 75]),
2. Remove the side access panel (see Removing the side access panel on page 78).
3. If your system has an airflow guide, remove it (see Removing the airflow guide on page 110).
4. Remove the rear system fan assembly from the chassis (see Removing the rear system fan assembly on page 100).
5. Install the rear system fan in the LCS radiator fan holder by placing the edge of the fan in the holder with the power cable routed through the notch in the fan holder (1), and then rotating the fan into the holder until it snaps into place (2), as shown in the following figure.

△ CAUTION: To avoid damaging the wiring, make sure the fan cable passes through the slot in the lower-right corner of the LCS radiator fan holder.

Figure 5-67 Installing the system fan in the LCS radiator fan holder

6. Remove the CPU heatsink (see Removing the CPU heatsink on page 154).
7. Set the cold plate retention ring on the CPU heatsink mounting base, and then slightly tighten a single retention screw (see Installing the CPU heatsink on page 155) as shown in the following figure.

⚠️ **CAUTION:** Do not scratch the system board while maneuvering the cold plate assembly or you might damage components.

💡 **TIP:** Tighten the retention ring screw only one or two turns to keep its corner in place while allowing the rest of the ring to move.

**Figure 5-68** The retention screw
8. Install the LCS cold plate.
   a. Remove the plastic cover from the bottom of the cold plate as shown in the following figure.
   
   **Figure 5-69** Removing the protective cap

   b. Perform one of the following tasks:

   - If you are reusing the original LCS unit, apply thermal compound to the center of the CPU top surface (see *Installing the CPU heatsink on page 155*).
   - If you are using a new LCS unit, do not apply thermal compound to the CPU because the new LCS unit already has thermal compound applied to the surface of the cold plate. Instead, remove the thermal compound protective liner from the bottom of the new LCS unit.
c. Lift the edge of the LCS cold plate retention ring, align the tabs on the retention ring with the slots in the cold plate, and then set the cold plate into the retention ring on the CPU as shown in the following figure.

**TIP:** Ensure that the HP logo is positioned horizontally as shown in the figure.

![Figure 5-70 Positioning the LCS cold plate](image)

d. Gently twist the cold plate body until it locks into place in the retention ring as shown in the previous figure.
e. Carefully tighten the four cold plate retention screws a little at a time in diagonal pairs—first set (1), and then set (2)—to 6 in.-lbs. of torque.

⚠ **CAUTION:** Do not overtighten the heatsink screws. If you overtighten them, you might strip the threads in the system board tray.

Do not fully tighten one screw and then move on to the next. Instead, tighten each diagonal set of screws a little at a time, ensuring that the cold plate remains level.

**Figure 5-71** Tightening the cold plate screws
9. Connect the LCS pump cable to the system board as shown in the following figure.

**Figure 5-72** Connecting the LCS pump cable
10. Install the LCS radiator with attached rear system fan in the chassis, as shown in the following figure.

   a. Align the LCS radiator assembly in the chassis as shown in the following figure.

   😷 **TIP:** Align the radiator assembly with the rear system fan screw holes in the chassis.

   Figure 5-73 Aligning the LCS radiator assembly
b. Fasten the LCS radiator assembly to the chassis as shown in the following figure.

Figure 5-74  Fastening the LCS radiator assembly
11. Connect the rear system fan cable to the system board as shown in the following figure.

*Figure 5-75* Connecting the rear system fan cable
12. Install the LCS VR fan in the chassis.

a. Place the LCS VR fan in the chassis so that the fan bracket holes align with the holes in the chassis as shown in the following figure.

Figure 5-76 Aligning the LCS VR fan bracket
b. Fasten the LCS VR fan assembly to the chassis as shown in the following figure.

**Figure 5-77** Fastening the LCS VR fan
c. Connect the LCS VR fan cable to the system board as shown in the following figure.

**Figure 5-78** Connecting the LCS VR fan cable

13. Reinstall all removed components and reconnect any cables that have been disconnected.
CPU heatsink

This section describes how to remove and install a CPU heatsink.

Removing the CPU heatsink

To remove a heatsink:

1. Power down the workstation (see Predisassembly procedures on page 75).
2. Disconnect power from the workstation (see Predisassembly procedures on page 75).
3. Remove the side access panel (see Removing the side access panel on page 78).
4. If your system has an airflow guide, remove it (see Removing the airflow guide on page 110).
5. Slowly and evenly loosen one pair of diagonally opposite screws (1) from the CPU until the screw shanks disengage from the system board, and then loosen the remaining pair (2), as shown below.

⚠️ CAUTION: Do not fully loosen one screw, and then move on to the next. Instead, loosen all screws a little at a time, ensuring that the CPU heatsink remains level.

Figure 5-79 Loosening heatsink screws in sequence
6. Disconnect the CPU heatsink fan cable from the system board (1), as shown in the following figure.

**Figure 5-80** Disconnecting the heatsink fan cable

7. Before lifting the heatsink, gently twist the heatsink to break the thermal compound between the CPU and the heatsink.

8. Lift the CPU heatsink out of the chassis (2).

9. Use alcohol and a soft cloth to clean the thermal interface residue from the CPU and the heatsink, allowing the alcohol on the CPU and CPU heatsink to dry completely.

**Installing the CPU heatsink**

To install a heatsink:

1. Disconnect power from the system (Predisassembly procedures on page 75).

2. Remove the side access panel (see Removing the side access panel on page 78).

3. If your system has an airflow guide, remove it (see Removing the airflow guide on page 110).

4. Remove the CPU heatsink (see Removing the CPU heatsink on page 154).

5. Perform one of the following tasks:
   - If you are reusing the original heatsink, apply thermal compound to the center of the CPU top surface.
   - If you are using a new CPU heatsink, do not apply thermal compound to the CPU because the new heatsink already has thermal compound applied to the heatsink surface. Instead, remove the thermal compound protective liner from the bottom of the new heatsink.
6. Align the four mounting screws with the mounting holes in the system board and carefully place the heatsink on the CPU. Ensure that the heatsink is placed properly with the fan positioned toward the front, facing the memory DIMMs.

⚠️ **CAUTION:** Do not overtighten the heatsink screws. If you overtighten them, you might strip the threads in the system board tray. Do not fully tighten one screw and then move on to the next. Instead, tighten all screws a little at a time, ensuring that the CPU heatsink remains level.

7. Tighten all screws partially so the CPU heatsink remains level.

8. Tighten each set of diagonally opposed screws a little at a time to 6 in.-lbs. of torque.

9. Connect the CPU heatsink fan connector to the system board.

*Figure 5-81* Connecting the heatsink fan cable
This section describes how to remove and install a CPU.

**Removing a CPU**

To remove a CPU:

1. Power down the workstation (see *Predisassembly procedures on page 75*).
2. Disconnect power from the workstation (see *Predisassembly procedures on page 75*).
3. Remove the side access panel (see *Removing the side access panel on page 78*).
4. If your system has an airflow guide, remove it (see *Removing the airflow guide on page 110*).
5. Remove the CPU heatsink (see *Removing the CPU heatsink on page 154*).
6. Raise the CPU socket lever (1), and then open the cover (2), as shown in the following figure.

**Figure 5-82** Removing a CPU

⚠️ **CAUTION:** Do not touch the CPU socket contacts or the gold pads underneath the CPU. Use extreme care and handle the CPU only by the edges.

7. Pull the CPU straight out of the socket (3), and store the CPU in a static free container in a safe place where it cannot be damaged.
Installing a CPU

**NOTE:** HP recommends that you do not swap processors (CPUs) from one system board to another.

To install a CPU:

1. Power down the workstation (see [Predisassembly procedures on page 75](#)).
2. Disconnect power from the workstation (see [Predisassembly procedures on page 75](#)).
3. Remove the side access panel (see [Removing the side access panel on page 78](#)).
4. If your system has an airflow guide, remove it (see [Removing the airflow guide on page 110](#)).
5. Remove the CPU heatsink (see [Removing the CPU heatsink on page 154](#)).
6. Remove the CPU (see [Removing a CPU on page 157](#)).
7. Using extreme care, fully raise the CPU socket lever and cover.

⚠️ **CAUTION:** The CPU socket contacts are delicate. To avoid bending the contacts, use extreme care when installing the CPU in the socket.

8. Align the notches in the CPU base with the tabs on the socket as shown in the figure below.
   Seat the CPU into the socket. Ensure that the underside of the CPU is level with the top of the CPU socket.

   **Figure 5-83** Seating the CPU

9. Close the CPU cover plate by lightly pressing down on the CPU cover plate while closing the socket lever.

10. Replace the CPU heatsink (see [Installing the CPU heatsink on page 155](#)).
System board

This section describes replacing the system board.

Removing the system board

To remove the system board:

1. Power down the workstation (see Predisassembly procedures on page 75).
2. Disconnect power from the workstation (see Predisassembly procedures on page 75).
3. Remove the side access panel (see Removing the side access panel on page 78).
4. If your system has an airflow guide, remove it (see Removing the airflow guide on page 110).
5. Remove expansion boards and graphics cards (see Removing an expansion card on page 124).
6. (Optional) Remove the CPU heatsink (see Removing the CPU heatsink on page 154).
7. Disconnect all cabling from the system board.

**Tip:** Make a note of the cable connections before disconnecting them from the system board. For more information, refer to Power connections on page 99.

8. Gently squeeze the release mechanism (1), as shown in the following figure.

**Figure 5-84** Removing the system board

9. Lift the system board slightly to clear the release mechanism, pull the board away from the rear of the chassis, and then lift the system board upward (2) out of the chassis.
Installing the system board

To install the system board:

1. Insert the system board with the rear chassis side of the board tilted slightly downward.
2. Push back on the board while maintaining downward pressure on the board to clear the release mechanism. The latch should click into place.
3. Reinstall all removed components and cables. (Refer to Power connections on page 99 to identify power cables.)
Converting to desktop configuration

This workstation can be operated in the mini-tower or the desktop configuration. Follow these steps to convert to desktop configuration operation:

1. With power removed from the workstation, remove the side access panel (see Removing the side access panel on page 78).
2. Remove the front bezel from the workstation (see Removing the front bezel on page 83).
3. Press gently on the edges of the optical drive bay filler panel, and remove it from the front bezel as shown in the following figure.

   **Figure 5-85** Removing the ODD bay filler panel

4. Rotate the filler panel 90 degrees to a horizontal position.
5. Align the slots in the filler panel frame with the tabs in the front bezel. Press the optical drive filler panel back into the front bezel until it snaps into place as shown in the following figure.

   **Figure 5-86** Installing the ODD bay filler panel
6. On the back of the front bezel, squeeze the HP logo mounting tabs (1), and then press the logo outward (2), as shown in the following figure.

**Figure 5-87** Rotating the HP logo

Rotate the HP logo 90 degrees counterclockwise, and then release the logo and press it back into place in the front bezel.

7. Remove the EMI filler panels and remove the optical disk drive from the chassis (see [Removing an optical disk drive from the optical bay (mini-tower configuration)](on page 89).
8. Rotate the EMI filler panels and the optical drive 90 degrees as shown in the figure below, and then reinstall them (see Installing an optical drive (desktop configuration) on page 95).

**Figure 5-88** Reinstalling the optical drive

9. Replace the front bezel (see Installing the front bezel on page 83) and the side access panel (see Installing the side access panel on page 78) when finished.

**Product recycling**

HP encourages customers to recycle used electronic hardware, HP original print cartridges, and rechargeable batteries.

For information about recycling HP components or products, see [http://www.hp.com/go/recycle](http://www.hp.com/go/recycle).
This chapter describes the tools available for diagnosing and troubleshooting system issues, and includes these topics:

<table>
<thead>
<tr>
<th>Topics</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Calling technical support</td>
<td>165</td>
</tr>
<tr>
<td>Locating ID labels</td>
<td>165</td>
</tr>
<tr>
<td>Locating warranty information</td>
<td>167</td>
</tr>
<tr>
<td>Diagnosis guidelines</td>
<td>168</td>
</tr>
<tr>
<td>Troubleshooting checklist</td>
<td>170</td>
</tr>
<tr>
<td>HP troubleshooting resources and tools</td>
<td>170</td>
</tr>
<tr>
<td>Troubleshooting scenarios and solutions</td>
<td>173</td>
</tr>
<tr>
<td>Self-troubleshooting with HP Vision Diagnostics</td>
<td>184</td>
</tr>
<tr>
<td>Diagnostic codes and errors</td>
<td>195</td>
</tr>
</tbody>
</table>
Calling technical support

At times you might encounter an issue that requires technical support. When you call technical support:

● Have the workstation readily accessible.
● Write down the workstation serial numbers, product numbers, model names, and model numbers and have them in front of you.
● Note any applicable error messages.
● Note any add-on options.
● Note the operating system.
● Note any third-party hardware or software.
● Note the details of any blinking LEDs on the front of the workstation.
● Note the applications you were using when you encountered the problem.
● Note the power supply BIST status, if applicable.

**NOTE:** When calling in for service or support, you might be asked for the Product Number (example: PS988AV) of the workstation. If the workstation has a Product Number, it is generally located next to the 10- or 12-digit Serial Number of the workstation.

**NOTE:** On most models, the serial number and product number labels can be found on the top panel or side of the workstation and at the rear of the workstation.

For a listing of all worldwide technical support phone numbers, visit [http://www.hp.com/support](http://www.hp.com/support), select your region, and click **Contact HP** in the upper-left corner.

Locating ID labels

To assist in troubleshooting, product, serial, and authentication numbers are available on each workstation.
Each HP Workstation has two unique serial number labels (1) and a Certificate of Authentication (COA) label (2) as shown in the figure below.

**Figure 6-1** Workstation label locations

In general, the serial number labels can be found on the top panel or on the side of the workstation and at the rear of the workstation (your workstation may look different). Keep this number available when contacting customer service for assistance.

A product number is generally located next to the serial number.

The COA is used for Windows-preinstalled systems only and is generally located on the top panel or side of the workstation near the serial number label. On some workstations, it is located on the bottom of the workstation.
Locating warranty information

To locate base warranty information, see: http://www.hp.com/support/warranty-lookuptool

To locate an existing Care Pack, see:

To extend a standard product warranty, see http://h20219.www2.hp.com/services/us/en/warranty/carepack-overview.html?jumpid=hpr_R1002 USEN HP Care Pack Services offer upgraded service levels to extend and expand a standard product warranty. For additional warranty information:

1. Go to: http://www.hp.com/#Support
2. Under Additional resources, click on Warranty information.
3. Under Select your product, click on Workstations.
4. Under Personal Workstations, click on HP Z400 Workstation. This displays information about warranties, upgrades, extensions.
Diagnosis guidelines

If you encounter a problem with the workstation, monitor, or software, the following sections provide a list of general suggestions that help you isolate and focus on the problem before taking further action.

Diagnosis at startup

- Verify that the workstation and monitor are plugged into a working electrical outlet.
- Remove all diskettes, CDs, or USB drive keys from your system before turning it on.
- Verify that the workstation is turned on and the green power light is on.
- If you have installed an operating system other than the factory-installed operating system, check to be sure that it is supported on your system by visiting http://www.hp.com/go/quickspecs.
- Verify that the monitor is turned on and the green monitor light is on. Note that not all monitors are equipped with LED lights to indicate their functionality.
- Turn up the brightness and contrast controls of the monitor if the monitor is dim.
- If the workstation has multiple video sources and only a single monitor, the monitor must be connected to the primary display adapter. During startup, the other monitor connectors are disabled; if the monitor is connected to one of these ports, it will not function after Power-on Self Test (POST). You can select the default VGA source in Computer Setup (F10).
Diagnosis during operation

- Look for blinking LEDs on the front of the workstation. The blinking lights are error codes that will help you diagnose the problem. Refer to the Diagnostic LED and audible (beep) codes on page 195 section of this document for information on interpreting diagnostic lights and audible codes.

- Press and hold any key. If the system beeps, then your keyboard is operating correctly.

- Check all cables for loose or incorrect connections.

- Wake the workstation by pressing any key on the keyboard or the power button. If the system remains in suspend mode, shut down the system by pressing and holding the power button for at least four seconds, then press the power button again to restart the system. If the system does not shut down, unplug the power cord, wait a few seconds, then plug it in again. If it does not restart, press the power button to start the workstation.

- Reconfigure the workstation after installing a non–plug and play expansion board or other option.

- Be sure that all required device drivers have been installed. For example, if you have connected a printer, you must install a printer driver.

- If you are working on a network, plug another workstation with a different cable into the network connection. There might be a problem with the network plug or cable.

- If you recently added new hardware, remove the hardware and verify if the workstation functions properly.

- If you recently installed new software, uninstall the software and verify if the workstation functions properly.

- If the screen is blank, plug the monitor into a different video port on the workstation if one is available. Alternatively, replace the monitor with a monitor that you know is working properly.

- Upgrade the BIOS. A new release of the BIOS might have been released that supports new features or fixes your problem.

- For more detailed information, see the troubleshooting chapter in the Maintenance and Service Guide at http://www.hp.com/support/workstation_manuals.
Troubleshooting checklist

Before running diagnostic utilities, use the following checklist to find possible solutions for workstation or software problems.

- Is the workstation and monitor connected to a working electrical outlet?
- Is the workstation powered on?
- Is the green power light illuminated?
- Is the monitor on?
- Is the green monitor light illuminated?
- If the monitor is dim, adjust the monitor brightness and contrast controls.
- Press and hold any key. If the system beeps, the keyboard is operating correctly.
- Check cables for loose or improper connections.
- After installing a non-plug and play (PnP) expansion board or other option (such as a diskette drive), reconfigure the workstation.
- Are all necessary device drivers installed?
- Have all printer drivers been installed for each application?
- Have you removed diskettes, optical disks, and USB drive keys from the drives before powering on the workstation?
- Are you running the latest version of BIOS, drivers, and software?

HP troubleshooting resources and tools

This section provides information on the HP Help and Support Center, E-support, and Helpful Hints for troubleshooting.

HP Support Assistant

The HP Support Assistant is a customized HP user interface that enhances the Windows Vista and Win 7 Help and Support Center functions. This customized utility allows you to access specific information about an HP Workstation such as configuration information by clicking Start > Help and Support. The interface also provides customized help and support links to the HP Web site related to the HP Workstation.

NOTE: The customized HP Support Assistant is not available on Windows XP Professional x32 or x64 Editions, or on Linux.

HP Help and Support Center

The HP Help and Support Center is a customized HP user interface that enhances the Windows XP Help and Support Center Help feature. This customized utility allows you to access specific information about your HP Workstation such as configuration information by clicking Start > Help and Support. The interface also provides customized help and support links to the HP Web site related to your HP Workstation.
NOTE: The customized HP Help and Support Center is not available on Windows XP Professional x64 Edition or on Linux.

NOTE: Currently, HP Help and Support Center does not work on Windows Vista.

E-support

Online access and support resources include Web-based troubleshooting tools, technical knowledge databases, driver and patch downloads, online communities, and product change notification services.

The following Web sites are also available to you:

- [http://www.hp.com/support/workstation_manuals](http://www.hp.com/support/workstation_manuals)—Provides the latest online documentation.
- [http://www.hp.com/support](http://www.hp.com/support)—Provides a listing of the worldwide technical support phone numbers. Access the telephone numbers by visiting the Web site, then select your region, and click Contact HP in the upper-left corner.
- [http://www.hp.com/support/workstation_swdrivers](http://www.hp.com/support/workstation_swdrivers)—Provides access to software and drivers for workstations.

Troubleshooting a problem

To help you troubleshoot problems with your system, HP provides the Business Support Center (BSC). The BSC is a portal to an extensive selection of online tools. To access BSC and troubleshoot a problem with the workstation, complete the following:

2. Under the Business Support Center menu on the left, select Troubleshoot a problem.
3. Under Select your product (center window), select Workstations (under personal computing).
4. Under Select your product, continue with selections as appropriate to the workstation series and model, and to the problem you are troubleshooting.

Instant Support and Active Chat

HP Instant Support is a set of Web-based support tools that automate and speed up the resolution of desktop computing, tape storage, and printing problems.

Active Chat enables you to electronically submit a support ticket to HP over the Web. When you submit a support ticket, Active Chat collects information about the computer and pass it to an online support specialist. The collection of information might take up to 30 seconds depending on the computer configuration. When you submit a support ticket, you receive a confirmation message containing your case ID, the support hours for your location, and the estimated time of response.

For more information about HP Instant Support and Active Chat and how to use them, visit [http://instantsupport.hp.com/](http://instantsupport.hp.com/)

NOTE: This feature is not available on Windows XP Professional x64 Edition or on Linux.
Customer Advisories, Customer and Security Bulletins, and Customer Notices

To find advisories, bulletins, and notices:

2. Select the desired product.
3. Under **Resources for <your selected product>**, select **See more....**
4. Under **Self-Help resources:** in the center of the window, choose the desired action and appropriate information in the scroll list to view the index.

Product Change Notifications

Product Change Notifications (PCNs) are proactive notifications for product changes occurring within a 30-60 day window of the effective date of the change in the manufacturing process. PCNs give customers advanced notice of changes to their product, such as an updated BIOS version that they may need to qualify prior to the change taking place. The latest PCNs are located at: [http://www.hp.com/go/workstationsupport](http://www.hp.com/go/workstationsupport).

Helpful hints

If you encounter a problem with the workstation, monitor, or software, the following provides a list of general suggestions that help you isolate and focus on the problem before taking further action.

At startup

- Verify that the workstation and monitor are plugged into a working electrical outlet.
- Remove all diskettes, optical disks, and USB drive keys from the drives before powering on the workstation.
- Verify that the workstation is turned on and the green power light is on.
- If you have installed an operating system other than the factory-installed operating system, check to be sure that it is supported on your system by visiting [http://www.hp.com/go/quickspecs](http://www.hp.com/go/quickspecs).
- Verify that the monitor is turned on and the green monitor light is on.
- Turn up the brightness and contrast controls of the monitor if the monitor is dim.
- If the workstation has multiple video sources and only a single monitor, the monitor must be connected to the source selected as the primary VGA adapter. During startup, the other monitor connectors are disabled; if the monitor is connected to one of these ports, it will not function after Power-on Self Test (POST). You can select the default VGA source in Computer Setup (F10).

During operation

- Look for blinking LEDs on the front of the workstation. The blinking lights are error codes that will help you diagnose the problem. Refer to the *Diagnostic lights and audible (beep) codes* section of this document for information on interpreting diagnostic lights and audible codes.
- Press and hold any key. If the system beeps, then your keyboard is operating correctly.
- Check all cables for loose or incorrect connections.
Wake the workstation by pressing any key on the keyboard or the power button. If the system remains in suspend mode, shut down the system by pressing and holding the power button for at least four seconds, then press the power button again to restart the system. If the system does not shut down, unplug the power cord, wait a few seconds, then plug it in again. If it does not restart, press the power button to start the workstation.

Reconfigure the workstation after installing a non–plug and play expansion board or other option. Refer to the Hardware installation problems section of this document for instructions.

Be sure that all required device drivers have been installed. For example, if you have connected a printer, you must install a printer driver.

If you are working on a network, plug another workstation with a different cable into the network connection. There might be a problem with the network plug or cable.

If you recently added new hardware, remove the hardware and verify if the workstation functions properly.

If you recently installed new software, uninstall the software and verify if the workstation functions properly.

If the screen is blank, plug the monitor into a different video port on the workstation if one is available. Alternatively, replace the monitor with a monitor that you know is working properly.

Upgrade the BIOS. A new release of the BIOS might have been released that supports new features or fixes your problem.

For more detailed information, see the troubleshooting chapter in the Maintenance and Troubleshooting Guide at http://www.hp.com/support/workstation_manuals.

Customizing the monitor display

You can manually select or change the monitor model, refresh rates, screen resolution, color settings, font sizes, and power management settings. To do so, right-click the desktop, then click Properties to change display settings. For more information, see the online documentation provided with the graphics controller utility or the documentation that came with your monitor.

Troubleshooting scenarios and solutions

This section presents an extensive overview of various troubleshooting scenarios and possible solutions for a Windows-based workstation.

**NOTE:** For Linux troubleshooting information, refer to the HP Workstations for Linux User Manual at http://www.hp.com/support/linux_user_manual.

Solving minor problems

<table>
<thead>
<tr>
<th>Table 6-1 Minor problems</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Problem</strong></td>
</tr>
</tbody>
</table>
| Workstation appears frozen and does not shut down when the power button is pressed. | Software control of the power switch is not functional. | 1. Press and hold the power button for at least four seconds until the workstation shuts down.  
2. Disconnect the electrical plug from the outlet.  
3. Restart the workstation. |
<table>
<thead>
<tr>
<th>Problem</th>
<th>Cause</th>
<th>Possible Solution</th>
</tr>
</thead>
</table>
| Workstation seems to be frozen. | Program in use has stopped responding to commands. | 1. If possible, use the Windows Task Manager to isolate and terminate the offending process.  
2. Attempt the normal Windows shutdown procedure.  
3. Restart the workstation using the power button. |
| Workstation date and time display is incorrect. | Real-time clock (RTC) battery might need replacement. | 1. Reset the date and time in the Control Panel.  
2. Replace the RTC battery. |
| Workstation appears to pause periodically. | Network driver is loaded and no network connection is established. | Establish a network connection, or use the Computer Setup (F10) Utility or the Microsoft Windows Device Manager to disable the network controller. |
| Cursor does not move using the arrow keys on the keypad. | The Num Lock key might be on. | Press Num Lock. The Num Lock key can be disabled or enabled in the Computer Setup (F10) Utility. |
| Poor performance is experienced. | Processor is hot. | 1. Verify that airflow to the workstation is not blocked.  
2. Verify that chassis fans are connected and working properly.  
Some fans operate only when needed.  
3. Verify that the processor heatsink is installed properly. |
| Workstation powered off automatically and the Power LED flashes red 2 times (once every second), followed by a 2-second pause, and then two simultaneous beeps sounded. | Processor thermal protection is activated.  
A fan might be blocked or not turning.  
OR  
The processor heatsink is not properly attached to the processor. | **CAUTION:** Internal components might be powered even when the workstation is off. To prevent damage, disconnect the workstation power cord before you remove a component.  
1. Verify that the workstation air vents are not blocked.  
2. Open the access panel and press the workstation power button.  
3. Verify that the system fan is running.  
4. Verify that the processor heatsink fan spins. If the fan is not spinning, verify that the heatsink fan cable is plugged into the system board connector and that the heatsink is properly seated.  
5. Replace the processor heatsink. |
| System does not power on, and the LEDs on the front of the workstation are not flashing. | System cannot power on. | Determine if the problem is caused by a faulty device or a problem with the power supply. Press and hold the power button for less than four seconds while observing the hard drive LED:  
- If the hard drive LED turns green, then perform the **Diagnose faulty device** procedure described below.  
- If the hard drive LED does not illuminate, then perform the **Diagnose power supply problem** procedure described below. |
Table 6-1  Minor problems (continued)

<table>
<thead>
<tr>
<th>Problem</th>
<th>Cause</th>
<th>Possible Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>CAUTION:</strong> Internal components might be powered even when the workstation is off. To prevent damage, disconnect the workstation power cord before you remove a component.</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Diagnose faulty device</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>To verify the presence of a faulty device, you must disconnect all devices one at a time, removing the graphics card last:</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1. Disconnect AC power to the computer.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2. Disconnect a device (graphics card last).</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3. Reconnect AC power</td>
<td></td>
<td></td>
</tr>
<tr>
<td>4. Power on the computer.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>◦ If the computer powers on successfully, follow the procedures in this guide to replace the device that you most recently disconnected.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>◦ If the computer cannot power on, then repeat this procedure to remove another device until you identify the faulty device.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>◦ If no faulty device is found, replace the system board.</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>CAUTION:</strong> Internal components might be powered even when the workstation is off. To prevent damage, disconnect the workstation power cord before you remove a component.</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Diagnose power supply problem</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1. Verify that the workstation is plugged into a working AC outlet.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2. Verify that the power button harness is connected to the inline front panel I/O device assembly connector.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3. Verify power supply functionality:</td>
<td></td>
<td></td>
</tr>
<tr>
<td>a. Disconnect the AC power.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>b. Remove the internal power supply cables from the system board. (You do not need to remove the power supply from the chassis.)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>c. Reconnect the AC power.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>d. Turn on the computer.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>◦ If the power supply fan spins and the BIST LED illuminates, the power supply is good. Replace the system board.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>◦ If the power supply fan does not spin or the LED does not illuminate, there may be a problem with the power supply. See Testing power supply on page 176 for more information.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Solving power supply problems**

This section presents power supply troubleshooting scenarios.
Testing power supply

Before replacing the power supply, use the Built-In Self-Test (BIST) feature to learn if the power supply still works.

To test the power supply:

1. Disconnect the AC power.
2. Remove the internal power supply cables from the system board. (You do not need to remove the power supply from the chassis.)
3. If necessary, disconnect the PCIe power cable from the graphics card.
4. Plug in AC power and verify the following:
   - If the green BIST LED on the rear of the workstation is illuminated and the fan is spinning, the power supply is functional.
   - If the green BIST LED is not illuminated or the fan is not spinning, replace the power supply.

See the Rear panel components section of this service guide to locate the BIST LED on this workstation.

Table 6-2 Power supply problems

<table>
<thead>
<tr>
<th>Problem</th>
<th>Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Power supply shuts down intermittently.</td>
<td>Power supply fault.</td>
<td>Replace the power supply.</td>
</tr>
<tr>
<td>Workstation powers off and the Power LED flashes red 2 times (once every second), followed by a 2-second pause.</td>
<td>Processor thermal protection is activated.</td>
<td>1. Ensure that the workstation air vents are not blocked.</td>
</tr>
<tr>
<td></td>
<td>A fan might be blocked or not turning.</td>
<td>2. Open the access panel and press the workstation power button.</td>
</tr>
<tr>
<td></td>
<td>OR</td>
<td>3. Verify that the system fan is running.</td>
</tr>
<tr>
<td></td>
<td>The processor heatsink fan assembly is not properly attached to the processor.</td>
<td>4. Verify that the processor heatsink fan spins. If the heatsink fan is not spinning, verify that the fan cable is plugged into the system board connector. Verify that the fan is properly seated.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>5. Replace the processor heatsink.</td>
</tr>
<tr>
<td>Power LED flashes red (once every 2 seconds).</td>
<td>Power failure (power supply is overloaded).</td>
<td>1. Determine whether a device is causing the problem by performing the following:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>a. Disconnect AC power.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>b. Remove all attached devices.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>c. If necessary, disconnect the PCIe power cable from the graphics card.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>d. Power on the workstation.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>If the system enters the POST, perform the following:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>a. Power off the workstation.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>b. Replace one device at a time and repeat this procedure until a failure occurs.</td>
</tr>
</tbody>
</table>
Table 6-2  Power supply problems (continued)

<table>
<thead>
<tr>
<th>Problem</th>
<th>Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>c.</td>
<td>Replace the device causing the failure</td>
<td></td>
</tr>
<tr>
<td>d.</td>
<td>Continue adding devices one at a time to verify that all devices are functioning.</td>
<td></td>
</tr>
</tbody>
</table>

2. Verify power supply functionality.

a. Disconnect AC power.

b. Remove the internal power supply cables from the system board. (You do not need to remove the power supply from the chassis.)

c. If necessary, disconnect the PCIe power cable from the graphics card.

d. Plug in AC power.

- If the power supply fan spins and the LED illuminates, the power supply is good. Replace the system board.
- If the power supply fan does not spin or the LED does not illuminate, replace the power supply.

---

Solving diskette problems

Table 6-3  Diskette problems

<table>
<thead>
<tr>
<th>Problem</th>
<th>Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Diskette drive light stays on.</td>
<td>Diskette is damaged.</td>
<td>1. Right-click <strong>Start</strong>, select <strong>Explore</strong>, and then select a drive.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2. Select <strong>File&gt;Properties&gt;Tools</strong>.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>3. Under Error-checking, select <strong>Check Now</strong>.</td>
</tr>
<tr>
<td>Diskette is incorrectly inserted.</td>
<td>Remove and reinsert diskette.</td>
<td></td>
</tr>
<tr>
<td>Files on the diskette are damaged.</td>
<td>Verify the program diskettes.</td>
<td></td>
</tr>
<tr>
<td>Drive cable is not properly connected.</td>
<td>Reconnect the power cable and verify that all four pins are connected.</td>
<td></td>
</tr>
<tr>
<td>Drive not found.</td>
<td>Cable is loose.</td>
<td>Reseat the diskette drive data and power cables.</td>
</tr>
<tr>
<td></td>
<td>Removable drive is not seated properly.</td>
<td>Reseat the drive.</td>
</tr>
<tr>
<td>Problem</td>
<td>Cause</td>
<td>Solution</td>
</tr>
<tr>
<td>---------</td>
<td>-------</td>
<td>----------</td>
</tr>
<tr>
<td>Diskette drive cannot write to a diskette.</td>
<td>Diskette is not formatted.</td>
<td>Format the diskette.</td>
</tr>
<tr>
<td></td>
<td>Diskette is write-protected.</td>
<td>Use another diskette or remove the write protection.</td>
</tr>
<tr>
<td></td>
<td>Writing to the wrong drive.</td>
<td>Verify the drive letter in the path statement.</td>
</tr>
<tr>
<td></td>
<td>There is not enough space on the diskette.</td>
<td>Use another diskette.</td>
</tr>
<tr>
<td></td>
<td>Diskette write-control is enabled.</td>
<td>Use the Computer Setup (F10) Utility to verify the storage security feature disabled settings.</td>
</tr>
<tr>
<td></td>
<td>Diskette is damaged.</td>
<td>Replace the damaged disk.</td>
</tr>
<tr>
<td>Cannot format diskette.</td>
<td>Invalid media reported.</td>
<td>When formatting a disk in MS-DOS, you might need to specify diskette capacity. For example, to format a 1.44-MB diskette, enter the following command at the MS-DOS prompt: <code>FORMAT A: /F:1440</code></td>
</tr>
<tr>
<td>A problem has occurred with a disk transaction.</td>
<td>The directory structure is bad, or there is a problem with a file.</td>
<td>1. Right-click <strong>Start</strong>, select <strong>Explore</strong>, and then select a drive. 2. Select <strong>File&gt;Properties&gt;Tools</strong>. 3. Under Error-checking, select <strong>Check Now</strong>.</td>
</tr>
<tr>
<td>Diskette drive cannot read a diskette.</td>
<td>Diskette is not formatted.</td>
<td>Format the diskette.</td>
</tr>
<tr>
<td></td>
<td>You are using the wrong diskette type for the drive type.</td>
<td>Verify the type of drive that you are using and use the correct diskette type.</td>
</tr>
<tr>
<td></td>
<td>You are reading the wrong drive.</td>
<td>Verify the drive letter in the path statement.</td>
</tr>
<tr>
<td></td>
<td>Diskette is damaged.</td>
<td>Replace the diskette with a new one.</td>
</tr>
<tr>
<td>Invalid system disk is displayed.</td>
<td>A diskette that does not contain the system files needed to start the workstation has been inserted into the drive.</td>
<td>When drive activity stops, remove the diskette and press the Spacebar. The workstation attempts to boot from the next device in the boot order.</td>
</tr>
<tr>
<td></td>
<td>Diskette error has occurred.</td>
<td>Restart the workstation by pressing the power button.</td>
</tr>
<tr>
<td>Cannot boot to diskette</td>
<td>Diskette is not bootable.</td>
<td>Replace with a bootable diskette.</td>
</tr>
<tr>
<td></td>
<td>Diskette boot has been disabled in Computer Setup.</td>
<td>Run the Computer Setup (F10) Utility and enable diskette boot in <strong>Storage&gt;Boot Order</strong>.</td>
</tr>
<tr>
<td></td>
<td>Removable media boot has been disabled in Computer Setup.</td>
<td>Run the Computer Setup (F10) Utility and enable Removable Media Boot in <strong>Storage&gt;Storage Options</strong>.</td>
</tr>
<tr>
<td></td>
<td>Diskette MBR validation is enabled.</td>
<td>Run the Computer Setup (F10) Utility and disable Diskette MBR Validation in <strong>Storage&gt;Storage Options</strong>.</td>
</tr>
</tbody>
</table>
## Solving hard drive problems

<table>
<thead>
<tr>
<th>Problem</th>
<th>Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hard drive error occurs.</td>
<td>Hard disk has bad sectors or has failed.</td>
<td>Locate and block the usage of bad sectors. If necessary, reformat the hard disk. If the drive is detected by the BIOS, run DPS Self-test.</td>
</tr>
</tbody>
</table>
| Disk transaction problem. | The directory structure is bad, or there is a problem with a file. | 1. Right-click **Start**, select **Explore**, and select a drive.  
2. Select **File>Properties>Tools**.  
3. Under Error-checking, select **Check Now**. |
| Drive not found (identified). | Improper cable connection | On workstations with discreet data and power cables, ensure that the data and power cables are securely connected to the hard drive. (See the **Hard drive** section of this guide for connection details.) |
| Improperly seated hard drive | | On systems with blind-mate drive connections, check for connector damage on the drive and in the chassis. Reseat the hard drive and its carrier in the chassis to ensure a proper connection. (See the **Hard drive** section of this guide for connection details.) |
| The system might not have automatically recognized a newly installed device. | | 1. Run the Computer Setup (F10) Utility.  
2. If the system does not recognize the new device, verify that the device is listed in the Computer Setup (F10) Utility.  
   If it is listed, the probable cause is a driver problem.  
   If it is not listed, the probable cause is a hardware problem.  
3. If this drive is newly installed, enter **Setup** and try adding a POST delay under Advanced>Power-On. |
<p>| Drive responds slowly immediately after power-up. | Run the Computer Setup (F10) utility, and increase the POST Delay in Advanced&gt;Power-On Options. |</p>
<table>
<thead>
<tr>
<th>Problem</th>
<th>Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Nonsystem disk or NTLD missing message.</td>
<td>System is trying to start from a nonbootable diskette.</td>
<td>Remove the diskette from the drive.</td>
</tr>
</tbody>
</table>
| | System is trying to start from a damaged hard drive. | 1. Insert a bootable diskette into the drive and restart the workstation.  
2. If the hard drive is still inaccessible and MBR Security is enabled, try restoring the previously saved MBR image by entering Setup and selecting Security>Restore Master Boot Record. |
| | System files missing or not properly installed. | 1. Insert a bootable system diskette and restart.  
2. Verify that the hard drive is partitioned and formatted.  
3. Install the system files for the appropriate operating system, if necessary. |
| | Hard drive boot disabled in Computer Setup. | Run the Computer Setup (F10) Utility and enable the hard drive entry in the Storage>Boot Order list. |
| Workstation will not start. | Hard drive is damaged. | Replace the hard drive. |
# Solving display problems

## Table 6-5  Display problems

<table>
<thead>
<tr>
<th>Problem</th>
<th>Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Blank screen (no video).</td>
<td>The cable connections are not correct.</td>
<td>Verify the cable connections from the monitor to the workstation and to a working electrical outlet.</td>
</tr>
<tr>
<td></td>
<td>The monitor is off.</td>
<td>Turn the monitor on (LED is on). You might need to refer to the monitor manual for an explanation of LED signals.</td>
</tr>
<tr>
<td></td>
<td>Screen blanking utility installed or energy saver features enabled.</td>
<td>Press a key or the mouse button and, if set, enter your password.</td>
</tr>
<tr>
<td></td>
<td>System ROM is bad; system is running in FailSafe Boot Block mode (indicated by 8 beeps).</td>
<td>Reflash the ROM using a SoftPaq.</td>
</tr>
<tr>
<td></td>
<td>Fixed-sync monitor does not sync at the resolution specified.</td>
<td>Verify that the monitor can accept the same horizontal scan rate as the resolution specified.</td>
</tr>
<tr>
<td></td>
<td>Computer is in Hibernate mode.</td>
<td>Press the power button to resume from Hibernate mode.</td>
</tr>
</tbody>
</table>
| | Workstation monitor settings are not compatible with the monitor. | 1. When you see Press F8 in the bottom-right corner of the screen, restart the workstation and press F8 during startup.  
2. Using the keyboard arrow keys, select Enable VGA Mode and then press Enter.  
3. For Windows, double-click the Display icon in the Control Panel and then select the Settings tab.  
4. Use the sliding control to reset the resolution. |
| | The display works properly during the POST but goes blank when the operating system starts. | 1. For Windows, restart your workstation in VGA mode.  
2. After the operating system starts, change the display settings to match those supported by your graphics card and monitor.  
3. Refer to your operating system and graphics card documentation for information about changing display settings. |
| | Power LED flashes red 6 times (once every second), followed by a 2-second pause, and then the workstation beeps 6 times. | Prevideo graphics error. For systems with a graphics card:  
1. Reseat the graphics card.  
2. Replace the graphics card.  
3. Replace the system board. |
<p>| | Monitor does not function when used with Energy Saver features. | Monitor without Energy Saver capabilities is being used with Energy Saver features enabled. Disable the monitor Energy Saver feature. |</p>
<table>
<thead>
<tr>
<th>Table 6-5  Display problems (continued)</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Problem</strong></td>
</tr>
<tr>
<td>Dim characters</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>Blurry video or requested resolution cannot be set.</td>
</tr>
<tr>
<td>Monitor cannot display requested resolution.</td>
</tr>
</tbody>
</table>
| The picture is broken up, rolls, jitters, or flashes. | The monitor connections might be faulty, or the monitor might be incorrectly adjusted. | 1. Be sure the monitor cable is securely connected to the workstation.  
2. In a multiple CRT monitor system, ensure that the monitors’ electromagnetic fields are not interfering with each other. Move them apart if necessary.  
3. Move fluorescent lights or fans that are too close to the CRT monitor. |
| Monitor must be degauss. Degauss the monitor. |                                            | None. It is normal for the degaussing coil to be activated when the monitor is powered on. |
| Vibrating or rattling noise coming from inside a CRT monitor when powered on. | Monitor de gaussing coil has been activated. | None. It is normal for some monitors to make a clicking noise when turned on and off, when going in and out of Standby mode, and when changing resolutions. |
| Clicking noise coming from inside a CRT monitor. | Electronic relays have been activated inside the monitor. | None. It is normal for some monitors to make a clicking noise when turned on and off, when going in and out of Standby mode, and when changing resolutions. |
| High pitched noise coming from inside a flat-panel monitor. | Brightness and contrast settings are too high. | Lower brightness and contrast settings. |
| Fuzzy focus; streaking, ghosting, or shadowing effects; horizontal scrolling lines; faint vertical bars; or unable to center the picture on the screen (flat-panel monitors using an analog VGA input connection only.) | Flat-panel monitor’s internal digital conversion circuits might be unable to correctly interpret the output synchronization of the graphics card. | 1. Select the monitor’s **Auto-Adjustment** option in the monitor’s onscreen display menu.  
2. Manually synchronize the Clock and Clock Phase onscreen display functions.  
3. Download SoftPaq SP22333 to assist with the synchronization). |
| Some typed symbols do not appear correctly. | The font you are using does not support that symbol. | Use the Character Map to locate and select the appropriate symbol.  
Select **Start>All Programs> Accessories>System Tools>Character Map.** You can copy the symbol from the Character Map into a document. |
# Solving audio problems

## Table 6-6 Audio problems

<table>
<thead>
<tr>
<th>Problem</th>
<th>Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sound does not come out of the speaker or headphones.</td>
<td>Software volume control is turned down.</td>
<td>Double-click the <strong>Speaker</strong> icon on the taskbar and use the volume slider to adjust the volume.</td>
</tr>
<tr>
<td></td>
<td>The external speakers are not turned on.</td>
<td>Turn on the external speakers.</td>
</tr>
<tr>
<td></td>
<td>External speakers plugged into the wrong audio jack.</td>
<td>See your sound card documentation for proper speaker connection.</td>
</tr>
</tbody>
</table>
| Digital CD audio is not enabled. | Enable digital CD audio:  
1. From the Control Panel, select **System**.  
2. On the Hardware tab, select the **Device Manager** button.  
3. Right-click the **CD/DVD** device and select **Properties**.  
4. On the Properties tab, select **Enable digital CD audio for this CD-ROM device**. | |
| Headphones or devices connected to the line-out connector have muted the internal speaker. | Turn on and use headphones or external speakers, if connected, or disconnect headphones or external speakers. |
| Volume is muted. | 1. From the Control Panel, select **Sound, Speech and Audio Devices**, and then select **Sounds and Audio Devices**.  
2. Deselect the **Mute** checkbox. | |
| Computer is in Standby mode. | Press the power button to resume from Standby mode. |
| Noise or no sound comes out of the speakers or headphones. | 1. If you are using digital speakers that have a stereo jack and you want the system to autoswitch to digital, use a stereo-to-mono adapter to engage the auto sense feature, or use multimedia device properties to switch the audio signal from analog to digital.  
2. If the headphones have a mono jack, use the multimedia device properties to switch the system to analog out.  

**NOTE:** If you set digital as the Output Mode, the internal speaker and external analog speakers no longer output audio until you switch back to an auto sense or analog mode.  
If you set analog as the Output Mode, external digital speakers do not function until you change the output mode back to an auto-sense or digital mode. |
Table 6-6  Audio problems (continued)

<table>
<thead>
<tr>
<th>Problem</th>
<th>Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sound occurs intermittently.</td>
<td>Processor resources are being used by other open applications.</td>
<td>Shut down all open processor-intensive applications.</td>
</tr>
</tbody>
</table>
| Workstation appears to be locked up while recording audio. | The hard disk might be full. | 1. Before recording, be sure there is enough free space on the hard disk.  
|                                |                                                 | 2. Try recording the audio file in a compressed format. |

Solving printer problems

Table 6-7  Printer problems

<table>
<thead>
<tr>
<th>Problem</th>
<th>Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Printer does not print.</td>
<td>Printer is not turned on and online.</td>
<td>Turn the printer on and be sure it is online.</td>
</tr>
<tr>
<td></td>
<td>The correct printer driver for the application is not installed.</td>
<td>1. Install the correct printer driver for the application.</td>
</tr>
</tbody>
</table>
|                        |                                                                     | 2. Try printing using the MS-DOS command: 
|                        |                                                                     | `DIR C:\>[printer port]`                                                  |
|                        |                                                                     | Replace `printer port` with the address of the printer used. If the printer works, reload the printer driver. |
| If you are on a network, you might not have made a connection to the printer. | Make the proper network connection to the printer.                    |
| Printer might have failed. | The cables might not be connected properly.                          | Run printer self-test.                                                   |
| Printer does not turn on. | The cables might not be connected properly.                          |                                                                          |

Self-troubleshooting with HP Vision Diagnostics

Hewlett-Packard Vision Field Diagnostics let you view information about the hardware configuration and perform hardware troubleshooting for HP Desktop and Workstation systems. These tools let you isolate potential issues and determine if problems relate to the operating system or the hardware. These diagnostics run outside the operating system by DVD, CD, or USB flash drive, making them easy to access and use.

HP Vision Diagnostics offer these benefits:

- Ability to capture complete system configuration information that can be shared as an HTML file, including:
  - System serial number
  - System product number
  - System BIOS revision
• Memory size and configuration
• Processor information
• Storage device information and configuration
• Graphics / audio / communications information and configuration
• And more…

● Comprehensive list of diagnostic test available with new added features:
  ○ Highly configurable testing options: quick / complete / custom / interactive / non-interactive
  ○ Specific failing memory DIMM identification
  ○ Tests video card memory
  ○ Launches DST Smart tests for both SATA and SAS drives
  ○ Many other tests and diagnostics

● Diagnostic Failure Code Output – A unique warranty code is generated for each failure which can be used to validate diagnostic use for a specific system

● Easy to use - uses similar user interface as previous field diagnostics, HP Insight Diagnostics

● True End2End diagnostics – same diagnostics modules used in factory

● Easy to obtain:
  ○ Download from Web
  ○ Bootable via USB flash drive, DVD, or CD
  ○ Included with restore media

Please run Vision diagnostics on supported products when attempting to troubleshoot system issues.

**Overview**

The HP Vision Diagnostics utility lets you view information about the hardware configuration of the workstation and perform hardware diagnostic tests on subsystems. The utility simplifies the process of effectively identifying, diagnosing, and isolating hardware issues.

Invoke HP Vision Diagnostics to display the Survey tab. This tab shows the current configuration of the workstation. From the Survey tab, you can access several categories of information about the workstation. Other tabs provide additional information, including diagnostic test options and test results.

Use HP Vision Diagnostics to determine if the system recognizes all the devices installed on the workstation and if the devices function properly. HP recommends that you run these tests after you install or connect new devices.

You can save the information from each diagnostic screen to an HTML file. You should run tests, save the test results, and print them so that you have a report available before placing a call to the Customer Support Center.

**NOTE:** HP Vision Diagnostics may not detect third-party devices..
**Downloading and accessing HP Vision Diagnostics**

Follow these steps to download the HP Vision Diagnostics utility from the HP Web site to a CD, DVD, or USB flash drive. Then use the disk or drive to perform diagnostics on the workstation:

2. Select the **Support & Drivers** link.
3. Select the **Download driver and software** radio button.
4. Enter your product number in the text box, and then press **Enter**.
5. Select your operating system.
6. Select the **Diagnostic** link.
7. Locate **HP Vision Diagnostics** and select **Download**.
8. After the `.iso` file is downloaded, save the file to a USB flash drive (recommended for faster performance) or use CD-ROM burning software to copy the `.iso` file to an optical medium.
9. Insert the disk or USB drive into the workstation while it is turned on.
10. Shut down the workstation.
11. Turn on the workstation. The system boots into HP Vision Diagnostics.

**NOTE:** If the system does not boot to the CD in the optical drive or the USB flash drive, you may need to change the boot order. You may use the Computer Setup (F10) utility to change the boot order, or press F9 to select the appropriate boot device.

12. At the boot menu, select either the **HP Vision Diagnostics** utility to test the various hardware components in the computer or the **HP Memory Test** utility to test memory only.

**NOTE:** The HP Memory Test, a comprehensive memory diagnostic utility, runs as a stand-alone application, outside of HP Vision Diagnostics. If the workstation boots from a CD, you must use a separate boot CD to run the memory diagnostic. Hence, HP recommends that you use a USB key to boot the diagnostic utilities. It is faster than using a CD or DVD, and it accommodates both Memory and Vision diagnostics.

13. If you run HP Vision Diagnostics, select the appropriate language and click **Continue**.
14. In the End User License Agreement page, select **Agree** if you agree with the terms. The HP Vision Diagnostics utility launches and displays the Survey tab.
Accessing HP Vision Diagnostics on the workstation

The following procedures describe how to access the HP Vision Diagnostics utilities included in the workstation software.

Creating and using a bootable USB key

This section describes how to use a USB key to access the HP Vision Diagnostics.

**NOTE:** Using a USB key is the most convenient method to access the HP Vision Diagnostics.

1. In the C:\VisionDiagnostics\ directory, double-click on VisionDiagUSB.exe. A setup menu appears.
2. Follow the setup prompts to create a bootable ISO image of the diagnostic utilities on a USB key.
3. Use the operating system to turn off the workstation.
4. Restart the workstation with the USB key installed. The workstation boots to the USB key and initiates HP Vision Diagnostics.
5. Follow the prompts to troubleshoot the workstation.

Creating and using a bootable DVD

This section describes how to use a DVD to access the HP Vision Diagnostics.

1. In the C:\VisionDiagnostics\ directory, double-click on the VisionDiagISO.exe file. A setup menu appears.
2. Follow the setup prompts to create a bootable ISO image of the diagnostic utilities on a DVD.
3. Enable a workstation boot from DVD.
4. Use the operating system to turn off the workstation.
5. Restart the workstation with the DVD installed in the optical drive. The workstation boots to the DVD and initiates HP Vision Diagnostics.
6. Follow the HP Vision Field Diagnostic prompts to troubleshoot the workstation.

Using the HP Memory Test utility

This section describes how to access the HP Memory Test utility.

**NOTE:** The HP Memory Test is a comprehensive memory diagnostic utility that is run as a stand-alone application, outside of HP Vision Diagnostics.

If the workstation is booted from a CD, a separate boot CD will be required to use the memory diagnostic. Hence, HP recommends that a USB key be used to boot the diagnostic utilities. It is faster than using a CD, and it accommodates both Memory and Vision diagnostics.

1. In the C:\VisionDiagnostics\ directory, double-click on the MemoryDiagISO.exe file. A setup menu appears.
2. Follow the setup prompts to create a bootable ISO image of the memory diagnostic utility on a DVD.
3. Use the operating system to turn off the workstation.
4. Restart the workstation with the DVD installed in the optical drive. The workstation boots to the DVD and initiates the memory diagnostic utility.

5. Follow the diagnostic prompts to troubleshoot workstation memory.
User interface

The HP Vision Diagnostics application provides six major functions, accessible through Tabs. These functions are:

- **Survey** — Your current system hardware information.
- **Test** — List all diagnostics available for your system. Tests are started there.
- **Status** — This screen shows progress and status of currently running diagnostics.
- **History** — All past diagnostics runs and status are listed there.
- **Errors** — All past diagnostics failures are listed there.
- **Help** — User help about HP Vision Diagnostics.

There are also some common operations that are part of the utility. They include:

- **Exit Diagnostics** button — This button will close HP Vision Diagnostic application and reboot your system. Any running test will be aborted.
- **Reload** button — If available, this button will rescan your system hardware and reload the diagnostics without the need to restart your entire system.
- **Save** button — If available, save your system survey, test history or error data as an HTML file to a floppy disk or a USB key drive.

Survey tab

The Survey tab shows your system hardware information, organized into eleven Categories (for example “Processors”) and device instances (for example “Processor 1”).

The amount of information displayed can be controlled by selecting a combination of View Level and Category.

The **View Levels** include:

- **Overview** — shows high level summary of the system hardware. This is the default view level.
- **Summary** — gives limited configuration data for each specific Category.
- **Advanced** — offers more technical and low-level data for the computer-savvy user.

The **Categories Levels** include:

- **All** — Shows all Categories.
- **Architecture** — Shows system architecture information such as high level PCI devices, low level SMBIOS, CMOS and PCI configuration space data.
- **Audio** — Shows all embedded and add-on audio devices.
- **Asset Control** — Shows asset control related information such as product name, serial number, asset tag, and universal unique ID information.
- **Communication** — Shows communication devices such as serial, parallel, USB, network, Firewire, modem, and Bluetooth ports and devices.
- **Graphics** — Shows all embedded and add-on video cards.
- **Input Devices** — Shows user input devices such as all connected mice and keyboards.
- **Memory** — Shows system memory information.
- **Miscellaneous** — List any devices or data that don't belong to any other Category.
- **Processors** - Shows system processors.
- **Storage** — Shows mass storage devices such as floppy drives, optical drives, SATA, SAS hard disk drives and controllers, as well as any RAID arrays.
- **System** — Shows information about system board devices such as fans and cables.
Test tab

The Test tab lists all available diagnostics. The lists have been tailored according to your system configuration. You can select or unselect different Test Modes:

- **Quick** — Performs quick-performance tests that cover your entire hardware. You cannot change test parameters.
- **Complete** — Performs all available tests but may take a long time to complete. You cannot change test parameters.
- **Custom** — Offers all available tests, and you can change test parameters to fit your specific needs. For advanced users only!

By default, the three test modes do not display prompts and require no interaction. Errors are displayed when testing is complete.

To add interactive tests, click the Include interactive tests box under Test Mode. Interactive tests give you maximum control over the testing process. The diagnostic software prompts you for input during tests.

**NOTE:** Memory can not be tested from within the HP Vision Diagnostics application. To test the memory in your workstation, exit HP Vision Field Diagnostic, boot to either the CD or USB flash drive and select HP Memory Test from the boot menu.

The **Duration of Test** options control the duration of the test sequence. The following options are available:

- **Number of loops** — A test selection will run once by default. Enter a positive number to make a test selection run many times.
- **Total test time (hours:minutes)** — Alternatively, the test selection can be set to run for a specified amount of time. This does not guarantee that all tests will run if the entered time is less than the necessary time to run all the tests.
- **Stop at first error** — Check this option to stop test execution as soon as one error is encountered.

The following **Test Controls** exist:

- **Select All, Unselect All** button — This button toggles to select or unselect all the tests from the test selection tree.
- **Expand, Collapse** button — This button toggles to expand or collapse the test selection tree.
- **Start Test** button — Click this button to start executing all selected tests. HP Vision Diagnostics will automatically switch to the Status tab in order to keep track of the test execution and status.

**WARNING!** Once started, do not reboot or power off your computer until all the tests have been completed.

To begin testing:

1. Select the Test tab.
2. Select the type of tests you want to run: **Quick**, **Complete**, or **Custom**.
3. Include optional interactive tests by selecting Include interactive tests.
4. Choose how you want the test to be executed, either **Number of Loops** or **Total Test Time**. When choosing to run the test over a specified number of loops, enter the number of loops to perform. If you want the diagnostic test for a specified time period, enter the amount of time in minutes.

5. Click the **Start Test** button to begin the testing. This displays the Status tab, which lets you monitor the progress of the tests. When the tests finish, the Status tab shows whether the devices passed or failed.

6. If errors are found, go to the Errors tab to display detailed information and recommended actions.
**Status tab**

The Status tab shows the overall progress and status of the test scenario as well as the progress and status of each test. The color coded status are black, blue, green, red, and orange.

The Status tab colors are:

- **Waiting** (black) — when no test is running
- **Running** (blue) — when at least one test is currently running
- **Passed** (green) — when all tests have run successfully, meaning that no hardware error or defect has been detected
- **Failed** (red) — when the tests have detected at least one error with your system
- **Canceled** (orange) — when the test scenario has been explicitly canceled, in which case no pass or fail conclusion can be drawn

The available data is:

- **Current Loop** — Shows the current execution loop out of the total number of loops specified in the Test panel.
- **Test Time** — Shows the total time elapsed since the beginning of the test execution.
- **Test Complete** — Shows the number of tests successfully completed out of the total number of test to execute.
- **Cancel** button — Push the Cancel button to immediately terminate all currently running tests.

**History tab**

The History tab shows the history of the past test executions.

The History Log displays all tests that have been executed, the number of times of execution, the number of times failed, the date each test was executed, and the time it took to complete each test. The **Clear History** button will clear the contents of the History Log.

The contents of the History Log may be saved as an HTML file to either floppy or USB flash drive by clicking the **Save** button.

**Errors tab**

The Errors tab displays detailed information about any errors found, as well as any recommended actions.

The Error Log displays the tests for devices that have failed during the diagnostic testing and includes the following columns of information:

- The Device section displays the device tested.
- The Test section displays the type of test run.
- The Times Failed is the number of times the device has failed a test.
- The Defect Code provides a numerical code for the failure. The error codes are defined in the Help tab.
- The Description section describes the error that the diagnostic test found.
• The Reason section describes the likely cause of the error.
• The Recommended Repair will give a recommended action that should be performed to resolve the failed hardware.
• The Warranty ID is a unique error code associated with the specific error on your computer. When contacting the HP Support Center for assistance with a hardware failure, please be prepared to provide the Warranty ID.
• The Clear Errors button will clear the contents of the Error Log.

The contents of the Error Log may be saved as a HTML file to either floppy or USB flash drive by clicking the **Save** button.

### Help tab

The Help tab contains a Vision Help section, and a Test Components section. This tab includes search and index features. You may also review the HP End User License Agreement (EULA), as well as the HP Vision Field Diagnostic application version information on this tab.

The various sections located here are:

• The Vision Help section contains information on the major functions of HP Vision Diagnostics.
• The Test components section provides a description of each test, as well as the parameters that may be adjusted when running in Custom test mode.
• The Defect codes section contains information on the numerical error code that may appear in the Errors tab.
• The Memory test tab section provides information on the HP Memory Test application that may be launched from the boot menu.
• The HP Support section provides information on obtaining technical support from HP.
Saving and printing information in HP Vision Diagnostics

You can save the information displayed in the HP Vision Diagnostics Survey, History and Errors tabs to a diskette or a USB flash drive. You can not save to the hard drive. The system will automatically create an html file that has the same appearance as the information displayed on the screen.

1. Insert a diskette or USB flash drive if running HP Vision Diagnostics from CD.

2. Click **Save** in the bottom on any of the Survey, History or Errors tabs. All three log files will be saved regardless of from which tab the Save button was clicked.

3. Select the drive onto which you will save the log files and click the **Save** button. Three html files will be saved to the inserted diskette or USB flash drive.

   **NOTE:** Do not remove the diskette or USB key until you see a message indicating that the html files have been written to the media.

4. Print the desired information from the storage device used to save it.

   **NOTE:** To exit HP Vision Diagnostics, click the **Exit Diagnostics** button at the bottom of the screen. Be sure to remove the USB flash drive or CD from the optical drive.

Diagnostic codes and errors

This section presents information about diagnostic LED codes, LED color definitions, and POST error messages to help you troubleshoot problems.

Diagnostic LED and audible (beep) codes

This section describes the front and rear panel LED error and operation codes as well as the audible codes that might occur before or during the POST.

**NOTE:** Some workstation models do not have Built-In Self Test (BIST) LED functionality.
### Table 6-8  Diagnostic lights and audible codes

<table>
<thead>
<tr>
<th>Activity</th>
<th>Possible cause</th>
<th>Recommended action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Blue Power LED on. No beeps.</td>
<td>Workstation on.</td>
<td>N/A</td>
</tr>
<tr>
<td>Blue Power LED blinks every two seconds. No beeps.</td>
<td>Workstation in Sleep mode (S3-Suspend to RAM). Select models only.</td>
<td>N/A</td>
</tr>
<tr>
<td>Blue Power LED is off. No beeps.</td>
<td>Workstation in Hibernate mode (S4-Suspend to disk) or off state (S5).</td>
<td>N/A</td>
</tr>
<tr>
<td>Blue Power LED blinks three times*, once per second. No beeps.</td>
<td>Workstation in Sleep mode (S3-Suspend to RAM). Select models only.</td>
<td>N/A</td>
</tr>
<tr>
<td>Blue Power LED blinks four times*, once per second. No beeps.</td>
<td>Workstation in Hibernate mode (S4-Suspend to disk).</td>
<td>N/A</td>
</tr>
</tbody>
</table>

* User-selectable. The BIOS option you select controls the blue LED function during these suspend modes. See The Computer Setup (F10) Utility menu on page 34 for details.

For the following LED activity and beeps, the beeps are heard through the chassis speaker. Blinks and beeps repeat for 5 cycles, after which, only the blinks continue to repeat.

<table>
<thead>
<tr>
<th>Red Power LED blinks two times, once every second, followed by a two-second pause. Two beeps.</th>
<th>CPU thermal protection activated by either of the following methods:</th>
<th><strong>CAUTION:</strong> Internal components might be powered even when the workstation is off. To prevent damage, disconnect the workstation power cord before you remove a component.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>● A fan might be blocked or not turning.</td>
<td>1. Ensure that the workstation air vents are not blocked and the cooling fan is running.</td>
</tr>
<tr>
<td></td>
<td>● The heatsink and fan assembly is not properly attached to the CPU.</td>
<td>2. Open the access panel, press power button, and verify that the CPU fan is spinning. If the CPU fan is not spinning, make sure the fan cable is plugged into the workstation board header. Ensure the fan is fully and properly seated or installed.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>3. If fan is plugged in and seated properly, but is not spinning, the problem might be in the CPU fan. Contact HP for assistance.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>4. Verify that the fan assembly is properly attached. If problems persist, there might be a problem with the CPU heatsink. Contact HP for assistance.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Red Power LED blinks three times, once every second, followed by a two-second pause. Three beeps.</th>
<th>CPU not installed (not an indicator of bad CPU).</th>
<th>1. Verify that the CPU is present.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>2. Reseat the CPU.</td>
<td></td>
</tr>
</tbody>
</table>
### Table 6-8 Diagnostic lights and audible codes (continued)

<table>
<thead>
<tr>
<th>Activity</th>
<th>Possible cause</th>
<th>Recommended action</th>
</tr>
</thead>
</table>
| Red Power LED blinks four times, once every second, followed by a two-second pause. Four beeps. | Power failure (power supply is overloaded) **CAUTION:** Internal components might be powered even when the workstation is off. To prevent damage, disconnect the workstation power cord before you remove a component. | 1. Open the access panel and ensure that all power connections (24-pin Main, 4-pin CPU) are secure on the system board.  
2. Check if a device is causing the problem by removing **all** attached devices (such as hard, diskette, or optical disk drives, and expansion cards.) Power on the computer. If the system enters the POST, power off and replace one device at a time; repeat this procedure until failure occurs. Replace the device that is causing the failure. Continue adding devices one at a time to ensure all devices are functioning properly.  
3. (For computers with a BIST LED on the rear panel) Check the power supply functionality:  
   - a. Disconnect the AC power.  
   - b. Disconnect **all** internal power supply cables.  
   - c. Plug in the AC power.  
   - d. Power on the computer.  
     - If the power supply fan spins and the BIST LED lights, the power supply is functional. The problem might be on the system board. Contact HP for assistance.  
     - If the power supply fan does not spin or the BIST LED does not light, the problem might be in the power supply. Contact HP for assistance. |
| Red Power LED blinks five times, once every second, followed by a two-second pause. Five beeps. | Pre-video memory error **CAUTION:** Internal components might be powered even when the workstation is off. To prevent damage, disconnect the workstation power cord before you remove a component. | 1. Reseat DIMMs.  
2. Replace DIMMs one at a time to isolate faulty module.  
3. Replace third-party memory with HP memory.  
4. The problem might be on the system board. Contact HP for assistance. |
| Red Power LED blinks six times, once every second, followed by a two-second pause. Six beeps. | Pre-video graphics error **CAUTION:** Internal components might be powered even when the workstation is off. To prevent damage, disconnect the workstation power cord before you remove a component. | 1. Reseat the graphics card.  
2. Verify the graphics auxiliary power cable is connected (if applicable).  
3. The problem might be on the graphics card. Contact HP for assistance. |
<table>
<thead>
<tr>
<th>Activity</th>
<th>Possible cause</th>
<th>Recommended action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Red Power LED blinks seven times, once every second, followed by a two-second pause. Seven beeps.</td>
<td>System board failure (ROM detected failure prior to video).</td>
<td>1. Clear CMOS. <strong>NOTE:</strong> Refer to the Maintenance and Service Guide for the workstation model for detailed information on clearing CMOS. 2. The problem might be on the system board. Contact HP for assistance.</td>
</tr>
<tr>
<td>Red Power LED blinks eight times, once every second, followed by a two-second pause. Eight beeps.</td>
<td>Invalid ROM based on bad checksum.</td>
<td><strong>CAUTION:</strong> Internal components might be powered even when the workstation is off. To prevent damage, disconnect the workstation power cord before you remove a component. 1. Clear CMOS. <strong>NOTE:</strong> Refer to the Maintenance and Service Guide for the workstation model for detailed information on clearing CMOS. 2. Upgrade the ROM using SoftPaq from the hard disk drive, CD, diskette, or USB removable device (for example, HP Drive Key). See the ROM Flash section of the Maintenance and Service Guide at <a href="http://www.hp.com/support/workstation_manuals">http://www.hp.com/support/workstation_manuals</a>. SoftPaq is a self-extracting executable that lets you upgrade the ROM. The executable contains contains use instructions, To download Softpaq, visit <a href="http://www.hp.com/go/workstationsupport">http://www.hp.com/go/workstationsupport</a>. 3. The system board might have a problem. Contact HP for assistance.</td>
</tr>
</tbody>
</table>
Table 6-8  Diagnostic lights and audible codes (continued)

<table>
<thead>
<tr>
<th>Activity</th>
<th>Possible cause</th>
<th>Recommended action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Red Power LED blinks nine times, once every second, followed by a two-second pause. Nine beeps.</td>
<td>System powers on but does not start.</td>
<td>1. The system board might have a problem. Contact HP for assistance.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2. The CPU might have a problem. Contact HP for assistance.</td>
</tr>
<tr>
<td>System does not power-on and LEDs are not blinking. No beeps.</td>
<td>System unable to power on.</td>
<td>CAUTION: Internal components might be powered even when the workstation is off. To prevent damage, disconnect the workstation power cord before you remove a component.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>To resolve the problem, choose one of the following options:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Press and hold the power button for less than 4 seconds. If the hard disk drive LED turns green, then:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>1. Remove the expansion cards one at a time and try holding the power button again for less than 4 seconds.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2. The problem might be on the system board. Contact HP for assistance.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Press and hold the power button for less than 4 seconds. If the hard disk drive LED does not turn on green then:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>1. Check that unit is plugged into a working AC outlet.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2. Open the access panel and check that the power button harness is properly connected to the system board.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>3. Check that all power supply cables are properly connected to the system board.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>4. (For computers with a BIST LED on the rear panel) Check the power supply functionality:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>a. Disconnect the AC power.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>b. Disconnect ALL internal power supply cables.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>c. Plug in the AC power.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>d. Power on the computer.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• If the power supply fan spins and the BIST LED lights, the power supply is functional. The problem might be on the system board. Contact HP for assistance.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• If the power supply fan does not spin or the BIST LED does not light, the problem might be in the power supply. See Testing power supply on page 176 for more information.</td>
</tr>
</tbody>
</table>

LED color definitions

The following table describes what each LED light on the workstation front panel signifies.

Table 6-9  LED color definitions

<table>
<thead>
<tr>
<th>LED state</th>
<th>LED color</th>
<th>System status</th>
</tr>
</thead>
<tbody>
<tr>
<td>Solid</td>
<td>Blue</td>
<td>System is on.</td>
</tr>
<tr>
<td>LED state</td>
<td>LED color</td>
<td>System status</td>
</tr>
<tr>
<td>-------------------</td>
<td>-----------</td>
<td>---------------------------------------------------</td>
</tr>
<tr>
<td>Flashing</td>
<td>Blue</td>
<td>System is in Standby.</td>
</tr>
<tr>
<td>Solid or flashing</td>
<td>Red</td>
<td>System has experienced an error. (See POST error messages on page 201.)</td>
</tr>
<tr>
<td>None</td>
<td>No light</td>
<td>System is in Hibernate, or is off.</td>
</tr>
</tbody>
</table>
**POST error messages**

The Power-On Self Text (POST) is a series of diagnostic tests that runs automatically when the workstation is powered on.

Audible and visual messages occur before the operating system starts if the POST encounters a problem. POST checks the following items to ensure that the workstation system is functioning properly:

- Keyboard
- DIMMs
- Diskette drives
- All mass storage devices
- CPUs
- Controllers
- Fans
- Temperature sensors
- Cables (front/rear panels, audio, and USB ports)

The table shown next describes the POST error messages.

<table>
<thead>
<tr>
<th>Screen message</th>
<th>Probable cause</th>
<th>Recommended action</th>
</tr>
</thead>
<tbody>
<tr>
<td>101—Option ROM Checksum Error</td>
<td>System ROM checksum.</td>
<td>Verify the you have the latest ROM:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>1. Flash the ROM, if needed.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2. If an expansion card was recently added, remove it to find out if the problem remains.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>3. Clear CMOS. If the message disappears, there might be a problem with the expansion card.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>4. Replace the system board.</td>
</tr>
<tr>
<td>102—System Board Failure</td>
<td>DMA, timers, and so forth, might be set improperly or might be defective.</td>
<td>1. Clear the CMOS.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2. Remove the expansion boards.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>3. Replace the system board.</td>
</tr>
<tr>
<td>110—Out of memory space for option ROMs</td>
<td>Option ROM for a device could not run because of memory constraints.</td>
<td>1. Run the Computer Setup (F10) Utility to disable unneeded option ROMs, and to enable ACPI/USB Buffers at Top of Memory.</td>
</tr>
<tr>
<td>162—Systems Options Error</td>
<td></td>
<td></td>
</tr>
<tr>
<td>163—Time and Date Not Set</td>
<td>Invalid time or date in configuration memory.</td>
<td>1. Set the date and time from the Control Panel or in the Computer Setup (F10) Utility (depending on the operating system).</td>
</tr>
<tr>
<td></td>
<td>RTC battery might need replacement.</td>
<td>2. If the problem persists, replace the RTC battery.</td>
</tr>
<tr>
<td></td>
<td>CMOS jumper might not be properly installed.</td>
<td></td>
</tr>
<tr>
<td>Screen message</td>
<td>Probable cause</td>
<td>Recommended action</td>
</tr>
<tr>
<td>----------------</td>
<td>----------------</td>
<td>--------------------</td>
</tr>
</tbody>
</table>
| 164—Memory Size Error | Memory configuration is incorrect. | 1. Run the Computer Setup (F10) Utility or the Windows utilities.  
2. Verify that the memory modules are installed properly.  
3. If third-party memory has been added, test the memory configuration using HP memory.  
4. Verify the memory module type. |
| 201—Memory Error | RAM failure. | 1. Run the Computer Setup (F10) utility or the Windows utilities.  
2. Be sure that memory modules are installed correctly.  
3. Verify the memory module type.  
4. Remove and replace memory modules one at a time to isolate faulty modules.  
5. Replace faulty memory modules.  
6. If the error persists after replacing memory modules, replace the system board. |
| 202—Memory Type Mismatch | Memory modules do not match. | Replace the memory modules with matched sets. |
| 203—Memory module failed self-test and failing rank was disabled | Defective memory module. | Replace the memory module. |
| 204—Memory module failed and user rank was disabled | Improper module load. | Reseat the memory module correctly. |
| 205—Memory high temperature detected | Insufficient memory module cooling. | Verify that a memory module cooling fan is installed and operating. |
| 206—Memory setup invalid | Memory configured incorrectly. | Reconfigure the memory modules in the proper slots. |
| 207—Incompatible DIMMs detected | DIMMs are installed that do not fulfill system requirements. | 1. Verify that the memory module type matches workstation requirements.  
2. Insert the DIMM in the proper memory socket.  
3. Replace the DIMM if the problem persists. |
| 208—Mismatched DIMMs detected | Installed DIMMs are improperly matched. | Verify that matching DIMMs are installed. |
| 209—Memory warning condition detected | Incorrect memory module type in use. | Verify that the memory modules are compatible with workstation requirements. |
| 212—Failed Processor 0 | Processor has failed to initialize. | 1. Reseat the processor in its socket.  
2. If the processor does not respond, replace it.  
3. Replace the system board. |
<table>
<thead>
<tr>
<th>Screen message</th>
<th>Probable cause</th>
<th>Recommended action</th>
</tr>
</thead>
</table>
| 213—Incompatible Memory Modules       | A memory module in the memory socket identified in the error message is missing critical SPD information, or is incompatible with the chipset.        | 1. Verify the memory module type.  
2. Insert the DIMM in another memory socket.  
3. Replace the module with a DIMM conforming to the SPD standard. |
| 214—DIMM Configuration Warning       | DIMMs are not installed correctly (not paired correctly).                                                                                                                                                    | See the service label on the workstation access panel for the correct memory configurations, and reseat the DIMMs accordingly. |
| 215—DIMM Configuration Error          |                                                                                                                                                    | 1. Verify how much memory the workstation supports.  
2. Remove the excess memory.                                                                                          |
| 216—Memory Size Exceeds Maximum      | The amount of memory installed exceeds that supported by the hardware.                                                                                                                                     | 1. Reconnect the keyboard with the workstation powered off.  
2. Check the connector for bent or missing pins.  
3. Be sure that none of the keys are pressed.  
4. Replace the keyboard. |
| 301—Keyboard Error                    | Keyboard failure.                                                                                                                                         | 1. Reconnect the keyboard with the workstation powered off.  
2. Check the connector for bent or missing pins.  
3. Be sure that none of the keys are pressed.  
4. Replace the keyboard. |
| 303—Keyboard Controller Error         | I/O board keyboard controller is defective or is not set properly.                                                                                   | 1. Reconnect the keyboard with the workstation powered off.  
2. Connect a keyboard directly to the workstation (instead of through a switch box).  
3. Replace the system board. |
| 304—Keyboard or System Unit Error     | Keyboard failure.                                                                                                                                           | 1. Reconnect the keyboard with the workstation powered off.  
2. Connect a keyboard directly to the workstation (instead of through a switch box).  
3. Be sure that none of the keys are pressed.  
4. Replace keyboard.  
5. Replace system board. |
| 510—Splash Screen image corrupted     | Splash Screen image has errors.                                                                                                                        | Update system BIOS.                                                                                             |
| 511—CPU Fan not detected             | Fan is not connected or is defective.                                                                                                                   | 1. Reseat the fan cable.  
2. Reseat the fan.  
3. Replace the fan.                                                                                               |
| 512—Rear Chassis fan not detected    | Rear fan missing, disconnected, or defective.                                                                                                          | 1. Reseat the fan cable.  
2. Reseat the fan.  
3. Replace the fan.                                                                                               |
<table>
<thead>
<tr>
<th>Screen message</th>
<th>Probable cause</th>
<th>Recommended action</th>
</tr>
</thead>
</table>
| 513—Front Chassis fan not detected     | Front fan missing, disconnected, or defective.      | 1. Reseat the fan cable.  
2. Reseat the fan.  
3. Replace the fan. |
| 514—Memory fan not detected            | Memory fan missing, disconnected, or defective.     | 1. Reseat the fan cable.  
2. Reseat the fan.  
3. Replace the fan. |
| 515—CPU Overtemp occurred              | Insufficient processor cooling or processor defect. | 1. If necessary, add a heatsink to the processor and ensure proper operation.  
2. Replace the processor. |
| 516—Chipset fan not detected           | Chipset fan missing, disconnected, or defective.    | 1. Ensure that the fan is installed and connected properly.  
2. Replace the fan. |
| 517—Low power CPU heatsink(s) detected for high power CPUs | Inadequate heatsink is installed.                  | Replace the low power heatsink with a high power heatsink. |
| 518—Power supply wattage insufficient for hardware configuration | Workstation configuration requires more power than the power supply can provide. | 1. Reduce the workstation power consumption.  
2. Replace the power supply with a high output power supply. |
| 601—Diskette Controller Error          | Diskette controller circuitry or diskette drive circuitry incorrect. | 1. Run the Computer Setup (F10) utility.  
2. Verify cabling and replace defective cables if necessary.  
3. Clear CMOS.  
4. Replace the diskette drive.  
5. Replace the system board. |
| 605—Diskette Drive Type Error          | Mismatch in drive type.                             | 1. Run the Computer Setup (F10) Utility.  
2. Disconnect any other diskette controller devices (tape drives).  
3. Clear the CMOS. |
| 610—External Storage Device Failure    | External storage device is not detected, is improperly connected, or is defective. | 1. Verify that the external device is present and connected properly.  
2. Replace the external device. |
<p>| 611—Primary Floppy Port Address Assignment Conflict | The flexible disk drive is configured at a previously assigned address. | Select a new address for the flexible disk drive. |
| 912—Computer Cover Has Been Removed Since Last System Start Up | N/A                                                  | No action required. |</p>
<table>
<thead>
<tr>
<th>Screen message</th>
<th>Probable cause</th>
<th>Recommended action</th>
</tr>
</thead>
<tbody>
<tr>
<td>914— Hood Lock Coil is not Connected</td>
<td>Mechanism is missing or is not connected.</td>
<td>1. Reconnect or replace the missing mechanism.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2. Reseat or replace the missing mechanism cable.</td>
</tr>
<tr>
<td>916—Power Button Not Connected</td>
<td>Power button cable is disconnected from the system board.</td>
<td>Reconnect the cable and restart.</td>
</tr>
<tr>
<td>917—Front Audio Not Connected</td>
<td>Front Audio mechanism is missing or is not connected.</td>
<td>1. Replace or reconnect the missing front audio mechanism to the system board.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2. Reseat or replace the missing mechanism cable.</td>
</tr>
<tr>
<td>918—Front USB Not Connected</td>
<td>Front USB mechanism is missing or is not connected.</td>
<td>1. Replace or reconnect the missing Front USB mechanism to the system board..</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2. Reseat or replace the missing mechanism cable.</td>
</tr>
<tr>
<td>919—Multi-Bay Riser Not Connected</td>
<td>Multi-Bay riser mechanism is missing or is not connected.</td>
<td>1. Replace or reconnect the missing Multi-Bay mechanism to the system board.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2. Reseat or replace the missing mechanism cable.</td>
</tr>
<tr>
<td>920—Fatal error on QPI link X</td>
<td>Fatal error detected on QPI link x, where x is 0 or 1. This type of error is identified on the line following the error message.</td>
<td>Potential system board problem; contact HP Support.</td>
</tr>
<tr>
<td>921—Fatal error on QPI Protocol link X</td>
<td>Fatal error detected in QPI link x protocol, where x is 0 or 1. This type of error is identified on the line following the error message.</td>
<td>Potential system board problem; contact HP Support.</td>
</tr>
<tr>
<td>922—Fatal error on PCIe slot X</td>
<td>Fatal error occurred in the designated slot.</td>
<td>Move the card to a different slot. If the problem persists, replace the card.</td>
</tr>
<tr>
<td>923—Fatal error on ESI port 0 slot</td>
<td>A fatal error occurred on ESI port 0.</td>
<td>Verify that the ESI port device is connected and working properly.</td>
</tr>
<tr>
<td>924—Fatal error on IOH core X</td>
<td>Fatal error detected on IOH core x, where x is 0 or 1. This type of error is identified on the line following.</td>
<td>Potential system board problem; contact HP Support.</td>
</tr>
<tr>
<td>925—Fatal error on IOH miscellaneous</td>
<td>Fatal miscellaneous error detected on IOH core x, where x is 0 or 1.</td>
<td>Potential system board problem; contact HP Support.</td>
</tr>
<tr>
<td>926—Fatal error on IOH Vtd</td>
<td>Fatal error detected in the Intel Virtualization Technology.</td>
<td>Potential system board problem; contact HP Support.</td>
</tr>
<tr>
<td>927—Fatal error on DIMM in slot CPU X DIMM Y</td>
<td>Fatal multibit ECC error detected on the DIMM in the slot labeled CPU x DIMM y (where x is 0 or 1 and y is 1 - 6), as labeled on the system board.</td>
<td>Replace the DIMM in the identified slot.</td>
</tr>
<tr>
<td>928—Fatal machine check detected on CPU X</td>
<td></td>
<td>Contact HP support.</td>
</tr>
<tr>
<td>Screen message</td>
<td>Probable cause</td>
<td>Recommended action</td>
</tr>
<tr>
<td>----------------------------------------</td>
<td>--------------------------------------------------------------------------------</td>
<td>----------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| 1720—SMART Hard Drive Detects Imminent Failure | Hard drive is about to fail. (Some hard disk drives have a firmware patch that fixes erroneous error messages.) | 1. Determine if the hard disk drive is giving a correct error message.  
2. Run the Drive Protection System test (if applicable).  
4. Back up contents and replace the hard disk drive. |
| 1783—Fixed Disk 0/1 locked             | Hard disk drive failure.                                                        | Diagnose the hard disk drive, and replace it if necessary.                         |
| 1796—SATA Cabling Error               | Missing or improperly attached cable.                                           | Verify that a cable is attached. Reattach the cable.                               |
| 1797—SATA Drivelock is not supported in RAID mode | SATA Drivelock is not supported in RAID mode.                                   | Disable RAID mode, or disable SATA drivelock.                                     |
| 1801—Microcode Update Error           | Unknown or unsupported processor stepping.                                      | The microcode update failed. Check the processor stepping to ensure it is a supported stepping. If it is contact, HP Support. |
| 1802—Processor Not Supported          | The system board does not support the processor.                                | Replace the processor with a compatible one.                                       |
| 1803—Processor feature set is insufficient for current system settings | Processor feature set is insufficient for current system settings. The BIOS settings do not match the support provided by the processor | Change the BIOS settings or upgrade the processors.                               |
| 1804—A processor feature and the memory configuration are incompatible | A processor feature is incompatible with the memory configuration.              | Restore the previous memory configuration.                                         |
| ERROR: Invalid 1394 GUID               | No electronic serial number is stored with the system.                         | To assign a serial number, select Security>System IDs in the Computer Setup (F10) Utility. |
| ERROR: Invalid electronic serial number (no number) | No electronic serial number is stored with the system. | To assign a serial number, select Security>System IDs in the Computer Setup (F10) Utility. |
| ERROR: An unsupported processor is installed. System halted | Unsupported processor detected.                                                 | Replace the processor.                                                            |
| ERROR: A processor requiring too much power is installed. System halted | Unsupported processor detected.                                                 | Replace the processor.                                                            |
| Invalid electronic serial number       | Incorrect serial number registered in the system.                              | Use the Computer Setup (F10) Utility to reset the serial number.                  |
| Network Server Mode Active and No Keyboard Attached | Keyboard not detected.                                                         | Verify that a functioning keyboard is attached to the workstation.                 |
| Processor initialization fails!!!      | Processor defective.                                                            | Replace the processor.                                                            |
7 Configuring RAID devices

This chapter describes how to configure SAS and SATA RAID devices, and includes these topics:

<table>
<thead>
<tr>
<th>Topics</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximum hard drive configurations on page 207</td>
</tr>
<tr>
<td>Configuring SATA RAID devices on page 208</td>
</tr>
<tr>
<td>Configuring SAS RAID devices on page 211</td>
</tr>
</tbody>
</table>

For additional information about configuring RAIDs, see [http://www.hp.com/support/RAID_FAQs](http://www.hp.com/support/RAID_FAQs). For information about preparing the workstation for RAID configuration, see [http://www.hp.com/support/workstation_manuals](http://www.hp.com/support/workstation_manuals).

## Maximum hard drive configurations

This section lists the maximum number of hard drives supported on HP workstations for RAID configurations.

**NOTE:** This section applies to internal workstation configurations that do not use add-in cards and JBODs.

**TIP:** Use the table values to determine workstation-specific maximum number of hard drives as discussed the sections below.

<table>
<thead>
<tr>
<th>Workstation</th>
<th>SATA hard drive</th>
<th>SATA SFF hard drive</th>
<th>SAS hard drive</th>
</tr>
</thead>
<tbody>
<tr>
<td>Z800</td>
<td>5</td>
<td>6</td>
<td>5</td>
</tr>
<tr>
<td>Z600</td>
<td>3</td>
<td>4</td>
<td>3</td>
</tr>
<tr>
<td>Z400</td>
<td>4</td>
<td>4</td>
<td>4</td>
</tr>
</tbody>
</table>

* Small form factor hard drive
Configuring SATA RAID devices

This section describes how to use the Intel Matrix Storage Manager option ROM Configuration utility to set up and manage SATA RAID volumes.

The following SATA RAID configurations are supported on this workstation:

- Up to the workstation-specific maximum number of internal SATA hard disk drives and eSATA drives (if you use an optional eSATA bulkhead cable)
- Intel Matrix Storage Manager (IMSM) for Windows

If only a single HDD is attached, the Intel Matrix Storage Manager option ROM does not execute. Associated messages are not displayed.

The Intel SATA AHCI BIOS executes when you select RAID+AHCI for the SATA emulation mode. This BIOS is only used to support serial-attached optical drives.

This section does not apply to configuring SATA RAID in the Linux environment. For Linux SATA RAID, refer to the Software RAID in Linux Workstations section in the HP Workstations for Linux User Guide at http://www.hp.com/support/linux_user_manual.

Attaching SATA HDDs

Attach the required minimum number of SATA hard drives for the desired RAID level:

- RAID 0: two or more hard drives
- RAID 1: only two hard drives
- RAID 5: three or more hard drives
- RAID 10: only four hard drives
Configuring system BIOS

Configure the system BIOS to enable embedded SATA RAID functionality.

1. To enter the system BIOS setup, press F10.
2. Use the arrow keys to highlight the desired language, and then press Enter.
3. Use the arrows to highlight Storage>Storage Options, and then press Enter.
4. Use the up or down arrow key to highlight SATA Emulation.
5. Use the left or right arrow key to select RAID+AHCI.
6. To accept the new setting, press F10.
7. Use the arrows to highlight Advanced>Power-On Options, and then press Enter.
8. Use the up or down arrow key to highlight POST Messages.
9. Use the left or right arrow key to select Enable.
10. To accept the new setting, press F10.
11. Use the arrow keys to highlight Advanced>Device Options, and then press Enter.
12. Use the up or down arrow key to highlight SATA RAID Option ROM Download, and then press Enter.
13. Use the left or right arrow key to select Enable.
14. To accept the new setting, press F10.
15. Use the arrows to highlight File>Save Changes and Exit, and then press Enter.
16. Press F10 when prompted.
Creating RAID volumes

To create RAID volumes, use the Intel Matrix Storage Manager option ROM Configuration utility.

1. To enter the Intel Matrix Storage Manager option ROM Configuration utility, press Ctrl+l when prompted.

2. If required, see Deleting RAID volumes on page 215 to make enough physical drives available to create the RAID volume.

3. Use the up or down arrow key to highlight 1. Create RAID Volume, and then press Enter.

4. Type the desired RAID volume name in the Name: field, and then press Tab.

5. Use the up or down arrow key to select the RAID level in the RAID Level: field, and then press Tab.

6. To display the Select dialog, press Enter.

7. Use the up and down arrow keys and Space to mark individual physical as members of the volume.

8. To exit the Select dialog and return to the Create Volume Menu dialog, press Enter.

9. If appropriate, use the up or down arrow key to select the Strip Size in the Strip Size: field, and then press Tab.

10. Enter the desired volume size in the Capacity: field, and then press Tab.

11. Press Enter to initiate volume creation.

12. When prompted, press Y to acknowledge the warning message and create the volume.

13. Return to step 3 to create additional RAID volumes, or use the up or down arrow key to highlight 4. Exit, and then press Enter.

14. Press Y when prompted to confirm the exit.
Configuring SAS RAID devices

Supported configurations

The following RAID configurations are supported on this workstation:

- Up to the workstation-specific maximum number of internal SAS hard disk drives
- LSI MegaRAID Storage Manager (MSM) for Windows

The following RAID configurations are supported on this workstation:

- RAID 0 – Striped disk array (IS)
  - Two drive minimum
  - Improved I/O performance
  - No fault tolerance
- RAID 1 — Mirrored disk array (IM)
  - Two drives
  - 100% redundancy
  - Can recover from single drive failure
  - Improved read performance
- RAID 1E (IME)
  - Three drives minimum
  - Can be an odd number of drives
  - Can always recover from a single drive failure and, in some cases, can recover from two drive failures

*NOTE:* This section does not apply to configuring SAS RAID in the Linux environment. For Linux SAS RAID information, including supported configurations, refer to *Installing and Configuring SAS Hardware RAID on HP Linux Workstations* at [http://www.hp.com/support/xw8600_manuals](http://www.hp.com/support/xw8600_manuals).
SAS RAID 0 configuration

Use the following procedure to configure an Integrated Striped (IS) volume with the BIOS-based configuration utility. The procedure assumes that the system has the required disk and disk controllers.

1. Start the LSI Corporation Configuration Utility. During BIOS start up, you are prompted to Press Ctrl-C to start LSI Corp. Configuration Utility.
2. On the Main menu of the BIOS-based configuration utility, use the arrow keys to select an adapter.
3. Press Enter to go to the Adapter Properties screen.
4. On the Adapter Properties screen, use the arrow keys to select RAID Properties, and press Enter to go to the New Array Type screen.
5. In the Select New Array Type screen, use the arrow keys to select Create IS Volume. Press Enter to go to the Create New Array screen.
6. In the Create New Array screen, use the arrow keys to select the first disk for the IS volume. Then use the arrow keys to move to the RAID Disk column for this disk, and press Space and + or - to select Yes as the value for this column.
   If partitions are defined on the selected disk, a message appears warning you that data on the disk will be lost when the striped volume is created.
7. Press M to migrate, or D to delete the data on the drive.
8. To select additional drives for the striped volume, up to the workstation-specific maximum number, repeat the previous steps.
9. When all drives are selected, press C to create the array once. Use the arrow keys to move to Save changes then exit this menu and press Enter.
10. When the new array is created, the Adapter Properties screen appears. Press Esc twice and select Exit.
SAS RAID 1 configuration

Use the following procedure to configure an Integrated Mirroring (IM) volume with the BIOS-based configuration utility. The procedure assumes that the system has the required drives and drive controllers.

1. Start the LSI Corporation Configuration Utility. During BIOS start up, you are prompted to Press Ctrl-C to start LSI Corp. Configuration Utility.

2. On the Main menu of the BIOS-based configuration utility, use the arrow keys to select an adapter.

3. Press Enter to go to the Adapter Properties screen.

4. On the Adapter Properties screen, use the arrow keys to select RAID Properties, and press Enter to go to the New Array Type screen.

5. In the Select New Array Type screen, use the arrow keys to select Create IM Volume. Press Enter.

6. To configure a two-disk mirrored volume with an optional hot spare disk:
   a. In the Create New Array screen, use the arrow keys to select the primary disk for the IM volume (the disk with the data you want to mirror.)
   b. Use the arrow keys to move to the RAID Disk column for this disk and press Space to select Yes as the value.
      If partitions are defined on the selected disk, a message appears warning you that data on the disk will be lost when the mirrored volume is created.
   c. Press M to migrate or D to delete the data on the drive.
   d. The value in the Array Disk column changes to Primary.
      Use the arrow keys to select the secondary (mirrored) disk for the IM volume, and then select Yes as the value for the Array Disk column.
      If partitions are defined on this disk, a message warns that data on the disk will be lost when the mirrored volume is created.
   e. Press Delete to confirm erasing data from the disk, or press any other key to deselect the disk.

7. When all drives are selected, press C to create the array once. Use the arrow keys to move to Save changes then exit this menu and press Enter.

8. When the new array is created, the Adapter Properties screen appears. Press Esc twice and select Exit.
SAS RAID 1E configuration

Use the following procedure to configure an Integrated Mirroring Extended (IME) volume with the BIOS-based configuration utility. The procedure assumes that the system has the required disk and disk controllers.

1. Start the LSI Corporation Configuration Utility. During BIOS start up, you are prompted to Press Ctrl-C to start LSI Corp. Configuration Utility.

2. On the Main menu of the BIOS-based configuration utility, use the arrow keys to select an adapter.

3. Press Enter to go to the Adapter Properties screen.

4. On the Adapter Properties screen, use the arrow keys to select RAID Properties, and press Enter to go to the New Array Type screen.

5. In the Select New Array Type screen, use the arrow keys to select Create IME Volume. Press Enter.

6. To configure a mirrored volume or an optional hot spare drive with up to the workstation-specific maximum number of drives:
   a. In the Create New Array screen, use the arrow keys to select the first disk for the IME volume.
   b. Use the arrow keys to move to the RAID Disk column for this disk, and then use the + or - keys to select Yes as the value.
      If partitions are defined on the selected disk, a message appears warning that the data on the disk will be lost when the mirrored volume is created.
   c. Press M to migrate, or D to delete the data on the drive.
   d. Use the arrow keys to select the next disk for the IME volume, and then select Yes as the value for the Array Disk column.
      If partitions are defined on this disk, a message warns you that data on the disk will be lost when the mirrored volume is created.
   e. Press Delete to confirm erasing data from the disk, or press any other key to deselect the disk.
   f. Repeat the previous steps to select up to the workstation-specific maximum number of drives for the IME volume, including configuration of a hot spare.

7. When all drives are selected, press C to create the array once. Use the arrow keys to move to Save changes then exit this menu and press Enter.

8. When the new array is created, the Adapter Properties screen appears. Press Esc twice and select Exit.
Deleting RAID volumes

Use the LSI Logic Corporation Configuration Utility to delete SAS RAID volumes.

1. Start the LSI Corporation Configuration Utility. During BIOS start up, you are prompted to **Press Ctrl-C to start LSI Corp. Configuration Utility**.

2. On the Main menu of the BIOS-based configuration utility, use the arrow keys to select an adapter.

3. Press **Enter** to go to the Adapter Properties screen.

4. In the Select New Array Type screen, use the arrow keys to select **New Existing Array**.

5. In the View Array screen, use the arrow keys to select **Manage Array**. Press **Enter**.

6. In the Manage Array screen, use the arrow keys to select **Delete Array**. Press **Enter**.

   Press **Y** to delete the array and exit to the adapter properties screen.
This chapter describes how to configure password security and to reset CMOS, and includes these topics:

**Topics**

- Preparing to configure passwords on page 217
- Resetting the password jumper on page 218
- Clearing and Resetting the CMOS on page 219
Preparing to configure passwords

The Computer Setup (F10) Utility lets you create setup and power-on passwords.

There are three possibilities for setting passwords:

- Define a setup password only
- Define a power-on password only
- Define both

When defining a setup password only, you cannot enter the setup utility without the password.

No password is needed to start from power-on.

When defining a power-on password only, the power-on password is needed to enter F10 Setup or to start from power-on.

When defining both, the setup password is needed to enter F10 setup and can be used to start from power-on.

The power-on password cannot be used to enter the F10 Setup Utility, but it can be used to start from power-on.

One of the passwords will be required to start from power on.

After you create both passwords, you can use the setup password in place of the power-on password as an override to log into the workstation (a useful feature for a network administrator).

**NOTE:** You can only clear the passwords with the password jumper. Clearing CMOS does not clear the passwords.

**CAUTION:** Before pressing the Clear CMOS button, back up the workstation CMOS settings.

Pressing the Clear CMOS button resets CMOS values to factory defaults and erases customized information, including asset numbers and special settings.

To back up the CMOS settings, run the Computer Setup (F10) Utility and select **Save to Diskette** from the File menu.
Resetting the password jumper

Use the following procedure to disable the power-on or setup password features and clear the power-on and setup passwords.

⚠️ **WARNING:** To reduce the risk of personal injury from electrical shock and hot surfaces, disconnect the power cord from the wall outlet and let the internal system components cool before touching.

⚠️ **CAUTION:** When the workstation is plugged in, the power supply has voltage applied to the system board, even when the workstation is turned off. Failure to disconnect the power cord can result in damage to the workstation.

⚠️ **CAUTION:** Static electricity can damage the electronic components of the workstation or optional equipment. Before beginning these procedures, be sure that you are discharged of static electricity by briefly touching a grounded metal object.

1. Shut down the operating system, power off the workstation and external devices, and disconnect the workstation power cord and external devices from power outlets.
2. Disconnect the keyboard, monitor, and other external devices that are connected to the workstation.
3. Remove the access panel.
4. Locate the password header and jumper.
   The password header is E49. The password jumper is green so it can be easily identified.
5. Verify that the AC power cord is disconnected from the power outlet.
6. Remove the jumper from pins 1 and 2.
7. Replace the access panel.
8. Reconnect the external equipment.
9. Reconnect AC power to the workstation.
10. Power on the workstation.
11. Wait for the workstation to display the HP splash screen.
12. Repeat steps 1 through 5.
13. Replace the jumper from pins 1 and 2.
14. Repeat steps 7 through 10.
15. Wait for the workstation to boot to the F10 (Setup) Utility.
16. Use the F10 (Setup) Utility to create the new passwords.
Clearing and Resetting the CMOS

This section describes the steps necessary to successfully clear and reset the CMOS. The CMOS of the workstation stores password information and information about the workstation configuration.

Using the CMOS Button

To clear CMOS using the Clear CMOS button, use the following procedure:

⚠️ **WARNING!** To reduce the risk of personal injury from electrical shock and hot surfaces, disconnect the power cord from the wall outlet and let the internal system components cool before you touch them.

⚠️ **CAUTION:** When the workstation is plugged in, the power supply has voltage applied to the system board, even when the workstation is powered off. Failure to disconnect the power cord can result in damage to the workstation.

⚠️ **CAUTION:** Static electricity can damage the electronic components of the workstation or optional equipment. Before beginning these procedures, be sure that you are discharged of static electricity by briefly touching a grounded metal object.

1. Shut down the operating system, power off the workstation and any external devices, and then disconnect the workstation power cord and external devices from power outlets.

2. Disconnect the keyboard, monitor, and other external devices that are connected to the workstation.

3. Remove the access panel.

⚠️ **CAUTION:** Before pressing the Clear CMOS button, back up the workstation CMOS settings.

Pressing the Clear CMOS button resets CMOS values to factory defaults and erases customized information, including asset numbers and special settings.

To back up the CMOS settings, run the Computer Setup (F10) Utility and select **Save to Diskette** from the File menu.

4. Locate, press, and hold the CMOS button for five seconds.

**NOTE:** Verify that the AC power cord is disconnected from the power outlet.

The CMOS button does not clear CMOS if the power cord is connected.

For assistance locating the CMOS button and other components, see Clearing and Resetting the CMOS on page 219.

5. Replace the access panel.


7. Plug in and power on the workstation. The system boots to a F1 prompt and displays a message that the date/time has changed and that system options have changed.

8. Press F1. The system shuts down for three seconds and then powers back on.

9. Use the F10 (Setup) Utility to reset the date and time.
Using the Computer Setup (F10) Utility to Reset CMOS

To reset CMOS using the Computer Setup (F10) Utility:

1. Access the Computer Setup (F10) Utility menu.

2. When the Computer Setup message appears in the lower-right corner of the screen, press F10, and then press Enter to bypass the title screen, if necessary.
   
   If you do not press F10 while the message is displayed, the workstation must be restarted to access this utility.

3. From the Computer Setup (F10) Utility menu, select File>Default Setup.
   
   This restores the settings that include boot sequence order and other factory settings. However, it does not force hardware rediscovery.

4. Choose Restore Factory Settings as Default, and press F10 to accept.

5. Select File->Apply Defaults and Exit, and then press F10 to accept.

6. Reset the workstation passwords and configuration information, such as the system date and time.

   **NOTE:** This step does not clear the passwords.
# Connector pins

### Workstation keyboard

<table>
<thead>
<tr>
<th>Pin</th>
<th>Signal</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Data</td>
</tr>
<tr>
<td>2</td>
<td>Unused</td>
</tr>
<tr>
<td>3</td>
<td>Ground</td>
</tr>
<tr>
<td>4</td>
<td>+5 VDC</td>
</tr>
<tr>
<td>5</td>
<td>Clock</td>
</tr>
<tr>
<td>6</td>
<td>Unused</td>
</tr>
</tbody>
</table>

### Workstation mouse

<table>
<thead>
<tr>
<th>Pin</th>
<th>Signal</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Data</td>
</tr>
<tr>
<td>2</td>
<td>Unused</td>
</tr>
<tr>
<td>3</td>
<td>Ground</td>
</tr>
<tr>
<td>4</td>
<td>+5 VDC</td>
</tr>
<tr>
<td>5</td>
<td>Clock</td>
</tr>
<tr>
<td>6</td>
<td>Unused</td>
</tr>
</tbody>
</table>

### Workstation Ethernet

<table>
<thead>
<tr>
<th>Pin</th>
<th>10/100-Mb Signal</th>
<th>1000-Mb Signal</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>(+) Transmit Data</td>
<td>TX/RX 0 +</td>
</tr>
<tr>
<td>2</td>
<td>(-) Transmit Data</td>
<td>TX/RX 0 –</td>
</tr>
<tr>
<td>3</td>
<td>(+) Receive Data</td>
<td>TX/RX 1 +</td>
</tr>
<tr>
<td>4</td>
<td>Unused</td>
<td>TX/RX 2 +</td>
</tr>
<tr>
<td>5</td>
<td>Unused</td>
<td>RX/RX 2 –</td>
</tr>
<tr>
<td>6</td>
<td>(-) Receive Data</td>
<td>TX/RX 1 –</td>
</tr>
<tr>
<td>7</td>
<td>Unused</td>
<td>TX/RX 3 +</td>
</tr>
<tr>
<td>8</td>
<td>Unused</td>
<td>TX/RX 3 –</td>
</tr>
<tr>
<td>Workstation USB</td>
<td>Pin</td>
<td>Signal</td>
</tr>
<tr>
<td>-----------------</td>
<td>-----</td>
<td>----------</td>
</tr>
<tr>
<td></td>
<td>1</td>
<td>+5 VDC</td>
</tr>
<tr>
<td></td>
<td>2</td>
<td>- Data</td>
</tr>
<tr>
<td></td>
<td>3</td>
<td>+ Data</td>
</tr>
<tr>
<td></td>
<td>4</td>
<td>Ground</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Microphone cable (1/8 inch)</th>
<th>Pin</th>
<th>Signal</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>1</td>
<td>Audio</td>
</tr>
<tr>
<td></td>
<td>2</td>
<td>Power</td>
</tr>
<tr>
<td></td>
<td>3</td>
<td>Ground</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Headphone cable (1/8 inch)</th>
<th>Pin</th>
<th>Signal</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>1</td>
<td>Audio_Left</td>
</tr>
<tr>
<td></td>
<td>2</td>
<td>Audio_Right</td>
</tr>
<tr>
<td></td>
<td>3</td>
<td>Ground</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Audio line-in cable (1/8 inch)</th>
<th>Pin</th>
<th>Signal</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>1</td>
<td>Audio_In_Left</td>
</tr>
<tr>
<td></td>
<td>2</td>
<td>Audio_In_Right</td>
</tr>
<tr>
<td></td>
<td>3</td>
<td>Ground</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Line-out audio cable (1/8 inch)</th>
<th>Pin</th>
<th>Signal</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>1</td>
<td>Audio_Out_Left</td>
</tr>
<tr>
<td></td>
<td>2</td>
<td>Audio_Out_Right</td>
</tr>
<tr>
<td></td>
<td>3</td>
<td>Ground</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>SATA drive</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Pin</th>
<th>Signal</th>
<th>Pin</th>
<th>Signal</th>
<th>Pin</th>
<th>Signal</th>
</tr>
</thead>
<tbody>
<tr>
<td>S1</td>
<td>Ground</td>
<td>P1</td>
<td>3.3V power</td>
<td>P8</td>
<td>5V power</td>
</tr>
</tbody>
</table>
### SATA drive

<table>
<thead>
<tr>
<th>Pin</th>
<th>Signal</th>
<th>Pin</th>
<th>Signal</th>
<th>Pin</th>
<th>Signal</th>
</tr>
</thead>
<tbody>
<tr>
<td>S2*</td>
<td>A+</td>
<td>P2</td>
<td>3.3V power</td>
<td>S9</td>
<td>5V power</td>
</tr>
<tr>
<td>S3*</td>
<td>A-</td>
<td>P3</td>
<td>3.3V power</td>
<td>S10</td>
<td>Ground</td>
</tr>
<tr>
<td>S4</td>
<td>Ground</td>
<td>P4</td>
<td>Ground</td>
<td>S11</td>
<td>Reserved</td>
</tr>
<tr>
<td>S5**</td>
<td>B-</td>
<td>P5</td>
<td>Ground</td>
<td>S12</td>
<td>Ground</td>
</tr>
<tr>
<td>S6**</td>
<td>B+</td>
<td>P6</td>
<td>Ground</td>
<td>S13</td>
<td>12V power</td>
</tr>
<tr>
<td>S7</td>
<td>Ground</td>
<td>P7</td>
<td>5V power</td>
<td>S14</td>
<td>12V power</td>
</tr>
<tr>
<td></td>
<td>* S2 and S3 differential signal pair</td>
<td></td>
<td></td>
<td></td>
<td>**S5 and S6 differential signal pair</td>
</tr>
</tbody>
</table>

### SAS drive

<table>
<thead>
<tr>
<th>Segment</th>
<th>Pin</th>
<th>Backplane receptacle</th>
<th>Plug and cable receptacles</th>
</tr>
</thead>
<tbody>
<tr>
<td>Primary signal segment</td>
<td>S1</td>
<td>SIGNAL GROUND</td>
<td></td>
</tr>
<tr>
<td></td>
<td>S2</td>
<td>TP+</td>
<td>RP+</td>
</tr>
<tr>
<td></td>
<td>S3</td>
<td>TP-</td>
<td>RP-</td>
</tr>
<tr>
<td></td>
<td>S4</td>
<td>SIGNAL GROUND</td>
<td></td>
</tr>
<tr>
<td></td>
<td>S5</td>
<td>RP-</td>
<td>TP-</td>
</tr>
<tr>
<td></td>
<td>S6</td>
<td>RP+</td>
<td>TP+</td>
</tr>
<tr>
<td></td>
<td>S7</td>
<td>SIGNAL GROUND</td>
<td></td>
</tr>
<tr>
<td>Secondary signal segment</td>
<td>S8</td>
<td>SIGNAL GROUND</td>
<td></td>
</tr>
<tr>
<td></td>
<td>S9</td>
<td>TS+</td>
<td>RS+</td>
</tr>
<tr>
<td></td>
<td>S10</td>
<td>TS-</td>
<td>RS-</td>
</tr>
<tr>
<td></td>
<td>S11</td>
<td>SIGNAL GROUND</td>
<td></td>
</tr>
<tr>
<td></td>
<td>S12</td>
<td>RS-</td>
<td>TS-</td>
</tr>
<tr>
<td></td>
<td>S13</td>
<td>RS+</td>
<td>TS+</td>
</tr>
<tr>
<td></td>
<td>S14</td>
<td>SIGNAL GROUND</td>
<td></td>
</tr>
</tbody>
</table>
### SAS drive

<table>
<thead>
<tr>
<th>Segment</th>
<th>Pin</th>
<th>Backplane receptacle</th>
<th>Plug and cable receptacles</th>
</tr>
</thead>
<tbody>
<tr>
<td>Power segment</td>
<td>P1</td>
<td>V_{33}^c</td>
<td></td>
</tr>
<tr>
<td></td>
<td>P2</td>
<td>V_{33}^c</td>
<td></td>
</tr>
<tr>
<td></td>
<td>P3</td>
<td>V_{12}^c precharge c</td>
<td></td>
</tr>
<tr>
<td></td>
<td>P4</td>
<td>GROUND</td>
<td></td>
</tr>
<tr>
<td></td>
<td>P5</td>
<td>GROUND</td>
<td></td>
</tr>
<tr>
<td></td>
<td>P6</td>
<td>GROUND</td>
<td></td>
</tr>
<tr>
<td></td>
<td>P7</td>
<td>V_{12}^c precharge c</td>
<td></td>
</tr>
<tr>
<td></td>
<td>P8</td>
<td>V_{12}^c</td>
<td></td>
</tr>
<tr>
<td></td>
<td>P9</td>
<td>V_{12}^c</td>
<td></td>
</tr>
<tr>
<td></td>
<td>P10</td>
<td>GROUND</td>
<td></td>
</tr>
<tr>
<td></td>
<td>P11</td>
<td>READY LED d</td>
<td></td>
</tr>
<tr>
<td></td>
<td>P12</td>
<td>GROUND</td>
<td></td>
</tr>
<tr>
<td></td>
<td>P13</td>
<td>V_{12}^c precharge c</td>
<td></td>
</tr>
<tr>
<td></td>
<td>P14</td>
<td>V_{12}^c</td>
<td></td>
</tr>
<tr>
<td></td>
<td>P15</td>
<td>V_{12}^c</td>
<td></td>
</tr>
</tbody>
</table>

### VGA

<table>
<thead>
<tr>
<th>Pin</th>
<th>Signal</th>
<th>Pin</th>
<th>Signal</th>
<th>Pin</th>
<th>Signal</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Red Analog</td>
<td>6</td>
<td>GND</td>
<td>11</td>
<td>Monitor ID</td>
</tr>
<tr>
<td>2</td>
<td>Green Analog</td>
<td>7</td>
<td>GND</td>
<td>12</td>
<td>DDC Serial Data</td>
</tr>
<tr>
<td>3</td>
<td>Blue Analog</td>
<td>8</td>
<td>GND</td>
<td>13</td>
<td>Horizontal Sync</td>
</tr>
<tr>
<td>4</td>
<td>Monitor ID</td>
<td>9</td>
<td>+5 VDC</td>
<td>14</td>
<td>Vertical Sync</td>
</tr>
<tr>
<td>5</td>
<td>GND</td>
<td>10</td>
<td>GND</td>
<td>15</td>
<td>DDC Serial Clock</td>
</tr>
</tbody>
</table>
### DVI-I cable

<table>
<thead>
<tr>
<th>Pin</th>
<th>Signal</th>
<th>Pin</th>
<th>Signal</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>T.M.D.S DATA 2-</td>
<td>16</td>
<td>HOT PLUG DETECT</td>
</tr>
<tr>
<td>2</td>
<td>T.M.D.S DATA 2+</td>
<td>17</td>
<td>T.M.D.S DATA 0-</td>
</tr>
<tr>
<td>3</td>
<td>T.M.D.S DATA 2/4 SHIELD</td>
<td>18</td>
<td>T.M.D.S DATA 0+</td>
</tr>
<tr>
<td>4</td>
<td>T.M.D.S DATA 4-</td>
<td>19</td>
<td>T.M.D.S DATA 0/5 SHIELD</td>
</tr>
<tr>
<td>5</td>
<td>T.M.D.S DATA 4+ 2</td>
<td>20</td>
<td>T.M.D.S DATA 5-</td>
</tr>
<tr>
<td>6</td>
<td>DDC CLOCK</td>
<td>21</td>
<td>T.M.D.S DATA 5+</td>
</tr>
<tr>
<td>7</td>
<td>DDC DATA</td>
<td>22</td>
<td>T.M.D.S CLOCK SHIELD</td>
</tr>
<tr>
<td>8</td>
<td>ANALOG VERT. SYNC</td>
<td>23</td>
<td>T.M.D.S CLOCK+</td>
</tr>
<tr>
<td>9</td>
<td>T.M.D.S DATA 1-</td>
<td>24</td>
<td>T.M.D.S CLOCK-</td>
</tr>
<tr>
<td>10</td>
<td>T.M.D.S DATA 1+</td>
<td></td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>T.M.D.S DATA 1/3 SHIELD</td>
<td>C1</td>
<td>ANALOG RED</td>
</tr>
<tr>
<td>12</td>
<td>T.M.D.S DATA 3-</td>
<td>C2</td>
<td>ANALOG GREEN</td>
</tr>
<tr>
<td>13</td>
<td>T.M.D.S DATA 3+</td>
<td>C3</td>
<td>ANALOG BLUE</td>
</tr>
<tr>
<td>14</td>
<td>+5V POWER</td>
<td>C4</td>
<td>ANALOG HORZ SYNC</td>
</tr>
<tr>
<td>15</td>
<td>GND</td>
<td>C5</td>
<td>ANALOG GROUND</td>
</tr>
</tbody>
</table>

### Display port

<table>
<thead>
<tr>
<th>Pin</th>
<th>Signal</th>
<th>Pin</th>
<th>Signal</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>ML_Lane 0(p)</td>
<td>11</td>
<td>GND</td>
</tr>
<tr>
<td>2</td>
<td>GND</td>
<td>12</td>
<td>ML_Lane 3(n)</td>
</tr>
<tr>
<td>3</td>
<td>ML_Lane 0(n)</td>
<td>13</td>
<td>GND</td>
</tr>
</tbody>
</table>
### Display port

<table>
<thead>
<tr>
<th>Pin</th>
<th>Signal</th>
<th>Pin</th>
<th>Signal</th>
<th>Pin</th>
<th>Signal</th>
</tr>
</thead>
<tbody>
<tr>
<td>4</td>
<td>ML_Lane 1(p)</td>
<td>14</td>
<td>GND</td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>GND</td>
<td>15</td>
<td>AUX CH(p)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>ML_Lane 1(n)</td>
<td>16</td>
<td>GND</td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>ML_Lane 2(p)</td>
<td>17</td>
<td>AUX CH(n)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>GND</td>
<td>18</td>
<td>Hot Plug Detect</td>
<td></td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>ML_Lane 2(n)</td>
<td>19</td>
<td>DP_PWR Return</td>
<td></td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>ML_Lane 3(p)</td>
<td>20</td>
<td>DP_PWR</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Main power cable, P1

![Main power cable, P1 diagram]

<table>
<thead>
<tr>
<th>Pin</th>
<th>Signal</th>
<th>Pin</th>
<th>Signal</th>
<th>Pin</th>
<th>Signal</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>+3.3V</td>
<td>9</td>
<td>+5 Vaux</td>
<td>17</td>
<td>GND</td>
</tr>
<tr>
<td>2</td>
<td>+3.3V</td>
<td>10</td>
<td>+12 V-B</td>
<td>18</td>
<td>GND</td>
</tr>
<tr>
<td>3</td>
<td>GND</td>
<td>11</td>
<td>+12 V-B</td>
<td>19</td>
<td>GND</td>
</tr>
<tr>
<td>4</td>
<td>+5V</td>
<td>12</td>
<td>12 V-D</td>
<td>20</td>
<td>GND</td>
</tr>
<tr>
<td>5</td>
<td>GND</td>
<td>13</td>
<td>+3.3V</td>
<td>21</td>
<td>+5V</td>
</tr>
<tr>
<td>6</td>
<td>+5V</td>
<td>14</td>
<td>-12V</td>
<td>22</td>
<td>+5V</td>
</tr>
<tr>
<td>7</td>
<td>GND</td>
<td>15</td>
<td>GND</td>
<td>23</td>
<td>12 V-D</td>
</tr>
<tr>
<td>8</td>
<td>POK</td>
<td>16</td>
<td>PS_ON_L</td>
<td>24</td>
<td>GND</td>
</tr>
</tbody>
</table>
**CAUTION:** Ensure that you can differentiate between which power cable connects to the PCIe x16 graphics card and which power cable connects to the system board. These two cables have different pin counts and different colors. The PCIe power cable has a 6-pin black connector, and the CPU power cable has a 4-pin white connector. When power is present, you must never connect the PCIe power cable to the system board. If you do so, the system board can be damaged and the warranty voided. To see a picture of the PCIe cable and where it must be connected, see Expansion card on page 124.

**NOTE:** The 6-pin power (auxiliary PCIe) is only required with high-powered graphics cards.

### CPU power cable, P3

<table>
<thead>
<tr>
<th>Pin</th>
<th>Color</th>
<th>Signal</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>BLK</td>
<td>GND</td>
</tr>
<tr>
<td>2</td>
<td>BLK</td>
<td>GND</td>
</tr>
<tr>
<td>3</td>
<td>WHT</td>
<td>12V CPU</td>
</tr>
<tr>
<td>4</td>
<td>WHT</td>
<td>12V CPU</td>
</tr>
</tbody>
</table>

### Graphics aux. power cables

#### 475W power supply

<table>
<thead>
<tr>
<th>Pin</th>
<th>Signal</th>
<th>Color</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>V12-D</td>
<td>YEL</td>
</tr>
<tr>
<td>2</td>
<td>V12-D</td>
<td>YEL</td>
</tr>
<tr>
<td>3</td>
<td>V12-D</td>
<td>YEL</td>
</tr>
<tr>
<td>4</td>
<td>GND</td>
<td>BLK</td>
</tr>
<tr>
<td>5</td>
<td>GND</td>
<td>BLK</td>
</tr>
<tr>
<td>6</td>
<td>GND</td>
<td>BLK</td>
</tr>
</tbody>
</table>

#### 600W power supply

<table>
<thead>
<tr>
<th>Pin</th>
<th>Signal</th>
<th>Color</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>V12-M</td>
<td>BLK w/ BRN STRIPE</td>
</tr>
<tr>
<td>2</td>
<td>V12-M</td>
<td>BLK w/ BRN STRIPE</td>
</tr>
<tr>
<td>3</td>
<td>V12-M</td>
<td>BLK w/ BRN STRIPE</td>
</tr>
<tr>
<td>4</td>
<td>GND</td>
<td>BLK</td>
</tr>
<tr>
<td>5</td>
<td>GND</td>
<td>BLK</td>
</tr>
<tr>
<td>6</td>
<td>GND</td>
<td>BLK</td>
</tr>
</tbody>
</table>
### Internal USB 1 2x5

<table>
<thead>
<tr>
<th>Pin</th>
<th>Signal</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>+5V</td>
</tr>
<tr>
<td>2</td>
<td>+5V</td>
</tr>
<tr>
<td>3</td>
<td>USB6#</td>
</tr>
<tr>
<td>4</td>
<td>USB9#</td>
</tr>
<tr>
<td>5</td>
<td>USB6</td>
</tr>
<tr>
<td>6</td>
<td>USB9</td>
</tr>
<tr>
<td>7</td>
<td>GND</td>
</tr>
<tr>
<td>8</td>
<td>GND</td>
</tr>
<tr>
<td>9</td>
<td>(not keyed)</td>
</tr>
<tr>
<td>10</td>
<td>DETECT</td>
</tr>
</tbody>
</table>

**CAUTION:** Possible equipment damage. The 2x5 connector can be mated to either a wide 2x5 option cable connector or a narrow 1x5 option cable connector. To prevent damage to the connectors, always connect a narrow 1x5 option cable connector to pins 1, 3, 5, and 7 only of the 2x5 connector (pin 9 is not keyed on the connector).

### Internal USB 2 2x5

<table>
<thead>
<tr>
<th>Pin</th>
<th>Signal</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>+5V</td>
</tr>
<tr>
<td>2</td>
<td>+5V</td>
</tr>
<tr>
<td>3</td>
<td>USB7#</td>
</tr>
<tr>
<td>4</td>
<td>USB8#</td>
</tr>
<tr>
<td>5</td>
<td>USB7</td>
</tr>
<tr>
<td>6</td>
<td>USB8</td>
</tr>
<tr>
<td>7</td>
<td>GND</td>
</tr>
<tr>
<td>8</td>
<td>GND</td>
</tr>
<tr>
<td>9</td>
<td>(not keyed)</td>
</tr>
<tr>
<td>10</td>
<td>DETECT</td>
</tr>
</tbody>
</table>

**CAUTION:** Possible equipment damage. The 2x5 connector can be mated to either a wide 2x5 option cable connector or a narrow 1x5 option cable connector. To prevent damage to the connectors, always connect a narrow 1x5 option cable connector to pins 1, 3, 5, and 7 only of the 2x5 connector (pin 9 is not keyed on the connector).

### Rear system fan

<table>
<thead>
<tr>
<th>Pin</th>
<th>Signal</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>GND</td>
</tr>
<tr>
<td>2</td>
<td>+12V</td>
</tr>
<tr>
<td>3</td>
<td>Tach</td>
</tr>
<tr>
<td>4</td>
<td>PWM</td>
</tr>
</tbody>
</table>
### CPU fan

<table>
<thead>
<tr>
<th>Pin</th>
<th>Signal</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>GND</td>
</tr>
<tr>
<td>2</td>
<td>+12V</td>
</tr>
<tr>
<td>3</td>
<td>TACH1</td>
</tr>
<tr>
<td>4</td>
<td>PWM</td>
</tr>
<tr>
<td>5</td>
<td>TACH2</td>
</tr>
</tbody>
</table>

### FDD

<table>
<thead>
<tr>
<th>Pin</th>
<th>Signal</th>
<th>Pin</th>
<th>Signal</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Ground</td>
<td>18</td>
<td>FLP_DIR#</td>
</tr>
<tr>
<td>2</td>
<td>FLP_LOWDEN#</td>
<td>19</td>
<td>Ground</td>
</tr>
<tr>
<td>3</td>
<td>Tach</td>
<td>20</td>
<td>FLP_STEP#</td>
</tr>
<tr>
<td>4</td>
<td>FLP_WDO</td>
<td>21</td>
<td>Ground</td>
</tr>
<tr>
<td>5</td>
<td>MT</td>
<td>22</td>
<td>FLP_STEP#</td>
</tr>
<tr>
<td>6</td>
<td>Unused</td>
<td>23</td>
<td>Ground</td>
</tr>
<tr>
<td>7</td>
<td>Ground</td>
<td>24</td>
<td>FLP_WRTEN#</td>
</tr>
<tr>
<td>8</td>
<td>FLP_INDEX#</td>
<td>25</td>
<td>Ground</td>
</tr>
<tr>
<td>9</td>
<td>Ground</td>
<td>26</td>
<td>FLP_TRACK#</td>
</tr>
<tr>
<td>10</td>
<td>FLP_MOTOR#</td>
<td>27</td>
<td>Ground</td>
</tr>
<tr>
<td>11</td>
<td>Ground</td>
<td>28</td>
<td>FLP_WP#</td>
</tr>
<tr>
<td>12</td>
<td>Unused</td>
<td>29</td>
<td>Ground</td>
</tr>
<tr>
<td>13</td>
<td>Ground</td>
<td>30</td>
<td>FLP_RD_D#</td>
</tr>
<tr>
<td>14</td>
<td>FLP_SEL_A#</td>
<td>31</td>
<td>Ground</td>
</tr>
<tr>
<td>15</td>
<td>Ground</td>
<td>32</td>
<td>FLP_HD_SEL#</td>
</tr>
<tr>
<td>16</td>
<td>Unused</td>
<td>33</td>
<td>Ground</td>
</tr>
<tr>
<td>17</td>
<td>Ground</td>
<td>34</td>
<td>FLP_DSKCHG#</td>
</tr>
<tr>
<td>Internal serial</td>
<td>Pin</td>
<td>Signal</td>
<td>Pin</td>
</tr>
<tr>
<td>----------------</td>
<td>-----</td>
<td>----------</td>
<td>-----</td>
</tr>
<tr>
<td>2</td>
<td>1</td>
<td>DTR1#</td>
<td>9</td>
</tr>
<tr>
<td>14</td>
<td>10</td>
<td>RXD1</td>
<td>11</td>
</tr>
<tr>
<td>1</td>
<td>1</td>
<td>CTS1#</td>
<td>12</td>
</tr>
<tr>
<td>15</td>
<td>13</td>
<td>DSR1#</td>
<td>14</td>
</tr>
<tr>
<td>15</td>
<td>14</td>
<td>TXD1</td>
<td>13</td>
</tr>
<tr>
<td>15</td>
<td>14</td>
<td>RI#</td>
<td>14</td>
</tr>
<tr>
<td></td>
<td>15</td>
<td>Ground</td>
<td>14</td>
</tr>
<tr>
<td>14</td>
<td>14</td>
<td>Ground</td>
<td>14</td>
</tr>
</tbody>
</table>
This appendix describes the system board designators for this workstation.

<table>
<thead>
<tr>
<th>Designator</th>
<th>Silk screen</th>
<th>Component</th>
</tr>
</thead>
<tbody>
<tr>
<td>MTG1-MTG10</td>
<td>N/A</td>
<td>Mounting holes</td>
</tr>
<tr>
<td>E15</td>
<td>E15</td>
<td>Crisis recovery header/jumper</td>
</tr>
<tr>
<td>E49</td>
<td>E49 PSWD</td>
<td>Clear password header/jumper</td>
</tr>
<tr>
<td>J9</td>
<td>J9 RJ/USB</td>
<td>LAN/DUAL USB</td>
</tr>
<tr>
<td>J10</td>
<td>J10 QUAD USB</td>
<td>Quad rear USB</td>
</tr>
<tr>
<td>J20</td>
<td>J20 SLOT6 PCI</td>
<td>PCI slot</td>
</tr>
<tr>
<td>J21</td>
<td>J21 SLOT5 PCI</td>
<td>PCI slot</td>
</tr>
<tr>
<td>J31</td>
<td>J31 SLOT1 PCIe x8(4)</td>
<td>PCIe x8(4) slot</td>
</tr>
<tr>
<td>J32</td>
<td>J32 SLOT3 PCIe x8(4)</td>
<td>PCIe x8(4) slot</td>
</tr>
<tr>
<td>J41</td>
<td>J41 SLOT2 PCIe x16 75W</td>
<td>PCIe x16 slot</td>
</tr>
<tr>
<td>J42</td>
<td>J42 SLOT4 PCIe x16 75W</td>
<td>PCIe x16 slot</td>
</tr>
<tr>
<td>J68</td>
<td>J68 PS2 KBD_MSE</td>
<td>Stacked keyboard/mouse connector</td>
</tr>
<tr>
<td>J83</td>
<td>J83 AUD</td>
<td>Triple stacked audio jacks</td>
</tr>
<tr>
<td>J86</td>
<td>J86</td>
<td>Slot2 PCIe x16 retention clip</td>
</tr>
<tr>
<td>J87</td>
<td>J87</td>
<td>Slot4 PCIe x16 retention clip</td>
</tr>
<tr>
<td>SW50</td>
<td>SW50 CMOS</td>
<td>Clear CMOS switch/push button</td>
</tr>
<tr>
<td>P1</td>
<td>P1PWR</td>
<td>Power supply connector (24-pin)</td>
</tr>
<tr>
<td>P3</td>
<td>P3 PWR CPU</td>
<td>CPU power connector (4-pin)</td>
</tr>
<tr>
<td>P5</td>
<td>P5 PB/LED</td>
<td>Power button/HDD LED/Power LED switch/Side access panel sensor/Temperature header</td>
</tr>
<tr>
<td>P8</td>
<td>P8 REAR FAN</td>
<td>Rear system fan</td>
</tr>
<tr>
<td>P10</td>
<td>P10 FLPHY</td>
<td>Floppy diskette drive connector</td>
</tr>
<tr>
<td>P24</td>
<td>P24 FRONT USB</td>
<td>Front panel USB header</td>
</tr>
<tr>
<td>P25</td>
<td>P25 USB2</td>
<td>Single USB header</td>
</tr>
<tr>
<td>P26</td>
<td>P26 DASH/USB1</td>
<td>DASH/Dual internal USB</td>
</tr>
<tr>
<td>P29</td>
<td>P29 HDD LED</td>
<td>Hard disk drive LED connector</td>
</tr>
<tr>
<td>P60-P63</td>
<td>P60 - P63</td>
<td>SATA Connectors</td>
</tr>
<tr>
<td></td>
<td>SATA0 - SATA3</td>
<td></td>
</tr>
<tr>
<td>Designator</td>
<td>Silk screen</td>
<td>Component</td>
</tr>
<tr>
<td>------------</td>
<td>-------------</td>
<td>-------------------------------</td>
</tr>
<tr>
<td>P66 - P67</td>
<td>P66 - P67</td>
<td>SATA Connectors</td>
</tr>
<tr>
<td></td>
<td>SATA4 - SATA5</td>
<td></td>
</tr>
<tr>
<td>P70</td>
<td>P70 CPU0 FAN</td>
<td>Primary CPU fan header</td>
</tr>
<tr>
<td>P93</td>
<td>P93 FRNTFAN</td>
<td>Front fan header</td>
</tr>
<tr>
<td>P94</td>
<td>P94 IOH FAN</td>
<td>IOH fan header</td>
</tr>
<tr>
<td>P124</td>
<td>P124 HLCK</td>
<td>Side access panel solenoid lock header</td>
</tr>
<tr>
<td>XBT1</td>
<td>XBT1 BAT</td>
<td>Battery holder</td>
</tr>
<tr>
<td>XMM1 - XMM6</td>
<td>4-DIMM: XMM1-XMM4, DIMM1-DIMM4</td>
<td>Memory slots</td>
</tr>
<tr>
<td></td>
<td>6-DIMM: XMM1-XMM6, DIMM1-DIMM6</td>
<td></td>
</tr>
<tr>
<td>XU1</td>
<td>XU1 CPU0</td>
<td>Primary CPU socket</td>
</tr>
</tbody>
</table>
C    Routine Care

General cleaning safety precautions

- Never use solvents or flammable solutions to clean the workstation.
- Never immerse any component in water or cleaning solutions; apply any liquids to a clean cloth and then use the cloth on the component.
- Always unplug the workstation before cleaning the keyboard, mouse, or air vents.
- Always disconnect the keyboard before cleaning it.
- Wear safety glasses equipped with side shields when cleaning the keyboard.

Cleaning the workstation case

- Follow the safety precautions presented (Service considerations on page 66) before cleaning the workstation.
- To remove light stains or dirt, use plain water with a clean, lint-free cloth or swab.
- For stronger stains, use a mild dish washing liquid diluted with water. Rinse well by wiping it with a cloth or swab dampened with clear water.
- For stubborn stains, use isopropyl (rubbing) alcohol. No rinsing is required because the alcohol evaporates quickly and does not leave a residue.
- After cleaning, always wipe the workstation with a clean, lint-free cloth.
- Occasionally, clean the air vents on the workstation. Lint and other foreign matter can block the vents and limit the airflow.

Cleaning the keyboard

⚠️ CAUTION: Use safety glasses equipped with side shields before attempting to clean debris from under the keys.

- Follow the safety precautions presented (Service considerations on page 66) before cleaning the workstation.
- Visible debris underneath or between the keys can be removed by vacuuming or shaking.
- Canned, pressurized air can be used to clean debris from under the keys. Use caution because too much air pressure can dislodge lubricants applied under the wide keys.
- If you remove a key, use a specially designed key remover to prevent damage to the keys. This tool is available from many electronic supply outlets.

⚠️ CAUTION: Never remove a wide key (like the space bar key) from the keyboard. If these keys are improperly removed or installed, the keyboard might not function properly.
• Clean under a key with a swab moistened with isopropyl alcohol and squeezed out. Be careful not to wipe away lubricants necessary for proper key functions. Allow the parts to air dry before reassembly.

• Use tweezers to remove any fibers or dirt in confined areas.

Cleaning the monitor

• Follow the safety precautions presented (Service considerations on page 66) before cleaning the workstation.

• To clean the monitor, wipe the monitor screen with a towelette designed for cleaning monitors or a clean cloth moistened with water.

⚠️ **CAUTION:** Do not use sprays or aerosols directly on the screen—the liquid might seep into the housing and damage a component.

Never use solvents or flammable liquids on the monitor because display or housing damage may result.

Cleaning the mouse

1. Follow the safety precautions presented (Service considerations on page 66) before cleaning the workstation.

2. Remove the mouse ball from the housing by removing the retaining plate.

3. Clean the mouse ball.

4. Pull out any debris from the ball socket, and wipe the ball with a clean, dry cloth.

5. Reassemble the mouse.
This section provides information on the following HP resources for your workstation:

**Topics**

**Product information on page 236**
- HP Cool Tools
- Regulatory information
- Accessories
- System board
- Serial number and Certificate of Authenticity labels
- Linux

**Product support on page 237**
- Additional information
- Technical support
- Business Support Center
- IT Resource Center
- HP Service Center
- HP Business and IT Services
- Warranty information

**Product documentation on page 238**
- User and third-party documentation, and white papers
- Product notifications
- QuickSpecs
- Customer Advisories, Security Bulletins, Notices

**Product diagnostics on page 239**
- Diagnostics tools
- Audible beeps and LED code definitions
- Web-based support tools

**Product updates on page 240**
- Software, BIOS, and driver updates
- Operating system reinstallation
- Operating system
Product information

Table D-1  Product information

<table>
<thead>
<tr>
<th>Topic</th>
<th>Location</th>
</tr>
</thead>
</table>
| HP Cool Tools                                              | Most HP Microsoft Windows workstations are preloaded with additional software that is not automatically installed during first boot. Additionally, a number of valuable tools on your workstation are preinstalled that may enhance system performance. To access or learn more about these applications, choose one of the following options:  
  - Click the **HP Cool Tools** icon on the desktop, or  
  - Open the **HP Cool Tools** folder by selecting **Start > All Programs > HP Cool Tools**.  
  To learn more about these applications, click **HP Cool Tools—Learn More**.  
  To install or launch the applications, click the appropriate application icon. |
| Regulatory information                                     | Refer to the Safety & Regulatory Information guide for product Class information. You can also refer to the label on the workstation chassis. |
| Accessories                                                | For complete and current information on supported accessories and components, see [http://www.hp.com/go/workstations](http://www.hp.com/go/workstations). |
| System board                                               | A diagram of the system board is located on the inside of the side access panel. Also, additional information is located in the Maintenance and Service Guide on the Web at [http://www.hp.com/support/workstation_manuals/](http://www.hp.com/support/workstation_manuals/). |
| Serial number and Certificate of Authenticity (COA) labels (if applicable) | Serial number labels are on the top panel, or on the side of the unit at the rear, depending on the workstation model. The COA label is generally located on the top or side panel near the serial number label. Some workstations have this label on the bottom of the unit. |
| Linux                                                      | For information on running Linux on HP workstations, see [http://www.hp.com/linux/](http://www.hp.com/linux/). |
## Product support

### Table D-2  Product support

<table>
<thead>
<tr>
<th>Topic</th>
<th>Location</th>
</tr>
</thead>
</table>
| Additional information    | For online access to technical support information and tools, see [http://www.hp.com/go/workstationsupport](http://www.hp.com/go/workstationsupport). Support resources include Web-based troubleshooting tools, technical knowledge databases, driver and patch downloads, online communities, and proactive notification services. The following communication and diagnostic tools are also available:  
  ● Instant Chat  
  ● Instant Support  
  ● Diagnose Problem  
Refer to the workstation Maintenance and Service Guide for more information on how to receive support. |
| Technical support         | Before you call technical support, refer to the workstation Maintenance and Service Guide for a listing of information you need to have available before you call. For a listing of all worldwide technical support phone numbers, see [http://www.hp.com/support/](http://www.hp.com/support/), select your region, and click **Contact HP** in the upper-left corner. |
| Business Support Center (BSC) | For software/driver downloads, warranty information, single-topic documents, user manuals, or service manuals, see [http://www.hp.com/go/bizsupport](http://www.hp.com/go/bizsupport). |
| HP Business and IT Services. | For business and IT information, see [http://www.hp.com/hps/](http://www.hp.com/hps/). |
| Warranty information      | To locate base warranty information, see [http://www.hp.com/support/warranty-lookuptool](http://www.hp.com/support/warranty-lookuptool).  
To locate an existing Care Pack, see [http://www.hp.com/go/lookuptool](http://www.hp.com/go/lookuptool).  
## Product documentation

<table>
<thead>
<tr>
<th>Topic</th>
<th>Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>HP user documentation, white papers, and third-party documentation</td>
<td>For the latest online documentation, see <a href="http://www.hp.com/support/workstation_manuals">http://www.hp.com/support/workstation_manuals</a>. These include this User Guide and the Maintenance and Service Guide.</td>
</tr>
<tr>
<td>Product notifications</td>
<td>Subscriber’s Choice is an HP program that allows you to sign up to receive driver and software alerts, proactive change notifications (PCNs), the HP newsletter, customer advisories, and more. Sign up at <a href="http://www.hp.com/go/subscriberschoice/">http://www.hp.com/go/subscriberschoice/</a>. Customer advisories and product change notifications are also available on <a href="http://www.hp.com/go/bizsupport/">http://www.hp.com/go/bizsupport/</a>.</td>
</tr>
<tr>
<td>Workstation QuickSpecs</td>
<td>The Product Bulletin contains QuickSpecs for HP Workstations. QuickSpecs provide an overall specification review of your product. It includes information about its features including the operating system, power supply, memory, CPU, and many other components of the system. To access the QuickSpecs, see <a href="http://www.hp.com/go/productbulletin/">http://www.hp.com/go/productbulletin/</a>.</td>
</tr>
</tbody>
</table>
| Customer Advisories, Security Bulletins, and Notices | To find advisories, bulletins, and notices:  
2. Select the desired product.  
3. From the **Resources** section, select **See more...**  
4. Use the scroll bar to select **Customer Advisories, Customer Bulletins, or Customer Notices**. |
## Product diagnostics

**Table D-4  Product diagnostics**

<table>
<thead>
<tr>
<th>Topic</th>
<th>Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>Diagnostics tools</td>
<td>The HP Vision Field Diagnostics utility can be downloaded from the HP Web site. To use this utility, refer to the appropriate section of the workstation <em>Maintenance and Service Guide</em>.</td>
</tr>
<tr>
<td>Audible beep and LED code definitions</td>
<td>Refer to the appropriate section of the workstation <em>Maintenance and Service Guide</em> for detailed information about beep and Light Emitting Diode (LED) codes applicable to the workstation.</td>
</tr>
</tbody>
</table>
# Product updates

## Table D-5  Product updates

<table>
<thead>
<tr>
<th>Topic</th>
<th>Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>Software, BIOS, and driver updates</td>
<td>See <a href="http://www.hp.com/go/workstationsupport">http://www.hp.com/go/workstationsupport</a> to verify that you have the latest drivers for the workstation. To locate the current workstation BIOS on your Microsoft Windows workstation, select <strong>Start&gt;Help and Support&gt;Pick a Task&gt;Use Tools to view...&gt;Tools&gt;My Computer Information&gt;View general system information...</strong>.</td>
</tr>
<tr>
<td>Operating system</td>
<td>For information on operating systems supported on HP workstations, see <a href="http://www.hp.com/go/wsos">http://www.hp.com/go/wsos</a>.</td>
</tr>
</tbody>
</table>
Index

A
Appendices
Connector pins 221
System board designators 231

B
BIOS
Determining version 22
Updating 23
BIOS ROM 31

C
Clearing and resetting CMOS 219
Computer Setup (F10) Utility
Menu description 34
Configuring RAID devices
SAS RAID 211
SATA RAID 208
Connector pins
Audio line-in 222
Audio line-out 222
CPU fan 229
CPU power cable 227
Display port 225
DVI-I 225
Ethernet 221
FDD 229
Graphics aux. power 227
Headphone 222
Internal serial 230
Internal USB 228
Keyboard 221
Main power cable 226
Microphone 222
Mouse 221
Rear system fan 228
SAS drive 223
SATA drive 222
USB 222
VGA 224

D
Diagnostic codes and errors
LED colors 199
POST errors 201
Diagnostics and troubleshooting
Diagnosis guidelines 168
HP Vision Diagnostics 184
Locating ID labels 165
Locating warranty info 167
Drivers
Installing 19
Updating 19, 23

H
HP Backup and Recovery 27
HP resources
Locating 235
Product diagnostics 239
Product documentation 238
Product information 236
Product support 237
Product updates 240
Web links 238
Microsoft Windows
Setting up 19
Transferring files 19
monitor
Windows 173

N
Novell SLED
Restoring 28
Setting up 21

O
Operating system setup
Microsoft Windows 19
Red Hat Linux 20
Operating system setup; Novell SLED 21

P
Password security
Configuring passwords 217
Resetting password jumper 218
Power supply
Currents 9
Power consumption 11
Resetting power supply 11
Specifications 10
System fans 11
Voltages 8
Product features
ERP compliance mode 14
Front panel components 6
HP Cool Tools 15
Hyper-threading 15
Physical characteristics 8
Rear panel components 7
SATA Power Management 15
System board architecture 2
Turbo Boost 15
Workstation components 5
Product overview 1

R
Red Hat Linux
Setting up 20
Replacing components
Access panel 78
Battery 128
cable lock 77
Component locations 73
Converting to desktop configuration 161
CPU 157
CPU heatsink 154
Disassembly order 76
Front panel I/O device 83
Memory 116
Optical disk drive 89
PCIe card 124
Power button 87
Power connections 99
Power supply 98
Predisassembly 75
Rear system fan 100
Self-repair 71
Service considerations 66
side access panel sensor 79
side access panel solenoid 82
Slot identification 121
System board 159
Workstation speaker 97
RestorePlus! 25
Restoring the operating system
  Restore methods 24
  Windows Vista 25
  Windows XP 26
Software
  Ordering 25
Support
  Locating HP resources 235
Updating the workstation
  First boot update 21
  Updating drivers 23
  Updating the BIOS 23
Windows operating system
  monitor 173
Windows Vista
  Restoring 25
  Setting up 19
Windows XP
  Restoring 26
  Setting up 19
Workstation management
  Altiris Client Management Solutions 47
  Dual-state power button 63
  FailSafe Boot Block ROM 51
  Fault notification and recovery 62
  HP Client Manager Software 47
  HP SoftPaq Download Manager 48
  HPQFlash 50
  Initial configuration 44
  Proactive Change Notification 49
  Remote ROM Flash 50
  Remote system install 44
  Replicating the setup 45
  ROM Flash 50
  Subscriber’s Choice 49
  System Software Manager 49
  Updating software 47
  Workstation security 52
  Workstation setup
    Ensuring proper ventilation 16